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1 Introduction

Altova website:  Diff tool

Altova DiffDog 2023 Enterprise Edition is a powerful differencing application that intelligently finds differences
between pairs of directories and between pairs of files. Three-way comparisons of files are also supported. In
addition, you can compare Microsoft Word documents, the structure of XML schemas or database schemas,
as well as data from databases or CSV files. Comparisons between CSV files and databases, or between
databases of different kinds, are also possible. Data can be compared on different bases and according to a
variety of options that you can change quickly in the graphical user interface. In addition, DiffDog allows you to
merge file differences, synchronize the content of two directories, generate XSLT stylesheets and MapForce®
mappings for XML Schemas, merge the structure or data of database tables, and copy or delete changed files
with a mouse click.

DiffDog is a 32/64-bit Windows application that runs on Windows 7 SP1 with Platform Update, Windows 8,
Windows 10, Windows 11, and on Windows Server 2008 R2 SP1 with Platform Update or newer, see also
Support Notes . 

Last updated: 7 October 2022

12

https://www.altova.com/diffdog
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1.1 Support Notes

DiffDog runs on the following operating systems:

· Windows 7 SP1 with Platform Update, Windows 8, Windows 10, Windows 11
· Windows Server 2008 R2 SP1 with Platform Update or newer

Both the 32-bit and 64-bit platforms are supported.

DiffDog integrates with Microsoft Office products as follows:

· It can be used to compare Access databases. For supported versions, see Supported Databases .
· It can be used to compare Word 2003 or later documents, see Comparing Microsoft Word

Documents .

13

90
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1.2 Supported Databases

The table below lists all the supported databases. While Altova endeavors to support other databases,
successful connection and data processing have only been tested with the databases listed below. If your
Altova application is a 64-bit version, ensure that you have access to the 64-bit database drivers needed for the
specific database you are connecting to.

Database Notes

Firebird 2.x, 3.x

IBM DB2 8.x, 9.x, 10.x, 11.x

IBM Db2 for i 6.x, 7.4 Logical files are supported and shown as views.

IBM Informix 11.70 and later

MariaDB 10 and later

Microsoft Access 2003 and later At the time of writing (early September 2019), there is no
Microsoft Access Runtime available for Access 2019. You can
connect to an Access 2019 database from Altova products only
if Microsoft Access 2016 Runtime is installed and only if the
database does not use the "Large Number" data type.

Microsoft Azure SQL Database SQL Server 2016 codebase

Microsoft SQL Server 2005 and later
Microsoft SQL Server on Linux

MySQL 5 and later

Oracle 9i and later

PostgreSQL 8 and later PostgreSQL connections are supported both as native
connections and driver-based connections through interfaces
(drivers) such as ODBC or JDBC. Native connections do not
require any drivers.

Progress OpenEdge 11.6

SQLite 3.x SQLite connections are supported as native, direct connections
to the SQLite database file. No separate drivers are required.

Sybase ASE 15, 16

Teradata 16
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1.3 Product Features

DiffDog provides the following main features.

File Comparison
A file comparison  in DiffDog is made in a File Comparison window. Files to be compared are opened in
separate panes of a File Comparison window by browsing in Windows Explorer-type windows or from drop-
down lists of previously opened files. DiffDog remembers file comparison pairs, and, when you select a file for
comparison, can provide a list of files with which the selected file was previously compared .

Files can be compared as text or as structured XML. You can also compare binary files, however DiffDog
cannot—with the exception of Microsoft Word (*.doc or *.docx) documents— display the changes within binary
files, it can only detect whether or not a pair of binary files is equal. A large range of navigation controls
enables you to move easily among differences.

A wide range of comparison options  are available, thus allowing you to define what aspects of files to
compare and what aspects to ignore. Comparison options include settings for how whitespace and blank lines
should be treated, whether case-sensitivity should be considered or not, whether differences should be
indicated by line or character, whether certain node types, namespaces, and the order of attributes and/or
elements should be ignored, whether entities should be resolved, etc.

If a file is modified outside DiffDog while it is open in a File Comparison window, DiffDog can watch for changes
and reload the file if required.

Differences within files are indicated with background colors, and corresponding differences in the two panes
are joined with lines, thus making visual analysis easier. Note that this does not apply to binary files. Vertical
and horizontal scrolling of the two files in Comparison windows can be synchronized. This enables
corresponding differences always to be displayed simultaneously.

With DiffDog Enterprise Edition, you can also perform three-way file comparisons (this is not applicable to
Word files). Such comparisons can be used to merge differences from two files into a third one, see Three-Way
Comparisons .

File Editing and Merging in File Comparison Windows
After you have compared a file pair, files can be edited  and saved  directly within File Comparison
windows and you can specify whether and how backups of files  you edit should be kept. Comparisons can
be done dynamically as you edit .

DiffDog provides high-level find-and-replace functionality, which also includes support for regular expressions.
Differences between files can be merged , i.e. a different block in one file can be copied to replace the
corresponding block in the other file. Editing and merging changes in either file can be undone an unlimited
number of times.

Directory Comparison
A directory comparison  in DiffDog is made in a Directory Comparison window. The directories to be
compared are opened in separate panes of a Directory Comparison window. DiffDog provides a drop-down list of
recently compared directories from which to select. Additionally, once a directory is selected to be opened in
one pane, DiffDog can provide a list of directories with which that directory was previously compared ; as a
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result previously compared pairs can quickly be opened in a Directory Comparison window. You can define
filters  to specify what file types to compare and what file types to ignore in a directory comparison.

Directories can be compared on the basis of the sizes and timestamps of files within them (Quick Comparison
Mode), or on the basis of the contents of files. The compared directories are displayed as
expandable/collapsible trees and show details such as file size and last modification date. The view of the
compared directories can be configured  on the basis of the comparison results. For example, equal
directories and files can be hidden, and only non-equal folders and files shown. Differences between directories
and files are indicated  with color-coding and easy-to-identify icons.

If a directory is modified outside DiffDog while it is open in a Directory Comparison window, DiffDog can watch
for changes and reload the directory if required. Non-equal directories and files can be copied from one pane
(directory) to the other. You can also synchronize  the directories, that is, copy all missing or updated files
from one directory to the other or delete unneeded files. File comparisons can be started  directly from within
a Directory Comparison window by double-clicking a file in a directory.

Microsoft Word document comparison
A comparison of Microsoft Word documents  is made in a Word Comparison window. Please note that
Microsoft Word must be installed on your computer and that you cannot run a 64-bit version of DiffDog together
with a 32-bit version of Microsoft Word, or vice versa, if you want to compare Microsoft Word documents in
DiffDog. DiffDog opens two instances of Microsoft Word side by side and displays an empty document in both
of them. Documents are opened separately in the left and right pane by clicking the Open button in the
respective toolbar or choosing a previously compared document from the drop-down list box.

XML Schema comparison
An XML schema comparison  is made in an XML Schema Comparison window. The XML schemas to be
compared are opened in two components of the XML Schema Comparison window. Occasionally, you will have
to set a root element  for the comparison. The root elements on both sides are mapped and DiffDog tries to
find and map corresponding (child) elements. The mappings can be changed manually at any time.

You can save  the mapping and the settings of an XML Schema comparison in a file. If such an XML
Schema comparison file is modified outside DiffDog while it is open in an XML Schema Comparison window,
DiffDog can watch for changes and reload the file if required. DiffDog also allows you to generate XSLT
Stylesheets  and MapForce Mappings  for the compared XML Schemas. The XSLT Stylesheet or
MapForce Mapping, respectively, can then be saved or, for XSLT Stylesheets, opened in XMLSpy®.

Database schema comparison
A database schema comparison enables you to compare objects of two different database schemas, in terms
of their structure or size. Database objects that can be compared include tables, columns, views, functions,
and stored procedures. Comparison works differently for tables, as opposed to views, functions, or stored
procedures. Namely, in case of tables, the comparison results report the structural differences (such as
different columns, constraints, data types, and so on). In case of views, functions, and stored procedures, the
comparison results inform you if the size of the object is the same or different in database A (left-side of
comparison) as compared to database B (right-side of comparison). For more information, see Comparing
Database Schemas .

Database data comparison
You can compare data from two or more tables or columns side-by-side. The objects to be compared can
either belong to the same database, or reside in two different databases. A database comparison is similar to
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file comparisons; that is, it involves a "left" component and a "right" one. A "component" is just a representation
of the database structure from where you can conveniently select the tables or columns that are to be
compared.

After comparing database data, you can optionally merge differences either from left to right, or from right to
left. It is possible to merge all differences as one batch, or you can display the differences for each table in a
data grid, and then review and merge each difference individually at row level. For more information, see
Comparing Database Data .

Interface
Multiple comparison windows (directory, file, XML Schema, database schema, and database data) can be
opened in DiffDog at a time. Directory synchronization  is done in a dialog box that can be opened from the
Directory Comparison window after you have run a directory comparison, and which allows you to customize
the default synchronization settings according to your needs. 

The GUI has user-friendly menu layouts, intuitive toolbar icons, right-click quick menus, and a status bar that
summarizes the results of comparisons. You can customize the look of Directory Comparison windows, File
Comparison windows, XML Schema Comparison windows, Database Schema Comparison windows, and
Database Data Comparison windows, including the background colors  that are used to highlight differences.
Files can be viewed in Text View  or Altova's Grid View .

The Text View of documents in File Comparison windows provides line-numbering, source-folding (i.e.
expandable and collapsible elements), indentation guides, bookmarking, syntax coloring, and whitespace and
linefeed indicators. Syntax coloring  can be adjusted according to file type.

Grid View displays structured documents, such as XML documents, in a tabular grid. This enables you to carry
out large-scale changes easily (for example, inserting a column would insert the node represented by the
column in all the nodes represented by the rows of the grid).

Command Line
DiffDog can be called from the command line . The application can be integrated with any source control
system which provides the possibility to set up a path to the DiffDog executable.
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1.4 DiffDog Terminology

Terms used in this documentation are defined below.

Comparisons
DiffDog enables you to make the following kinds of comparisons: File Comparisons, Directory Comparisons,
Microsoft Word document Comparisons, XML Schema Comparisons, Database Schema Comparisons, and
Database Data Comparisons.

File comparison
A file comparison is the process of comparing two files. The term is also used to refer to the display of results
of the comparison.

File Comparison window
Each file comparison is displayed in a File Comparison window. Multiple file comparisons can be open in
DiffDog at a time, but only one may be active at any given time.

Microsoft Word document comparison
A Microsoft Word document comparison is the process of comparing two Microsoft Word (*.doc or *.docx) files.
The term is also used to refer to the display of results of the comparison.

Word Comparison window
Each Microsoft Word document comparison is displayed in a Word Comparison window. Multiple Microsoft
Word document comparisons can be open in DiffDog at a time, but only one may be active at any given time.

Directory comparison
A directory comparison is the process of comparing two directories. The term is also used to refer to the
display of the results of the comparison.

Directory Comparison window
Each directory comparison is displayed in a Directory Comparison window. Multiple directory comparisons can
be open in DiffDog at a time, but only one may be active at any given time.

Database Data comparison
A database data comparison is the process of comparing the content of tables contained in two databases.

Database Data Comparison window
Each database data comparison is displayed in a Database Data Comparison window. Multiple database data
comparisons can be open in DiffDog at a time, but only one may be active at any given time.
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Database Schema comparison
A database schema comparison is the process of comparing the structure of tables contained in two database
schemas.

Database Schema Comparison window
Each database schema comparison is displayed in a Database Schema Comparison window. Multiple
database schema comparisons can be open in DiffDog at a time, but only one may be active at any given time.

XML Schema comparison
An XML schema comparison is the process of comparing two XML schemas. The term is also used to refer to
the display of results of the comparison.

XML Schema Comparison window
Each XML schema comparison is displayed in an XML Schema Comparison window. Multiple XML schema
comparisons can be open in DiffDog at a time, but only one may be active at any given time.

Component
In Database Data comparisons, Database Structure comparisons, and XML Schema comparisons, the items to
be compared are contained in two components within the respective comparison window. The components are
used to select and map the items of the comparison and provide several context menu options.

Data source
The database that hosts the tables compared in a database data or database schema comparison is referred to
as data source. You need a connection to a data source in order to start a database data or database schema
comparison in DiffDog.

Database Data Comparison Result window
In contrast to file and directory comparisons, the results of a database data comparison are not displayed
directly in the Database Data Comparison window but in a separate window which is called the Database Data
Comparison Result window. The Database Data Comparison window itself provides only a short overview stating
whether or not the data in the two tables is equal and how many rows are different or exist only on one side of
the comparison.

Directories and Folders
These two terms are used interchangeably.

Difference
Six types of differences are distinguished: (1) differences between two compared files, (2) differences between
two compared directories, (3) differences between two compared Microsoft Word documents, (4) differences
between the data in tables of two compared databases, (5) differences between the structure in schemas of two
compared databases, and (6) differences between two compared XML Schemas.
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1. A difference between two files that are compared as text denotes a line of text in a file that is different
from the corresponding line (if any) in the compared file. Note that the entire line is considered to be a
single difference—even if the option to show differences within lines is selected. (This is significant
when merging differences because the entire line will be merged; merges are not carried out at the
character level.) A line of text is considered to be different from its corresponding line if one or more
characters of text in it are different, if text is missing, or if a line is present for which there is no
corresponding line in the compared file. A difference between two files that are compared as XML
denotes a node that is different from the corresponding node in the compared file. In general, nodes are
considered different if the corresponding text values do not match. What constitutes a difference can
be further refined  in the Comparison Options dialog box.

2. Differences between two compared directories are determined by comparing corresponding files within
the two compared directories. In Quick Comparison Mode, the file sizes and timestamps of the
corresponding files are compared. If one of these is different, the files are said to be different.
Alternatively, corresponding files within directories are compared on the basis of their contents. Such
comparisons are carried out as normal DiffDog file comparisons, and a difference causes the files to be
flagged as different. Also see the definition of Equal Files  and Non-Equal Files .

3. A difference between two Microsoft Word documents denotes a sentence or a paragraph (depending on
the settings you have defined in the Word comparison options ) that is different from the
corresponding sentence/paragraph (if any) in the compared document. Note that the entire
sentence/paragraph is considered to be a single difference—even if the option to show differences
within lines is selected. (This is significant when merging differences because the entire
sentence/paragraph will be merged; merges are not carried out at the character level.) A
sentence/paragraph is considered to be different from its corresponding sentence/paragraph if one or
more characters of text in it are different, if text is missing, or if a sentence/paragraph is present for
which there is no corresponding line in the compared file.

4. A difference between tables in two databases when strings are compared occurs when the string
representation of the data contained in a field is different between the two tables. A difference between
tables in two databases when the content of a database is compared using the database's internal
data types (native comparison) occurs when the content of a field itself (and not its string
representation which might be different for the same content in different databases) in the first table
does not match the content of the corresponding field in the second table.

5. A difference between the structure of schemas in two compared databases occurs when the name or
data type of a database item is different or when a database item exists in one schema that is missing
in the other schema.

6. A difference between two compared XML Schemas occurs when items exist in one XML Schema that
are missing in the other XML Schema or when the names of items are different.

Equal Files
In directory comparisons, files that are identical according to the comparison options, are said to be equal.

Non-equal Files
In directory comparisons, there are two types of non-equal files: (1) a different file (see definition of
Difference  above), and (2) a file that is present in one directory but not in the other. Note that a non-equal file
is not necessarily a different file.

Mapping
In database data, database schema, and XML Schema comparisons, each table, column, or item, respectively,
in the left comparison component has to be assigned a table, column, or item, respectively, in the right
comparison component to be compared with. This process is called mapping in DiffDog and can be done either
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automatically by the application based on column name and/or data type, or manually by the user using the
mouse.

Merging
Differences found in a file, database data, or database schema comparison can be merged, that is, copied from
one file or table, respectively, to the other. The block that is copied overwrites the corresponding block or space
in the compared file/database. In file comparisons, merges are performed for the active (current) difference, and
can be performed in either direction. In database comparisons, merges are performed either for all or for the
selected items. Note that non-equal files in a Directory Comparison can also be copied from one pane
(directory) to the other and that rows that exist only on one side of a database data comparison can be copied
to the other side. 

Synchronizing
Two directories that are different are synchronized by copying or deleting, respectively, all non-equal files and
sub-folders from one directory to the other, or by deleting files that are present in one directory but not in the
other. The default synchronization options are displayed in the Synchronize directories dialog box where they
can be changed for the entire directory. Additionally, you can also edit the synchronization actions for individual
files or sub-folders.
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1.5 Comparison Modes

Files, directories, and database data can be compared in DiffDog in several ways. The comparison mode is
indicated by the icons in the Comparison Mode and Database Data Comparison Mode toolbars. You can
change the comparison mode either by clicking a different toolbar icon or by selecting the desired mode from
the Diff and Merge menu.

The available comparison modes are described below.

File comparison
When a File Comparison  window is active, or when Quick Comparison Mode is toggled off in a Directory
Comparison window, you can select from among the following four file comparison modes:

· Text: Compares files as text files; compares directories with contents treated as text files.

· XML: Compares files as XML files; compares directories with contents treated as XML files.

· Binary: Compares files as binary files; compares directories with contents treated as binary
files.

· File extension: Compares files as text or XML according to settings for file extensions, which
you can make in the File Types  tab of the DiffDog Options dialog (Tools | DiffDog Options);
compares directories with contents treated as text files, XML files, Microsoft Word files, or binary files
according to file extension.

Directory comparison
When a Directory Comparison  window is active, you can choose between Quick Comparison Mode and one
of the four file comparison modes described in the File comparison section above.

·  Quick comparison: Compares files within directories and sub-directories by size and date
modified. This mode is either toggled on or off. When toggled off, the four file comparison modes
become available. Selecting one of the file comparison modes causes directories to be compared in
terms of their contents as text, XML, or binary files.

Database data comparison
When a Databases Data Comparison  window is active, you can select either string comparison or native
comparison.

·  String: Compares the content of database tables as strings with no regard to how the content is
stored in the database.

·  Native: Considers the data type of a database column when comparing tables. The same data, for
example, can be considered different when it is stored in two columns using different data types.

·  XML Native: Treats the content of  XML columns as XML files. This comparison mode is only
available together with the Native comparison mode.
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Current Comparison Mode
DiffDog uses the concept of the current comparison mode. This is the comparison mode that is current at any
given time. For each type of comparison window (file, directory, and database data), a separate current
comparison mode exists at all times. The current comparison mode for each type of comparison window is that
comparison mode most recently selected by you in any of the open comparison windows of that type. When
the application is started, the current comparison modes are the comparison modes that were current at the
time the application was last closed.

Every File Comparison window, Directory Comparison window, and Database Data Comparison window has a
comparison mode.

When new comparison windows (file, directory, or database data) are opened, they have the current
comparison mode for that type of comparison window (file, directory, or database data). Note that the current
comparison mode for file comparisons applies to new directory comparison windows if Quick Comparison Mode
is not the current comparison mode for directory comparisons.

If you change the comparison mode of a comparison window, then that comparison mode applies to that
particular comparison window. The comparison mode of other open comparison windows is not affected.
However, the newly selected comparison mode becomes the current comparison mode and is applied to all
comparison windows that are opened subsequently.
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1.6 The DiffDog Interface

The DiffDog interface displays multiple File Comparison windows, Directory Comparison windows, Word
Comparison Windows, Database Data Comparison windows, Database Schema Comparison windows, and
XML Schema Comparison windows within the DiffDog application window. The schematic diagrams below
illustrate the main parts of the interface. They are accompanied by a brief description of the various interface
parts.

The Database Data, Database Schema, and XML Schema Comparison windows look slightly different than the
File Comparison and Directory Comparison windows. They consist of only one pane which has a left and a right
component that serve for the selection of the data sources and tables for the database or XML Schema
comparison.
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Title Bar
The Title Bar displays the application name (i.e., DiffDog) followed by the name of the active File Comparison
window, Directory Comparison window, Word Comparison window, XML Schema Comparison window,
Database Schema Comparison window, or Database Data Comparison window. At the right-hand side are
buttons to minimize, reduce or maximize, and close the DiffDog application window.

Menu Bar and Toolbars
The Menu Bar displays the menus. Each toolbar displays a group of icons for DiffDog commands. You can
reposition the menu bar and toolbars by dragging their handles to the desired locations. At the right-hand side
are buttons to minimize, reduce or maximize, and close the active comparison window.

File/Directory/Microsoft Word/XML Schema/Database Schema/Database Data Comparison
Window
Multiple File Comparison windows and/or Directory Comparison windows and/or Word Comparison windows
and/or Database Data Comparison windows and/or Database Schema Comparison windows and/or XML
Schema Comparison windows can be open at a time, but only one of them is active. The name of the active
comparison window appears in the title bar and its name tab (at the bottom of the DiffDog application window)
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is highlighted and the name itself is displayed in bold; the name tabs of the other open comparison windows
are grayed out and the names are displayed in normal font. To make another comparison window the active
comparison window, click its name tab.

Each comparison window (file/Microsoft Word or directory) has two panes of equal width arranged side-by-side
and a status bar for that comparison window below the two panes. Above each pane is a file/directory selection
area. This consists of a combo box, where you can enter the name of the file/directory to be compared, or
select a previously opened file or directory from the drop-down menu. The buttons to the right of this area allow
you to browse for files or directories, and to open files, save files and refresh files. The file and directory that is
opened in each pane can therefore be opened independently of the file or directory in the other pane. Once a
file/directory has been opened in both panes of a comparison window, a comparison can be made.

In Directory Comparison windows, directories are displayed as trees, the levels of which can be
expanded/collapsed by double-clicking on a directory-level. Additionally, the width of individual columns can be
adjusted by dragging borders to the desired width. In File Comparison windows, the view of the document can
be customized using commands in the View and Text View menus.

In XML Schema Comparison windows, XML Schemas are selected in two components that are displayed in
one pane of the comparison window. Each component has a title bar displaying the file name of the XML
Schema that is currently loaded into the component, and a browse button that opens the Windows Open dialog
box where the XML Schemas for the left and right comparison component can be selected or changed. The
width of a component can be adjusted by dragging the handle in the lower right corner of the component. The
elements inside a component are displayed as trees. By double-clicking on an element or clicking the plus
symbol next to an element name, the element can be expanded to show the child elements. Elements that are
mapped to their respective counterparts in the other components are connected by connector lines. These
mappings can be selected, deleted, or dragged to other tables/columns using the mouse.

In database comparison windows (schema or data), data sources and tables are selected in two components
that are displayed in one pane of the comparison window. Each component has a title bar displaying the data
source the component is currently connected to, and a browse button that opens the Select Tables for Data
Comparison dialog box where the data sources and tables for the left and right comparison component can be
selected or changed. The width of a component can be adjusted by dragging the handle in the lower right
corner of the component. The tables and columns inside a component are displayed as trees. By double-
clicking on a table or clicking the plus symbol next to a table name, the table can be expanded to show the
table columns. Tables and columns that are mapped to their respective counterparts in the other components
are connected by connector lines. These mappings can be selected, deleted, or dragged to other
tables/columns using the mouse.

Comparison Window Status Bar
The status bar of a file/Microsoft Word or directory comparison window indicates the status of that comparison.
If files or directories have not been opened, this is indicated. If a comparison has been made, the type of
comparison is reported along with the result of the comparison. The comparison window status bar is not
available in XML Schema comparison windows, database data comparison windows, database data
comparison windows, and should not be confused with the application status bar.

Application Status Bar
The application status bar appears at the bottom of the application window, and shows application-level
information. The most useful of this information are the tooltips that are displayed here when you mouseover a
toolbar icon. The application status bar should not be confused with the comparison window status bar. If you
are using the 64-bit version of DiffDog, this is indicated in the status bar with the suffix (x64) after the
application name. There is no suffix for the 32-bit version.
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2 File Comparison

Altova website:  File compare tool

This chapter provides instructions on how compare two files with DiffDog. The information enclosed here is
applicable to most file types. However, if you intend to compare Microsoft Word documents and XML schemas,
see also the following sections:

· Comparing XML Schemas
· Comparing Microsoft Word Documents

Note: To compare ZIP-conformant files and Office Open XML (OOXML) files, run a directory comparison
instead of a file comparison (since ZIP and OOXML files contain multiple files). Otherwise, if you
attempt to compare ZIP-conformant files using a file comparison, DiffDog will prompt you to run a
directory comparison instead. For more information, see Comparing Directories .

A file comparison in DiffDog involves adding the files to the File Comparison window. The File Comparison
window enables you to view file differences side by side. For step-by-step instructions, see Running a File
Comparison .

File Comparison window

As illustrated above, the File Comparison window consists of two panes called Text View and Grid View. The
Text View is the default editor for most file types. It displays the content of the file, while offering multiple
navigation aids, such as word wrapping, code folding, line numbering, syntax highlighting for numerous file
types, as well as the ability to find and replace text or search by regular expressions. In case of XML files, the
Text View offers even more capabilities, such as automatic highlighting of start and end tags, and pretty-
printing. For more information, see Text View .
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The Grid View is applicable to well-formed files, typically XML documents. It is particularly useful if you want to
see the structure of the document at a glance, easily expand or collapse specific sections, or modify content in
table-like manner, without accidentally changing the XML tags. For more information, see Grid View .

If necessary, you can edit files directly in either the Text View or the Grid View (see Editing Files ). Changes
can be saved back to the original file, or reverted (either using Undo, or by reloading the original file from the
disk). For information about merging differences from one file to another, see Merging Differences .

If you are frequently comparing the same or similar sets of files, you can save the comparison as a file and
open it at a later time (see Saving and Loading Comparisons ).

Various comparison options can be customized (see Modifying the File Comparison Options ).
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2.1 Running a File Comparison

There are two ways to start a file comparison in DiffDog:

1. From the DiffDog graphical user interface
2. From Windows Explorer, by right-clicking a file and using the Compare with DiffDog context menu

command.

Depending on your preferences, comparisons may occur automatically immediately after you open both files.
You can also choose to initiate comparisons only explicitly, with a button click.

All these subjects are described in more detail below.

Starting a comparison from DiffDog
To run a file comparison with DiffDog:

1. Select the menu option File | Compare Files or click the Compare files  toolbar button.

2. Choose a comparison mode that is appropriate for the file types being compared (binary, text, XML, or
extension-based). For more information, see Comparison Modes .

3. Select the files to be compared. There are various ways to do this, as follows:

· In the left pane of an existing File Comparison window, click the Open  button and select a file in
the Windows Open dialog box. You can also open a file from a URL (see Opening Files from
URLs ).

· Enter the full path to a file and click the Apply  button.
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· Drag a file from the Windows Explorer into the pane.
· Select a previously compared file from the drop-down list.

4. Repeat any of the steps described in step 3 for the right pane.

Alternatively, you can run a file comparison as follows:

1. On the File menu, click Open (alternatively, press Ctrl+O).

2. In the Open comparison dialog box, select Compare files .
3. Browse for the files to be compared and click OK.

Starting a file comparison from Windows Explorer
Another way to run a file comparison is as follows:

1. In Windows Explorer, select the two files to be compared. To select multiple files in Windows Explorer,
hold the Ctrl key pressed while selecting a file.

2. Right-click one of the files, and select Compare with Altova DiffDog from the context menu.

You can also use this approach with SQLite and Microsoft Access databases, see Quick Comparison of
SQLite and Access Databases .128
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Automatic comparison
By default, when the two documents to be compared are loaded into the comparison window, a comparison is
automatically carried out. To enable or disable automatic comparison, do one of the following:

· On the Diff and Merge menu, select the Autostart Comparison menu command.

· Click the Autostart Comparison  toolbar button.

In addition, comparisons can be explicitly started any number of times. To start a comparison explicitly, do one
of the following:

· On the Diff and Merge menu, select the Start Comparison command.

· Click the Start Comparison  toolbar button.

When editing documents, they are compared dynamically as you type if the Compare while Editing
command is toggled on. To toggle this option on or off, do one of the following:

· On the Diff and Merge menu, select the Compare while Editing command.

· Click the Compare while Editing  toolbar button.

If the Show Options Before Comparison command is toggled on, then the Comparison Options dialog box
is displayed each time before the comparison is run (except when it is run dynamically by DiffDog while you
edit). This is useful if you wish to run comparisons with different options. To toggle this option on or off, do the
following:

· On the Diff and Merge menu, select the Show Options Before Comparison command.

2.1.1 Opening Files from URLs

In addition to opening local files, you can also open files from a URL. The supported protocols are HTTP,
HTTPS, and FTP. Note that files loaded from URLs cannot be saved back to their original location (in other
words, access to the file is read-only), unless they are checked out from a Microsoft® SharePoint® Server, as
shown below.

To open a file from a URL:

1. On the Open dialog box, click Switch to URL.
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2. Enter the URL of the file in the File URL text box, and click Open. 
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If the server requires password authentication, you will be prompted to enter the user name and password. If
you want the user name and password to be remembered next time you start DiffDog, enter them in the Open
dialog box and select the Remember password between application starts check box.

If the file you are loading is not likely to change, select the Use cache/proxy option to cache data and speed
up loading the file. Otherwise, if you want the file to be reloaded each time when you open DiffDog, select
Reload.

For servers with Web Distributed Authoring and Versioning (WebDAV) support, you can browse files after
entering the server URL in the Server URL text box and clicking Browse. 

Note: The Browse function is only available on servers which support WebDAV and on Microsoft SharePoint
Servers.

If the server is a Microsoft® SharePoint® Server, select the This is a Microsoft® SharePoint® Server check
box. Doing so displays the check-in or check-out state of the file in the preview area.
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The state of the file can be one of the following:

Checked in. Available for check-out.

Checked out by another user. Not available for check-out.

Checked out locally. Can be edited and checked-in.

To be able to modify the file in DiffDog, right-click the file and select Check Out. When a file is checked out
from Microsoft® SharePoint®, saving the file in DiffDog sends the changes back to the server. To check in the
file back to the server, right-click the file in the dialog box above, and select Check In from the context menu
(alternatively, log on to the server and perform this operation directly from the browser). To discard the changes
made to the file since it was checked out, right-click the file, and select Undo Check Out (or perform this
operation from the browser).

Note the following:

· When a file is already checked out by another user, it is not available for check out.
· If you check out a file in one Altova application, you cannot check it out in another Altova application.

The file is considered to be already checked out to you.



34 File Comparison Three-Way Comparisons

© 2016-2022 Altova GmbHAltova DiffDog 2023 Enterprise Edition

2.2 Three-Way Comparisons

With DiffDog, you can compare not only pairs of files, but also three files in a side-by-side manner. This kind of
comparison is particularly useful to compare two files against a base copy from which both files originate. For
example, let's assume that two people, Alice and Bob, created their own copies of an original file (let's call it
"the common ancestor file", or "the base file"). If both Alice and Bob subsequently made edits to their copy,
you can open all three files and compare them side-by-side in DiffDog. 

A triple way comparison would help you display all changes made by both Alice and Bob compared to the
common ancestor file, and navigate all the differences. For each encountered difference, you can decide whose
change ("left", "right", or "middle") should be kept. The chevrons in the diagram above show the directions in
which you can merge a particular change (for example, from Alice's file into the base file, or from the base file
into Bob's file).

Importantly, it might be the case that both Alice and Bob edited the same line of text, in which case a conflict
occurs. All the conflicts are identified and highlighted by DiffDog, and you can resolve them by accepting either
Alice's or Bob's change into the final version. A conflict essentially means that the program cannot reasonably
determine which change ("left", "middle", or "right") is the one you want to keep in the final version. To resolve
the conflict, you must explicitly instruct DiffDog to merge text either from Alice's file into the base file (or the
other way round), or from Bob's file into the base file (or the other way round).
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Three way comparison

In the image above, the middle pane displays the common ancestor file; the left pane displays Alice's version,
and the right pane display's Bob's version. After you run a three way comparison, DiffDog highlights any
differences and conflicts as follows:

· Differences between the "left" file and the "middle" file. For example, Alice changed line 3 which is
highlighted as a change.

· Differences between the "right" file and the "middle" file. For example, Bob changed line 2 which is
highlighted as a change.

· If any conflicts are detected between the three files, they are highlighted as well. For example, both
Alice and Bob changed line 5, which is highlighted as a conflict.

To run a three-way comparison:

1. On the File menu, click Compare Files 3-way. (Alternatively, click the Toggle 2-way/3-way

Comparison  toolbar button. You can also select three files in Windows Explorer, right-click and
select Compare with Altova DiffDog from the context menu.)

2. At the top-right corner of each comparison pane, click Open  to add the required files to the
comparison. You can also drag files from Windows Explorer into each of the three panes.

Note: The file into which you want to merge changes from both versions must be opened in the middle pane
(because merging is possible, for example, from right to middle, or left to middle, but not from right to
left, or left to right). See also Swapping Panes .
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3. On the Diff and Merge menu, click Start Comparison (alternatively, click Compare  or press

F5). This step is not necessary if Autostart Comparison   option is enabled.

To switch from a two-way comparison to a three-way comparison, and vice versa:

· On the View menu, click Toggle 2-way/3-way Comparison (or click Toggle 2-way/3-way

Comparison  toolbar button). The file comparison window now includes three panes instead of two.

After you run a three-way comparison, the total number of differences and conflicts is visible at all times in the
status bar. The color used by DiffDog to highlight differences and conflicts can be adjusted from Tools |
DiffDog Options | File Comparison  tab.

Three-way comparison works in a similar way for other file types, including XML files. Note that, with XML files,
you can view the differences in the Grid View , in addition to the Text View.

Note: Three-way comparisons are not supported for Word documents or directories.

Three-way comparisons can be saved to a .filedif file and re-opened later just like two-way comparisons, see
Saving and Loading Comparisons .

2.2.1 Navigating and Merging Three-Way Differences

With three-way comparisons, you can navigate differences between the three panes in a similar way as with
two-way comparisons, from the Diff and Merge menu and toolbar. For example, you can run the Next

difference (Alt+Down)  command to navigate to the next difference and Previous difference (Alt+Down)

 to navigate in the opposite direction, see also Navigating Differences . 

Unlike two-way comparisons, three-way comparisons may result in conflicts and also require special merging
commands (for example, to copy a difference from left to middle pane, or from middle to right). All the
commands specific to three-way comparisons are available in the 3-Way Comparison toolbar. This toolbar
appears automatically when a 3-way comparison is toggled on. You can also explicitly show or hide it from
Tools | Customize | Toolbars tab.

3-Way Comparison Toolbar

The 3-Way Comparison toolbar contains the following commands:

Previous Conflict Jump to the previous conflict. 

Next Conflict Jump to the next conflict. 

Copy from left to middle Copy (merge) the current difference from the left pane to the middle
pane.
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Copy from middle to left Copy (merge) the current difference from the middle pane into the left
pane.

Copy from middle to right Copy (merge) the current difference from the middle pane to the right
pane.

Copy from right to middle Copy (merge) the current difference from the right pane to the middle
pane.

Change document order
(Swap panes)

Enables you to swap the left or right pane with the middle one, see
Swapping Panes .

Note the following:

· The commands above are enabled only if they are meaningful for the current difference or conflict. For
example, the commands "Copy from left to middle" and "Copy from middle to left" are disabled if the
current difference is between the middle and right panes (but not the left one).

Other commands that can be issued in the context of three-way merges are the same as for two-way merges,
namely:

· To undo a merge change, first click inside the pane where you want to undo the change, and then run
the Edit | Undo menu command (or Ctrl+Z keyboard shortcut). The same applies for the Edit | Redo
menu command (and its respective Ctrl+Y keyboard shortcut).

· To save any merges made from DiffDog to a file, click the Save  or Save As  buttons at the
top-right corner of each pane. To reload the file content from the disk (and thus lose any unsaved

changes made from DiffDog), click Refresh ). See also Editing Files  and Saving Files .
· Differences resulting from three-way comparisons can be exported to an XML or text file, see Exporting

Differences .

2.2.2 Swapping Panes

By default, when you open three files for comparison, the one from the middle pane is treated as the "common
ancestor", or base file (that is, the one into which you want to merge changes from two sources). Using the
previous example, if you want to merge Bob's or Alice's version into the common ancestor file, then this file
must be opened in the middle pane. This would enable you to merge changes from both the left and right panes
into it. 
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However, it is also possible to swap the panes if necessary. For example, you may decide that you want to
keep Alice's version. In this case, you can swap Alice's version with the base file (so that Alice's file is in the
middle pane). This way, you can merge into Alice's file changes from both the base file and Bob's file.
Swapping may also be necessary if you opened three files by right-clicking them in Windows Explorer.

To swap panes:

1. Click the Change Document Order  button on the 3-Way Comparison Toolbar. A dialog box
appears.

2. Select the desired target pane (middle, right, left) next to each file, and click OK.
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2.3 Modifying the File Comparison Options

The options of a file comparison can be changed in the Comparison Options dialog box. This dialog box
provides separate tabs for text and XML comparison. To open the Comparison Options dialog box:

· On the Tools menu, click Comparison Options.

In addition, the Diff and Merge menu offers several toggle commands which can be switched on or off via the
menu:

· Show Options Before Comparison
· Autostart Comparison
· Compare while Editing
· Support Recently Compared Pairs

General options for the comparison of files are furthermore available in the File comparison  tab of the DiffDog
Options dialog box.
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2.3.1 Options for Text Comparison

The Text tab of the Comparison Options dialog box displays the options that are used for text comparison.

View results
By selecting the Show differences within lines check box, you can display the differences on character

level. Note that the Compare as Text  button must be active in order to display differences within lines
(see Comparison Modes ).

If the check box is deactivated, differences are displayed only on line level, that is, character level differences
are not highlighted. Only the line, as a whole, is indicated as being different.

21
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Whitespace
See Comparison Options for Whitespace Characters .

Case sensitivity
Activate the Ignore case check box if upper and lower casing should be ignored when checking for
differences.

Lines
Here you define whether blank lines should be ignored.

2.3.2 Options for XML Comparison

The XML tab of the Comparison Options dialog box displays the options that are used for XML-based
comparison.
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View results
The Detailed differencing option enables you to show differences in detail or reduce the number of differences
(so that navigation is faster). With detailed differencing toggled off, consecutive nodes that are different are
displayed as a single node. This applies also to consecutive nodes on different hierarchical levels, such as an
element node and its child attribute node. Please note that detailed differencing must be checked to enable
merging and exporting differences.

This setting is not applicable when performing database data comparisons and the column data type is XML.

Whitespace
See Comparison Options for Whitespace Characters .

Namespace/Prefix
These are options for ignoring namespaces and prefixes when searching for differences.

Entities
If Resolve entities is selected, then all entities in the document are resolved. Otherwise the files are compared
with the entities as is.

Text
If Ignore text is selected, then differences in corresponding text nodes are not reported. Only the XML
structure is compared but not the text content. This is useful when you want to compare two XML structures
and disregard the actual content. For example, let's assume that the Ignore text check box is selected. In this
case, the following two XML files are equal (even though their content differs).
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Depth
If Ignore node depth is selected, then elements are treated as equal without regard to their depth. For
example, let's assume that the check box Ignore node depth is selected. In this case, in a comparison like
the one below, element <c> is equal on both sides, even though it is nested deeper on the right side.

Note: When the Ignore node depth check box is selected, merging and exporting differences are not
possible.

Case sensitivity
If the Ignore case check box is checked, then case is ignored, and you have the option of ignoring or not
ignoring case in node names.

Order
If Ignore order of child nodes is selected, then the relative position of the child nodes of an element is
ignored, provided that the individual nodes within a node level have unique node names. As long as an element
node with the same name exists in each of the two sets of sibling nodes, the two sets are considered to be
equal. In the following example, the order of the <Name> and <FirstName> nodes is different in the left and
right file and is marked as different if the Ignore order of child nodes option is deactivated.

Checking the Ignore order of child nodes option will ignore this difference in the comparison window.
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Note, however, that DiffDog can ignore the order of child nodes only if the node names on a certain node level
are unique. If several occurrences of a node appear, e.g. with different attributes assigned, a node, if appearing
in a different order, will always be considered unequal to an element with the same name and attribute in the
compared sibling set—even if the Ignore order of child nodes is selected. If we add different attributes to the
<Phone> node of our example, then the difference in order of the three occurrences of the <Phone> node will
appear in the comparison window although the Ignore order of child nodes check box is selected.

In order to ignore the order of several occurrences of child nodes that have different attributes assigned, you can
add these attributes as comparison criteria. DiffDog provides two options: (i) add all attributes and (ii) define a
list of specific attributes, which in our example will both result in the <Phone> nodes being displayed as equal.
However, if you select the Specific attributes option, you will first have to define an attribute group
accordingly.

It may happen that several occurrences of child nodes appear that have also the same attribute assigned (e.g.
a person with more than one mobile phone number in our example). In the image below, the All attributes
radio button has been selected, however differences are still reported since two mobile phone numbers are
listed.

In DiffDog you can cope also with this scenario by activating the Add element text as comparison criteria
check box. If element text, attribute value, and node name are identical and only the order of the nodes is
different, no differences will be reported.

Note that, if the Ignore Order option is specified, then the merge functionality also ignores the order. If Ignore
order of child nodes is unselected, then differences in order are represented as differences.

The option of ignoring the order of attributes is also available, and applies to the order of attributes of a single
element. In the above example, the Ignore order of attributes option has been checked and DiffDog,
therefore, has ignored the order of the attributes of the <Person> node. Note that the order of attributes will
always be ignored, if the Ignore order or child nodes check box is activated. In the screenshot below, both
the Ignore order of child nodes and the Ignore order of attributes check box are deactivated.
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Ignore node types
Check the node types that will not be compared in the Compare session. Node types that may be ignored are
Attributes, CDATA, Comments, Processing Instructions, DOCTYPE statements, and XML declarations.

Filter out specific elements/attributes
Enables you to define filters  to set what elements and/or attributes should not be considered for
comparison. A filter is defined at the application level, which means that once a filter is defined, it is available
for every comparison. More than one filter can be defined, and, for every comparison, the filter to be used is
selected in the drop-down list in the Filter out specific elements/attributes group box.

2.3.2.1  Defining Groups of Attributes

If you choose the Specific attributes radio button in the Order group box, the Define groups of attributes as
comparison criteria dialog box opens where you can create different lists of attributes that shall be used as
comparison criteria.

47



46 File Comparison Modifying the File Comparison Options

© 2016-2022 Altova GmbHAltova DiffDog 2023 Enterprise Edition

Attributes to be considered as comparison criteria are organized in attribute groups, that is, you first have to
define an attribute group and then add the relevant attributes to the group. You can select the attribute group to
be used from the Specific attributes drop-down list in the Comparison Options dialog box.



© 2016-2022 Altova GmbH

Modifying the File Comparison Options 47File Comparison

Altova DiffDog 2023 Enterprise Edition

To define groups of attributes to be considered as comparison criteria:

1. Select the menu option Tools | Comparison Options... or click the Comparison Options 
 button in the Diff and Merge toolbar, and change to the XML tab.

2. In the "Order" group box, activate the radio button Specific attributes and click the Browse 
button next to the drop-down list to open the Define groups of attributes as comparison criteria dialog
box.

3. In the "Attribute groups" group box, click the respective icon to append  or insert  a group to the
list of groups and give it a name. Always define a group before specifying attributes. Do not enter the
attributes in the "Attribute groups" group box.

4. With the attribute group selected, in the "Add attributes as comparison" group box, click the respective

icon to append  or insert  elements to the list and enter the name of the attribute that should be
considered. Add an extra list element for each attribute.

5. When done with defining attribute groups, click OK. The defined attribute groups are now available in
the combo box in the Comparison Options dialog box.

2.3.2.2  Defining a Filter to Ignore Elements or Attributes for Comparison

Filters are defined by clicking the Define Filters  button in the Comparison Options dialog box, which pops
up the Define Filters dialog box.
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In the image above, two filters (Filter1 and Filter2) have been defined. Filter1 specifies that the elements
email and name, and the attributes href and name, are to be ignored for comparison.

To create a filter for ignoring element/attributes for comparison:

1. Select the menu option Tools | Comparison Options... or click the Comparison Options 
 button in the Diff and Merge toolbar, and change to the XML tab.

2. In the Filter out specific elements/attributes group box, click the Define Filters  button to open the
Define filters dialog box.

3. In the Filters group box, click the respective icon to append  or insert  a filter to the list of filters
and give it a name.

4. With the filter selected, in the Ignore Elements/Attributes group box, click the respective icon to

append  or insert  elements and filters to the list. The Ele check box is activated by default.
5. Deactivate the Ele check box and/or activate the Att check box, if required, and enter a name for the

element/attribute.
6. Optionally, repeat steps 4 and 5 for additional elements/attributes.
7. When done with defining a filter, click OK. The defined filters are now available in the combo box in the

Comparison Options dialog box.
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2.3.3 Comparison Options for Whitespace Characters

Whitespace characters are any of the following: space, tab, carriage return, and line feed. You can change the
comparison options for whitespace characters from the Tools | Comparison Options menu.

When the Compare as is option is enabled, Text A is considered equal to Text B if characters in Text A
(including whitespace characters) correspond to those in Text B. The whitespace characters are relevant for
comparison.

When the Normalize option is enabled, Text A is equal to Text B if, after normalization, characters in Text A
correspond to those in Text B. “Normalization” means that multiple consecutive occurrences of whitespace
characters are replaced by a single space character. Also, the leading and trailing whitespace characters are
trimmed for each line of text.

Note: In case of XML (  ) comparison, the leading and trailing whitespace characters in element and
attribute values are trimmed.

When the Strip all option is enabled, Text A is considered equal to Text B if, after stripping whitespace
characters, characters in Text A correspond to those in Text B. In other words, any whitespace characters are
stripped from the text and considered not relevant for comparison. 

Note: In case of XML comparison (  ), whitespace characters that are outside attribute or element values
are disregarded for comparison. This is true for any of the whitespace options above.

The following table illustrates differences when comparing text with each option, using text (  ) or Word
comparison.

Text A Text B As is Normalize Strip

"a" "a " not equal equal equal

"a" " a" not equal equal equal

"a a" "a  a" not equal equal equal

The following table illustrates differences when comparing text with each option, using XML (  ) comparison.

Text A Text B As is Normaliz
e

Strip

<?xml version="1.0" <?xml   version="1.0" equal equal equal

<book id="1"> <book id=" 1 "> not equal equal equal
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Text A Text B As is Normaliz
e

Strip

<author>Mark
Twain</author>

<author>Mark  
Twain</author>

not equal equal equal



© 2016-2022 Altova GmbH

Displaying Differences in Files 51File Comparison

Altova DiffDog 2023 Enterprise Edition

2.4 Displaying Differences in Files

After you start a comparison, the differences between the two files are displayed as blocks of highlighted text
and the results of the comparison are reported in the Comparison Window Status Bar. Normally, Text View
is used for displaying differences, however if you compare well-formed files, you can also switch to Grid
View .

2.4.1 Text View

Text View is the standard display mode for any file pair being compared in DiffDog. Notice that the
corresponding differences in the two documents are linked for easier identification and analysis. When
synchronized scrolling  is toggled on, both documents scroll so that corresponding differences are always in
view simultaneously.

The current difference is highlighted in a different color than the other differences. In the screenshot above the
current difference is displayed in a darker green. These colors can be changed in the DiffDog Options . It is
important to know which difference is the current difference because merging  is always done for the current
difference only. You can navigate  among the differences with the navigation commands that are available in
the Diff and Merge menu and as toolbar icons.

2.4.1.1  Using Visual Aids in Text View

Text View has multiple visual aids to make the display and editing of text easier. These include:

· Line Numbers
· Syntax Coloring
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· Bookmarks
· Source Folding
· Indentation Guides
· End-of-Line and Whitespace Markers
· Zooming
· Go-to-Line/Character
· Pretty-printing
· Word wrapping
· Start and end tag matching
· Text highlighting

Where applicable, you can toggle or customize the features above from the Text View Settings dialog box.
Settings in the Text View Settings dialog box apply to the entire application—not only to the active document.

Text View Settings dialog box

To open the Text View settings dialog box, do one of the following:

· On the Text View menu, select Text View Settings.
· Click the Text View Settings button in the Text toolbar. 

Some of the navigation aids can also be toggled from the Text toolbar, the application menu, or keyboard
shortcuts. 

Text toolbar

For reference to all shortcuts applicable in the File Comparison window, see the "Key Map" section of the Text
View Settings dialog box illustrated above.
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Line numbers
Line numbers are displayed in the line numbers margin, which can be toggled on and off in the Text View
Settings dialog box. When a section of text is collapsed, the line numbers of the collapsed text are also
hidden. A related command is the Go-to-Line/Character  command.

Syntax coloring
Syntax coloring is applied according to the semantic value of the text. For example, in XML documents,
depending on whether the XML node is an element, attribute, content, CDATA section, comment, or processing
instruction, the node name (and in some cases the node's content) is colored differently. You can enable or
disable syntax coloring for various file extensions (including custom extensions) from the Tools | DiffDog
Options menu, File Types  tab.

Bookmarks
Lines in the document can be separately bookmarked for quick reference and access. If the bookmarks margin
is toggled on, bookmarks are displayed in the bookmarks margin; otherwise, bookmarked lines are highlighted
in cyan.

The bookmarks margin can be toggled on or off in the Text View Settings dialog box.

You can edit and navigate bookmarks using commands in the Text View menu and Text toolbar. Bookmarks
can be inserted with the Text View | Insert/Remove Bookmark command, enabling you to mark a line in the
document for reference. A bookmark can be removed by selecting the bookmarked line and then selecting the
Text View | Insert/Remove Bookmark command. To navigate through the bookmarks in a document, use the
Text View | Next Bookmark and Text View | Previous Bookmark commands. These bookmark commands
are also available as icons in the Text toolbar.

Source folding
Source folding refers to the ability to expand and collapse nodes and is displayed in the source folding margin.
The margin can be toggled on and off in the Text View Settings dialog box. To expand or collapse portions of
text, click the "+" and "-" nodes at the left side of the window. Any portions of collapsed code are displayed
with an ellipsis symbol. To preview the collapsed code without expanding it, move the mouse cursor over the
ellipsis. This opens a tooltip that displays the code being previewed, as shown in the image below. Note that, if
the previewed text is too big to fit in the tooltip, an additional ellipsis appears at the end of the tooltip.
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The Toggle All Folds command in the Text toolbar toggles all nodes together to their expanded or collapsed
forms.

Indentation guides
Indentation guides are vertical dotted lines that indicate the extent of a line's indentation (see screenshot
above). They can be toggled on and off in the Text View Settings dialog box.

End-of-line markers, whitespace markers
End-of-line (EOL) markers and whitespace markers can be toggled on in the Text View Settings dialog box.
The screenshot below shows these markers in the document display; each dot represents a whitespace.

Zooming in and out
You can zoom in and out of Text View by scrolling (with the scroll-wheel of the mouse) while keeping the Ctrl
key pressed. This enables you to magnify and reduce the size of text in Text View. If you wish to increase the
size of fonts, do this in the DiffDog Options  dialog box.

Go to line/character
This command in the View menu and Text toolbar enables you to go to a specific line and character in the
document text.
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Pretty-printing
The Pretty-Print XML Text command reformats the active XML document in Text View to give a structured
display of the document. Each child node is offset from its parent by four space characters.

To pretty-print an XML document, select the Text View | Pretty-Print XML Text menu command, or click the

 button in the Text toolbar

Note: The Pretty-Print XML Text command is not a toggle command. Once the command is executed, the
pretty-printed format cannot be undone by clicking the Pretty-Print XML Text command again. To undo
the pretty-printed format, use the Undo  (Ctrl+Z or Alt+Backspace) command.

Word wrapping
To toggle word wrapping in the currently active document, select the Text View | Word Wrap menu

command, or click the  button in the Text toolbar.

Start and end tag matching
When you place the cursor inside a start or end tag of a markup element, the corresponding start or end tag is
highlighted as well. When you edit the name of an element in a start tag, then the end tag will be automatically
edited as well.

Text highlighting
When you select text, all matches in the document of the text selection that you make are highlighted
automatically. The selection is highlighted in pale blue, and matches are highlighted in pale orange. The
selection and its matches are indicated in the scroll bar by gray marker-squares. The current cursor position is
given by the blue cursor-marker in the scroll bar.

2.4.2 Grid View

Altova website:  xml diff

Grid View can be used to display files that are well-formed, typically XML files. In Grid View, each node is
displayed as a row in a grid. This enables you to see the hierarchy in a graphical view, to navigate through the
document more easily, and to manipulate the structure of the document using graphical mechanisms such as
drag-and-drop.
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Note the following points, all of which can be seen in the screenshot above:

· Node names are displayed in bold, their contents in normal font.
· Different node types are indicated with different symbols. For example, attributes are indicated with a

red = symbol, elements with red angular brackets.
· Nodes that are different from one document to the other are highlighted, with the current difference

being highlighted in a different color.
· Corresponding differences in the two documents are joined with a line.

Nodes (rows) can be expanded and collapsed by clicking on the upward arrow button at the extreme left of a
grid row. To edit a node name or node contents, double-click the location where you wish to insert the cursor.

Grid rows can be dragged to new locations by selecting the row and dragging it to the desired location. Multiple
nodes that are contiguously located can be selected for this operation. Individual nodes can also be moved
left  or moved right  using the respective Grid View menu commands (or their toolbar icons). This
changes the position of the node in the document hierarchy. Graphical manipulation of structure and contents
is further enhanced in Table View , which is another mode of Grid View.

Columns can be resized by dragging their borders left or right.
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2.4.2.1  Displaying Repeating Elements as Table

In normal Grid View, each node has a grid row to itself, as shown in the screenshot below.

When an element occurs multiple times at the same hierarchical level (as is the case with the member element
in the screenshot above), it can be displayed as a table in which each occurrence of the element created as a
table is represented as a row. The table element's child nodes (attributes, elements, etc) are displayed as
columns of the table.

To display multiple elements as table:

1. Select one of the occurrences of the element to be created as a table.

2. Select the menu option Grid View | Table | Display as Table or click the Display as Table 
button in the Grid toolbar.

To switch from Table View to the normal Grid View:

· Select the table or any of its rows (not a column or cell), and click the Display as Table  toolbar
icon.
The table element switches to normal Grid View.
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Editing the table
The structure and contents of the table can also be edited using table mechanisms. For example, rows (new
table element occurrences) and columns (new child nodes for all table element occurrences) can be inserted
into the table, and the table can be sorted on one of its columns.

In the screenshot above, the table (for member elements) is sorted on the pop column. (This was done by
selecting the pop column and then clicking the command Grid View | Table | Ascending Sort.)
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2.5 Editing Files

After you have run a comparison  and investigated the differences  of the two files, you can edit the
content of the files directly in DiffDog. The available editing features differ for text-based and XML-based files.

Changes to the content  of both text-based and XML-based files are made in Text View. When comparing
well-formed XML-based files, DiffDog's Grid View allows you to also change the document structure  of the
files.

Reloading files
You can always undo all changes you have made to a document since you last saved it, and reload the file into
DiffDog. A warning message will be displayed if you are about to lose changes.

To reload a file into DiffDog:

1. In the respective pane of a comparison window, click the Reload  button.
2. If the file has changed since you last saved it, a warning message is displayed.

3. Click Yes if you want to reload, or No if you want to cancel the operation.

2.5.1 Changing the Content

In Text View, DiffDog provides syntax coloring and other visual aids such as line numbering, indentation, and
bookmarking, as well as powerful Find and Replace functionality that can help with editing (see Using Visual
Aids in Text View ). A history of changes is maintained for each file separately, and unlimited Undos are
allowed.

If you have the Compare while Editing  option activated in the Diff and Merge menu, the comparison of
the files is refreshed continuously as you type.

To edit files:

· Type in your changes in the respective pane of the File Comparison window.
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To undo changes made in a pane:

· Place the cursor in the pane and click Edit | Undo or press Ctrl+Z.

2.5.2 Changing the Structure

The Grid View shows the hierarchical structure of well-formed, XML-based documents through a set of nested
containers, that can be easily expanded and collapsed to get a clear picture of the document's structure. In
Grid View contents and structure can both be easily manipulated. For example, you can insert or append new
elements or attributes, edit the content of the file, or drag the individual elements to a different location in the
document. 

To modify the file structure in Grid View:

1. Click to select the element or attribute where you want to make the change.
2. Use the commands available in the Grid View menu (for example, GridView | Insert | New

Element). Alternatively, right-click an element and select the appropriate context menu commands.
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2.6 Finding and Replacing Text

DiffDog offers powerful Find and Replace functionality that can help with editing. Please note that the scope of
the Find, Find next, and Replace commands is the active document, and not both documents of a file
comparison.

The Find and Replace options are different for Text View and Grid View. See Finding and Replacing in Text
View  and Finding and Replacing in Grid View , respectively.

2.6.1 Finding and Replacing in Text View

You can search for a term in the entire document or within a text selection. To start a search in Text View
mode, press Ctrl+F or select the menu command Edit | Find. You can enter a string or use the combo box to
select a string from one of the last 10 strings. When you enter or select a string, all matches are highlighted,
and the positions of the matches are indicated by orange markers in the scroll bar (see screenshot below). The
position of the currently selected match (highlighted in gray) depends on where the cursor was last located. 

You can see the total number of matches and the index position of the currently selected match. Use the 

(Previous) and  (Next) buttons to switch between the matches. To switch between the Find and Replace

modes, click the  button.

Find options
You can specify find criteria with the help of the buttons located under the search field. The list of the available
options is given in the table below.

Option Icon Description

Match case Does a case-sensitive search: e.g., Address is not the same as address.
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Option Icon Description

Match whole word Only identical words will match.

Use regular
expression

If this option is toggled on, the search term will be read as a regular
expression. See Regular expressions below.

Find anchor The position of an anchor depends on the place where the cursor was last
located. Clicking the Previous and Next buttons does not change the
position of the anchor. 

Find in selection A selection is a marked piece of text. To find a term within a selection, mark
a piece of text, press Ctrl+F, make sure the Find in selection button is
pressed, and type the term in the search field.

Regular expressions
You can use regular expressions to find a text string. To do this, switch on the Use regular expressions

option (see table above). Then enter a regular expression in the search field. Clicking  (Regular
Expression Builder) gives you a list of sample regular expressions (see below). The screenshot below shows
a regular expression that helps find email addresses. 

Regular expression metacharacters
The table below shows metacharacters that you can use to find and replace text. All the metacharacters
except for the last two correspond to the menu items in Regular Expression Builder (see above).

Menu item Metacharacters Description

Any Character . Matches any character. This is a placeholder for a single character.

Character in
Range

[...] Matches any characters in this set. For example, [abc] matches

any of the characters a, b or c. You can also use ranges: e.g., [a-z]

for any lower case character.

Character Not in [^...] Matches any characters not in this set. For example, [^A-Za-z]
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Menu item Metacharacters Description

Range matches any character except an alphabetic character.

Beginning of
Word

\< Matches the beginning of a word.

End of Word \> Matches the end of a word.

Beginning of Line ^ Matches the beginning of a line unless it is used inside a set (see
above).

End of Line $ Matches the end of a line. For example, A+$ matches one or more

A's at the end of a line.

Tagged
Expression

(abc) The parentheses mark the start and end of a tagged expression.
Tagged expressions may be useful when you need to tag
("remember") a matched region to refer to it later. Up to nine sub-
expressions can be tagged and then back-referenced later.

For example, (the) \1 matches the string the the. This

expression can be explained as follows: Match the string the and
remember it as a tagged region; the expression must be followed by
a space character and a back-reference to the tagged region
matched previously.

0 or More
Matches

* Matches zero or more matches of the preceding expression. For
example, Sa*m matches Sm, Sam, Saam, Saaam and so on.

1 or More
Matches

+ Matches one or more occurrences of the preceding expression. For
example, Sa+m matches Sam, Saam, Saaam and so on.

\n Where n is 1 through 9, n refers to the first through ninth tagged
region (see above). For example, if the search string is Fred\([1-9]

\)XXX and the replace string is Sam\1YYY, when applied to

Fred2XXX, this will generate Sam2YYY.

\x Allows using a character x, which would otherwise have a special
meaning. For example, \[ would be interpreted as [ and not as the
start of a character set.

See also Example: Replacing Text Using Regular Expressions . 

Replace text
To replace text, follow the instructions below:

1. Open the Replace dialog: Press Ctrl+H or select the menu command Edit | Replace. Alternatively,

you can switch to Replace mode of the Find/Replace dialog by clicking the  button in the top left
corner of the dialog.
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2. Enter the string you would like to replace in the Find field and enter the new string in the Replace
field. 

3. The Replace Next and Replace All buttons are located to the right of the Replace field. If you click
Replace Next, one of the following happens: (i) If the cursor is located near a match or inside a
match, the match is replaced; (ii) if the cursor is located outside a match, the cursor jumps to the next
match. Click Replace All to replace all matches. 

Replace text within a selection
To replace text within a selection, take the steps below: 

1. Mark a piece of text. 
2. Toggle on the Find in selection option. 
3. Enter the Find and Replace text strings. 
4. Click Replace Next or Replace All as required. 

To undo the replace action, press Ctrl+Z or select Edit | Undo.

Find and replace special characters
If the Use regular expressions option is enabled, you can search for any of the following special characters
within the text:

· \t (Tab)
· \r (Carriage Return)
· \n (New line)
· \\ (Backslash)

For example, to find a tab character, press Ctrl + F, select the Use regular expressions option, and enter \t

in the Find dialog box.

The special characters above can also be used as replacement text. For example, to replace all occurrences of
semi-colons by carriage returns within the text A;B;C;D, use the following find and replace options:

The outcome is shown below:

A
B
C
D
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2.6.2 Finding and Replacing in Grid View

To search for text in Grid View:

1. Place the cursor into the pane in which you want to search for text.
2. Select the menu option Edit | Find or press Ctrl+F.

3. Enter the text you want to search for into the Find what field.
4. To restrict your search, select the required XML node type or DTD declarations to be searched in the

Types  group box.
5. Click Find Next.
6. To jump to the next found occurrence, press F3.

To replace text in Grid View:

1. Place the cursor into the pane in which you want to search for text.
2. Select the menu option Edit | Replace or press Ctrl+H.

66
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Types
In the Types group box, you can select or deselect various XML node type or DTD declarations to be searched.
The Set all and Clear all buttons enable you to check or uncheck all options with a single click.

Search in
You can search only the names and/or the contents of nodes by activating the respective check boxes in the
Search in group box.

Settings
Match case finds the text string only if the casing in the document is the same as that in the entry. Match
whole text only finds the text string only if, in the document, it is delimited by spaces.

Where
The scope of the search can be restricted to the current selection or the whole file can be searched.

Direction
The Up and Down options define whether the search should progress upwards or downwards from the current
selection or cursor location.

2.6.3 Example: Replacing Text Using Regular Expressions

This example illustrates how to find and replace text using regular expressions. In many cases, finding and
replacing text is straightforward and does not require regular expressions at all. However, there may be
instances where you need to manipulate text in a way that cannot be done with a standard find and replace
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operation. Consider, for example, that you have an XML file of several thousand lines where you need to rename
certain elements in one operation, without affecting the content enclosed within them. Another example: you
need to change the order of multiple attributes of an element. This is where regular expressions can help you,
by eliminating a lot of work which would otherwise need to be done manually.

Example 1: Renaming elements
The sample XML code listing below contains a list of books. Let's suppose your goal is to replace the
<Category> element of each book to <Genre>. One of the ways to achieve this goal is by using regular
expressions.

<?xml version="1.0" encoding="UTF-8"?>
<books xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:noNamespaceSchemaLocation="books.xsd">

   <book id="1">

      <author>Mark Twain</author>

      <title>The Adventures of Tom Sawyer</title>

      <category>Fiction</category>

      <year>1876</year>

   </book>

   <book id="2">

      <author>Franz Kafka</author>

      <title>The Metamorphosis</title>

      <category>Fiction</category>

      <year>1912</year>

   </book>

   <book id="3">

      <author>Herman Melville</author>

      <title>Moby Dick</title>

      <category>Fiction</category>

      <year>1851</year>

   </book>

</books>

To solve the requirement, follow the steps below:

1. Press Ctrl+H to open the Find and Replace dialog box.

2. Click Use regular expressions .
3. In the Find field, enter the following text:  <category>(.+)</category> . This regular expression

matches all category elements, and they become highlighted. 
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To match the inner text of each element (which is not known in advance), we used the tagged
expression (.+) . The tagged expression (.+) means "match one or more occurrences of any

character, that is .+ , and remember this match". As shown in the next step, we will need the

reference to the tagged expression later.

4. In the Replace field, enter the following text: <genre>\1</genre> . This regular expression defines the

replacement text. Notice it uses a back-reference \1 to the previously tagged expression from the Find

field. In other words, \1 in this context means "the inner text of the currently matched <category>

element".

5. Click Replace All  and observe the results. All category elements have now been renamed to
genre, which was the intended goal.

Example 2: Changing the order of attributes
The sample XML code listing below contains a list of products. Each product element has two attributes: id
and a size. Let's suppose your goal is to change the order of id and size attributes in each product element
(in other words, the size attribute should come before id). One of the ways to solve this requirement is by
using regular expressions.

<?xml version="1.0" encoding="UTF-8"?>
<products xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:noNamespaceSchemaLocation="products.xsd">

   <product id="1" size="10"/>

   <product id="2" size="20"/>

   <product id="3" size="30"/>

   <product id="4" size="40"/>

   <product id="5" size="50"/>

   <product id="6" size="60"/>

</products>

To solve the requirement, follow the steps below:

1. Press Ctrl+H to open the Find and Replace dialog box.
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2. Click Use regular expressions .
3. In the Find field, enter the following: <product id="(.+)" size="(.+)"/> . This regular expression

matches a product element in the XML document. Notice that, in order to match the value of each
attribute (which is not known in advance), a tagged expression (.+) is used twice. The tagged

expression (.+) matches the value of each attribute (assumed to be one or more occurrences of any

character, that is .+ ).

4. In the Replace field, enter the following: <product size="\2" id="\1"/> . This regular expression

contains the replacement text for each matched product element. Notice that it uses two references \1

and \2 . These correspond to the tagged expressions from the Find field. In other words, \1 means

"the value of attribute id" and \2 means "the value of attribute size".

6. Click Replace All  and observe the results. All product elements have now been updated so that
attribute size comes before attribute id.
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2.7 Saving Files

To save a document you have edited in DiffDog, use the Save  or Save As  buttons in the respective
panes of the comparison window. Files can also be saved using the Close , Close All , and Save
commands in the File menu.

In the File comparison  tab of the DiffDog Options dialog box, you can also specify whether and how backup
files should be saved.

To save a file:

Do one of the following:

· To save an individual file, click the Save  button in its pane of the comparison window.

· To save an individual file under a new name or path, click the Save As  button in its pane of the
comparison window. The Windows Save As dialog box appears where you can specify the new name
or path for the file.

· To save both files of a comparison, select the menu option File | Save. The Save files dialog box
appears where you can select the files to be saved or choose to discharge the changes.

To save and close the files of a comparison:

1. Click the tab of the comparison window that contains the files you want to save and close.
2. Select the menu option File | Close.
3. If a file contains unsaved changes, the Save files dialog box appears. Make sure that the file's check

box is selected and click Save selected. The file is saved and the comparison window is closed.

To save and close the files of all comparisons:

1. Select the menu option File | Close all.
2. For every comparison window that contains a file with unsaved changes, the Save files dialog box

appears. Make sure that the  file's check box is selected and click Save selected. The file is saved
and the comparison window is closed.
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3 Directory Comparison

Altova website:  Folder compare tool

In DiffDog, directories and, optionally, their sub-directories are compared in Directory Comparison windows.
Here you can compare , merge , or synchronize  directories. There are two ways in which DiffDog
compares directories:

· By comparing the sizes and timestamps of files in the directories. This comparison mode  is called
Quick Comparison Mode.

· By comparing the contents of files in directories. This comparison mode is Text Comparison Mode, or
XML Comparison Mode, or Binary Comparison Mode, or Extensions Comparison Mode.

To start a directory comparison in DiffDog, you can either directly choose two directories to compare  or first
open an empty Directory Comparison window and then select the directories to be compared . Alternatively,
you can also select two directories in Windows Explorer , right-click and select  Compare with Altova
DiffDog from the context menu. This will open a new instance of DiffDog and display the selected folders in a
Directory Comparison Window.

The comparison will start automatically unless you have deactivated the Autostart Comparison option in the
Diff and Merge menu. You can change the comparison mode  as desired and restart the comparison. In
addition, to eliminate differences, DiffDog allows you to copy files from one pane to the other .
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To open a directory comparison window:

Do one of the following:

· Select the menu option File | Open or press Ctrl+O. Then do the following:

1. Select Compare directories in the Open comparison dialog box.
2. Choose the directories to be compared in the Content group box.
3. Optionally, select a filter from the File/directory filter drop-down list.
4. Optionally, activate the Include subdirectories check box.
5. Click OK.

A new Directory Comparison window containing the selected directories is opened.

· Select the menu option File | Compare Directories or click the Compare directories  icon in the
Standard toolbar. An empty Directory Comparison window is opened.

ZIP and OOXML files
ZIP-conformant files are regarded as directories if the ZIP conformant file option is selected as the default  file
comparison mode for *.zip files on the File types tab  of the DiffDog Options dialog (this is the default
setting). You can then select a ZIP file as one of the directories in a directory comparison, show the content of
a ZIP file if it appears as a file in a directory comparison, and also copy and merge files that are contained in
the ZIP file.

Office Open XML (OOXML) files—which can be thought of as a specialized form of ZIP archives—are also
opened for comparison in directory comparison windows. After the content of the OOXML file is displayed in the
directory comparison window, you can browse for the document.xml file and open it in a file comparison
window.
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3.1 Opening a Directory Comparison Window

When opening a new Directory Comparison window, the Directory Comparison is given a name of the form
Directory compare X, where X is an integer indicating that directory comparison's position in the sequence of
directory comparisons opened in the current DiffDog session. This name appears in a tab at the bottom of the
window.

Note that the Compare Directories command opens only the Directory Comparison window; it does not open
any directory within the window. The two directories to be compared must be opened  subsequently in the
panes of the comparison window, one in each pane.

To open an empty Directory Comparison window:

· Select the menu option File | Compare Directories or click the Compare directories  button in
the Standard toolbar.
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3.2 Selecting Directories for Comparison

Directories can be selected for comparison in various ways. You can open the directories in a new Directory
Comparison window, re-open a previous comparison , or change the directories in the currently open
Directory Comparison window.

To open directories in a new Directory Comparison window:

1. Select the menu option File | Open or press Ctrl+O.
2. Select Compare directories.
3. Enter the path to the first and the second directory, or click Browse and select a folder from the

system. You can also open a directory from a URL through FTP, HTTP, or HTTPS. The connectivity
instructions are the same as for files, see Opening Files from URLs .

4. Optionally, choose a filter from the File/Directory filter drop-down list if you want to restrict the
displayed content of the directories to certain file types.

5. If required, select the Include subdirectories check box.
6. Click OK. The selected directories are opened in a new Directory Comparison window.

To select directories in the active Directory Comparison window:

1. In the left or right pane of an existing Directory Comparison window, do one of the following:

· Click the Open  icon and select a directory in the Windows Open dialog box.

· Enter the full path of a directory and click the Apply  button.
· Select a previously compared directory from the drop-down list.

To start a directory comparison from Windows Explorer:

1. Select two directories in Windows Explorer.
2. Right-click and choose Compare with Altova DiffDog from the context menu.

A new instance to DiffDog is opened, the selected folders are displayed in a Directory Comparison window, and
the comparison is started automatically.

To open directories from a URL:

1. In the left or right pane of the Directory Comparison window, click Open . The Browse for Folder
dialog box appears.
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2. Click Switch to URL and connect to a server which supports directory browsing, including WebDAV or
Microsoft® SharePoint® Servers. The connectivity instructions are the same as for files, see Opening
Files from URLs .30
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3.3 Modifying the Directory Comparison Options

When comparing directories, the comparison mode  you choose determines how the content of the
directories in the left and right pane of the Directory Comparison window are compared. The basic comparison
mode switch is the Quick Comparison toggle. In order to access Text Comparison Mode, or XML Comparison
Mode, or Binary Comparison Mode, or Extensions Comparison Mode, Quick Comparison must first be
toggled off. 

You can also define which types of files will be displayed in the Directory Comparison window by applying a
filter . In addition, the Diff and Merge menu offers several toggle commands which can be switched on or off
via the menu:

· Show Options Before Comparison
· Autostart Comparison
· Compare while Editing
· Support Recently Compared Pairs

General options for the comparison of directories are furthermore available in the Directory comparison  tab
of the DiffDog Options dialog box.

Note: If a new Directory Comparison window is opened, it assumes the comparison options of the last
comparison window (file or directory) to have had any of its comparison options modified.

To change the mode for directory comparison:

Do one of the following:

· To use Quick Comparison Mode, toggle on Quick Comparison by selecting the menu option Diff and

Merge | Compare only Size and Modification Date or activating the Quick Comparison  icon
in the Comparison Mode toolbar.

· Make sure that Quick Comparison is toggled off and select one of the following comparison modes
from the Diff and Merge menu or activate its corresponding icon in the Comparison Mode toolbar:

· Textual Comparison Only 

· Compare as XML 

· Compare as Binary 

· Compare According to File Extension Settings 
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3.4 Running a Directory Comparison

When the two directories to be compared are loaded into the Directory Comparison window, a comparison is
automatically carried out  if the Autostart Comparison command is toggled on (which is the default setting)
or if you have selected directories in Windows Explorer and used the Compare with Altova DiffDog context
menu command. In addition, comparisons can be explicitly started  any number of times with the Start
Comparison command.

If you double-click a file  in the Directory Comparison window, this file and the corresponding file in the
compared directory are opened in a new File Comparison window and compared immediately.

Filtering the content of compared directories
The Directory content toolbar contains a drop-down list from which you can select a filter  to be applied to
the Directory Comparison window. You can change this filter at any time prior to or after a comparison, or
change the definition of a filter as well as add a new filter.

To run a filtered directory comparison:

Do one of the following:

· When selecting directories for comparison using the File | Open menu option, select a filter from the
File/Directory filter drop-down list in the Open Comparison dialog box.

· If you have already opened a Directory Comparison window, select a filter from the drop-down list that
is available in the Directory content toolbar.

The content in the Directory Comparison window is updated and a comparison is started immediately.
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3.5 Configuring the View

In Directory Comparison windows, you can toggle on and off the display of the Size and Last Modified columns
by right-clicking the Header of either pane and then clicking Size and/or Last Modified.

The column width can also be changed by dragging column borders to the desired location.

Controlling what files are displayed
You can configure the view of individual Directory Comparison windows to display files on the basis of their
compared status. For example, you can opt to not display all equal files, or to not display non-comparable files,
or to display files that are unequal and newer in the left pane but to not display files that are unequal and newer
in the right pane. To do this, you use a set of simple toggle commands that are available as toolbar icons. Note
that the toggle is on when the icon has a border around it (as depicted below).

·  Show/Hide equal: Shows or hides files and sub-directories that are equal in the left and right
pane.

·  Show/Hide left newer: Shows or hides files that are unequal, and where the never version of the
file is located in the left pane.

·  Show/Hide right newer: Shows or hides files that are unequal, and where the never version of
the file is located in the right pane.

·  Show/Hide left only: Toggles on and off the display of subdirectories and files that are present in
the left pane only.

·  Show/Hide right only: Toggles on and off the display of subdirectories and files that are present
in the right pane only.

·  Show/Hide not comparable: Toggles on and off the display of files that are not comparable.
Files are considered to be non-comparable if they cannot be compared in the selected Comparison
Mode . For example, in XML Comparison Mode, file types that have been specified as not being
XML-conformant  are considered to be not comparable.

·  Show/Hide empty directories: Toggles on and off the display of empty directories.

Displaying sub-directories
If, during opening the directories using the File | Open menu option, you have decided to not show sub-
directories in the Directory Comparison window, you can nevertheless activate this option in any stage of the

comparison by clicking the Include Subdirectories  button in the Directory content toolbar. Clicking the
button again will toggle the display of sub-directories off again. With the button toggled on, you can use the
following buttons to customize the display of sub-directories:
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·  Collapse: Collapses all directories that have subdirectories. Note that this command will collapse
all sub-directories in both panes. To collapse a single sub-directory, double-click on it.

·  Expand: Expands all directories that have subdirectories.
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3.6 Displaying Differences in Directories

The directory comparison results are displayed as trees in both panes. If sub-directories are displayed, they
can be collapsed and expanded by double-clicking the icons for them. The comparison results are indicated
with colors and icons as described below.

The colors in which file names are displayed are significant. DiffDog displays the individual files in a Directory
Comparison window in the following colors:

· Black: The file is equal in the selected comparison mode.

Names of files that cannot be compared in the selected comparison mode are also displayed in black.

· Blue: The file is present in the directory in which it is displayed, but not in the other directory.

· Red: The file is present in both directories, but is not equal in the selected comparison mode. Note
that the newer file is colored a brighter red.

Sub-directory names are always displayed in black.

Folder icons
The following icons are used for directories in Directory Comparison windows. Note that expanded directories
are shown with their top right corners turned down (left icon):

·  Directories that contain files that are equal in the selected comparison mode are indicated with
a blank body.
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·  Directories that contain different files in the selected comparison mode are indicated with a
not-equal sign.

·  Directories that contain files that are not present in the corresponding directory in the other
pane are indicated with a blue exclamation mark.

·  Directories that have both extra files and different files are indicated with an exclamation mark
and a not-equal sign.

ZIP and OOXML icons
The following icons for ZIP and OOXML files are used for directories in Directory Comparison windows:

·  If the ZIP archives/OOXML files contain files that are equal in both panes, the ZIP symbol displays
two blank file icons.

·  ZIP archives/OOXML files that contain different files are indicated with a not-equal sign.

·  ZIP archives/OOXML files that contain files that are not present in the corresponding ZIP in the
other pane are indicated with a blue exclamation mark. Note that the exclamation mark is displayed in
the pane where the additional file is located.

·  ZIP archives/OOXML files that have both extra files and different files are indicated with an
exclamation mark and a not-equal sign.

File icons
The following file icons are displayed in Directory Comparison windows:

·  Files that are equal in the selected comparison mode are displayed with a blank body.

·  Files that are non-equal in the selected comparison mode are displayed with a not-equal sign.

·  Files that are not present in the other pane are displayed with a blue exclamation mark.

Comparison symbols
The following symbols appear in the column between the two panes and indicate the results of the directory
comparison, specifically the relationship between the files on either side of the symbol. Note that these
symbols are only displayed for files and not for subdirectories.

·  Files are equal in the selected comparison mode.

·  Files are different in the selected comparison mode.

·  Files cannot be compared in the selected comparison mode.
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3.7 Comparing Files from within a Directory Comparison

Double-clicking a file in either the left or right pane of the Directory Comparison window opens that file and its
corresponding sibling in a new File Comparison window. This is applicable only for files that have a sibling on
the left or right side; otherwise, only the left or right pane of the File Comparison window is populated.

The new file comparison is opened in the current comparison mode  of the directory comparison or—if Quick
Comparison is the comparison mode of the directory comparison—in the comparison mode that was the
current file comparison mode (Text, XML, Binary, or Extensions) when the directory comparison was opened,
respectively.

You can continue to work in the File Comparison window as in a regular file comparison session .
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3.8 Synchronizing Directories

In addition to the merging functionality, which allows you to copy individual files from one pane to the other,
DiffDog in the Diff and Merge menu also provides the Synchronize directories option. This option allows you
to synchronize the content of the two directories in one single step.

The Synchronize directories dialog box can be opened exclusively from a Directory Comparison window, that
is, there is no independent menu option available and you have to open a Directory Comparison window
first. After two directories have been compared  in a Directory Comparison window, you have the following
options:

· Synchronizing the currently displayed directories including their sub-directories
· Selecting a single sub-directory in the Directory Comparison window and synchronizing only that

particular sub-directory

75

78



© 2016-2022 Altova GmbH

Synchronizing Directories 85Directory Comparison

Altova DiffDog 2023 Enterprise Edition

You can further choose from two options: (i) Fully synchronize  all sub-directories and files (left to right or
right to left), or (ii) change the synchronization settings . You can also manually override the
synchronizations actions (such as "copy", "delete", "ignore") for individual files or sub-directories.

To open the Synchronize directories dialog box:

1. Make sure that the two directories that you want to synchronize are displayed in a Directory
Comparison window and that you have compared them.

2. Do one of the following:

· To synchronize the currently displayed directories including their sub-directories, select the menu

option Diff and Merge | Synchronize directories or click the Synchronize  button in the
Directory content toolbar.

· To synchronize only the sub-directory that is selected in the Directory Comparison window, select
the menu option Diff and Merge | Synchronize selected directory or click the Synchronize

selected  button in the Directory content toolbar.

3.8.1 Full Synchronization

If you have selected the Fully synchronize all sub-directories and files check box, you can choose the
synchronization direction either from left to right or from right to left, by selecting the corresponding radio
button. Therefore, the source and target directories are either on the left or on the right, depending on your
choice.

A full synchronization will perform the following actions:

· Files that are different in the source and target directories will be overwritten so that they become
equal. For example, if you synchronize from left to right, the file on the left will overwrite the one on the
right.

· Files that exist only in the source directory will be copied to the target directory.
· Files that exist in the target directory but don't exist in the source directory will be deleted permanently

(or moved to the recycle bin, if possible). For example, if a file is missing on the left side of the
comparison, and if you synchronize from left to right, the right file will be deleted.

· No backup files will be created.

3.8.2 Changing the Synchronization Settings

Within a running session of DiffDog, the Synchronize directories dialog box opens with the previously saved
settings for directory synchronization and displays them in the upper part of the dialog. When a new DiffDog
instance (or session) is opened, the Synchronize directories dialog box opens for the first time with the default
settings. Using the drop-down lists and check boxes, you can adapt those settings so as to meet the
requirements for synchronizing the currently displayed directories.

The options grouped under Different files let you define which files are to be copied, that is, whether older or
newer files are to be kept, and whether they should be copied to the right, or left directory, or to both
directories. The default option copies newer files to the opposite side so that only the newer version of the file
will be kept.
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You can choose from among the following options:

· No action: This option ignores different files.
· Copy newer files: This option copies the newer version of a file to the opposite directory. You can use

the Left to right and Right to left check boxes to limit the update to one particular directory. Check both
boxes to copy the newer files to the opposite directory and thus update both directories.

· Copy older files:  This option copies the older version of a file to the opposite directory. You can use
the Left to right and Right to left check boxes to limit the update to one particular directory. Check both
boxes to copy the older files to the opposite directory and thus update both directories.

The Create backup files check box allows you to keep a backup of a file's previous version in the directory. If
activated, the previous version is saved with a .BAK extension before the updated version is copied to the
directory.

The Enable manual override of synchronization actions check box enables you to fine-tune your
synchronization actions for one or more files or sub-directories, see Overriding the Synchronization Actions .

The options grouped under Missing files/directories determine how missing files and/or directories are to be
handled when directories are synchronized. You can choose whether these options are to be applied to files
and directories or to directories (when copying) or files (when deleting) only. Furthermore, you can define
whether deleted items should be moved to the Recycle Bin if possible or be deleted permanently.

The following options are available for missing files and directories:

· No action: No synchronization for files that are present in only one of the directories.
· Copy missing: Missing files are copied to the opposite directory. You can use the Left to right and

Right to left check boxes to limit the update to one particular directory. Check both boxes to copy
missing files to the opposite directory and thus update both directories.

· Delete missing: Missing files are deleted from the opposite side. You can use the Left only and Right
only check boxes to restrict the deletion to one particular directory. Check both boxes to delete
missing files from the opposite directory and thus delete missing files from both directories.

3.8.3 Overriding the Synchronization Actions

When you perform a full synchronization , synchronization actions (such as "ignore", "copy", or "delete") are
determined based on the direction of the synchronization. For example, if a file is missing on the left side of the
comparison, and if you synchronize from left to right, the default synchronization action for that file is "delete".
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On the other hand, if you changed synchronization settings  at directory level, those will apply instead when
you run a directory synchronization.

If you need even more control, you can override the synchronization actions for one or more individual files or
sub-directories manually. To do this, select the Enable manual override of synchronization actions check
box.

If this check box is selected, the "Sync Action" column provides a drop-down list where you can choose a
synchronization action for an individual file or sub-directory and thus override the settings that have been
defined on directory level.

Warning:
Synchronization actions that were overridden manually take precedence over other synchronization
options.

To define synchronization actions manually for individual files or sub-directories:

1. Make sure that the Enable manual override of synchronization actions check box is selected.
2. Optionally, change the default synchronization options for the directories, see Changing the

Synchronization Settings .
3. Select one of the following options from the "Sync Action" column:

· <blank>: No synchronization for this file or sub-directory.
· copy >: The file or sub-directory will be copied from the left side to the right side without considering

which file is newer.
· < copy: The file or sub-directory will be copied from the right side to the left side without considering

which file is newer.
· delete >: The file or sub-directory will be deleted on the right side.
· < delete: The file or sub-directory will be deleted on the left side.
· < delete >: The file or sub-directory will be deleted on both sides.
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Warning:
If you apply a delete action to a sub-directory, all files that are contained in this directory will be
deleted also, on the chosen side. Since equal files are not displayed in the Synchronize
directories dialog, DiffDog displays a warning so as to alert you to this fact.

4. Click OK. The synchronization action is indicated with a different background color. If you later on
change the overall settings for the directories and the settings happen to match the manually changed
action, the background color will be removed again.

To reset manual synchronization actions:

1. Do one of the following:

· Click the Reset all button.
· Clear the Enable manual override of synchronization actions check box.

2. Click OK in the message box that appears.

3.8.4 Running a Directory Synchronization

After you have configured the synchronization settings  and, if applicable, any manual overrides , you can
run a directory synchronization.

To run a directory synchronization:

1. Open  a Directory Comparison window and run  the comparison.
2. On the Diff and Merge menu, click Synchronize directories.
3. Choose either full synchronization  or define detailed settings  for different and missing files.
4. Optionally, override the synchronization actions  for individual files or sub-directories.
5. Click Start. DiffDog displays a summary that lists actions that will be performed during the

synchronization.
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6. Click OK to commit the changes. If you choose not to run the synchronization and discard the
synchronization settings, click Cancel to return to the Directory Comparison window.
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4 MS Word Comparison

Microsoft Word Document Comparison integrates Microsoft Word into the DiffDog GUI and uses some 
Microsoft Word functions such as Find, Replace, Copy, Cut, Paste, Undo, Redo, and Clear in the context of
DiffDog. This allows you to use Microsoft Word's formatting and editing features together with DiffDog's powerful
comparison engine. Please note that whenever the focus is on a Microsoft Word document and you  press a
keyboard shortcut in DiffDog, this will call the corresponding Microsoft Word function (e.g., if in a Word
Comparison window you press F5 to start a comparison, this will open Microsoft Word's Find and Replace
dialog box instead).

When you compare MS Word (*.doc or *.docx) documents, two instances of MS Word are opened side by side
in DiffDog. 

Microsoft Word 2003 or later must be installed on your computer and for both programs (i.e., DiffDog and
Microsoft Word) either the 32-bit version or the 64-bit version must be installed, that is, DiffDog x64
requires Microsoft Word x64, while DiffDog x32 requires Microsoft Word x32.

To start a Microsoft Word comparison in DiffDog, you must first open an empty Word Comparison window and
then select the Microsoft Word documents to be compared  or simply drag them from Windows Explorer into
the Word Comparison window. Alternatively, you can also select two documents in Windows Explorer ,

93

93



© 2016-2022 Altova GmbH

 91MS Word Comparison

Altova DiffDog 2023 Enterprise Edition

right-click and select  Compare with Altova DiffDog from the context menu . This will open a new instance of
DiffDog and display the selected Microsoft Word documents in a Comparison Window.

The comparison will start automatically unless you have deactivated the Autostart Comparison option in the
Diff and Merge menu. To eliminate differences, DiffDog allows you to edit the content  of the Microsoft
Word  documents directly in the comparison window and copy content from one pane to the other .

Microsoft Word documents that have been saved in the *.docx format can also be considered and compared as
ZIP-conformant files and Office Open XML (OOXML) files  in DiffDog. Note that, in this case, the comparison
has to be started as a directory comparison  and that you have to define *.docx files as ZIP-conformant in
the File Types  tab of the DiffDog Options dialog box.
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4.1 Opening a Word Comparison Window

When opening a new Word Comparison window, the Microsoft Word document comparison is given a name of
the form MS Word compare X, where X is an integer indicating that Microsoft Word document comparison's
position in the sequence of Microsoft Word document comparisons opened in the current DiffDog session. This
name appears in a tab at the bottom of the window.

Note that the Compare Microsoft Word Files command opens the Microsoft Word Comparison window with
two new and empty Word documents; it does not open any particular Microsoft Word  document within the
window. The two documents to be compared must be opened  subsequently in the panes of the comparison
window, one in each pane.

To open an empty Word Comparison window:

· Select the menu option File | Compare Microsoft Word Files or click the Compare Microsoft Word

files  button in the Standard toolbar.
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4.2 Selecting Microsoft Word Documents for Comparison

Microsoft Word documents can be selected for comparison in various ways. You can open  a new Word
Comparison window and select documents, re-open a previous comparison , or change the documents in the
currently open Word Comparison window. In addition, you can select a pair of documents in Windows Explorer
and use a context menu option to start a comparison in DiffDog.

Dragging documents into a DiffDog Word Comparison window
If you drag and drop files from the Windows Explorer into the respective panes of a Word Comparison window,
the documents will be opened for comparison. However, you can deactivate the Open/Insert document on
drop button so as to insert the document as text box in the Word document that is currently open in the Word
Comparison window (this is the default behavior for drag and drop in Microsoft Word). Note that the content of
text boxes cannot be compared in DiffDog. Therefore, the Open/Insert document on drop button is by default
activated in DiffDog.

To select Microsoft Word documents in the active Word Comparison window:

1. In the left pane of an existing Word Comparison window, do one of the following:

· Click the Open  icon and select a file in the Windows Open dialog box.

· Enter the full path to a file and click the Apply  button.
· Drag a file from the Windows Explorer into the pane.
· Select a previously compared file from the drop-down list.

2. Repeat any of the steps described in step 1 for the right pane.

To start a Microsoft Word document comparison from Windows Explorer:

1. Select two Microsoft Word documents in Windows Explorer.
2. Right-click and choose Compare with Altova DiffDog from the context menu. A new instance to

DiffDog is opened, the selected files are displayed in a Word Comparison window, and the comparison
is started automatically.
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4.3 Modifying the Microsoft Word Comparison Options

The Word tab of the Comparison Options dialog box displays the options that are used for the comparison of 
Microsoft Word documents.

Mode
DiffDog can compare the documents either on sentence level or at paragraph level.

View results
By activating the Show differences within lines check box, you can display the differences on character level.

If the check box is deactivated, differences are displayed only on sentence/paragraph level, that is, character
level differences are not highlighted. Only the sentence/paragraph, as a whole, is indicated as being different.
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Whitespace
See Comparison Options for Whitespace Characters .

Case sensitivity
Activate the Ignore case check box if upper and lower casing should be ignored when checking for
differences.

Lines
Here you define whether blank lines should be ignored.

Format
You can specify which type of formatting should be considered when comparing documents. If differences in
formatting are found, the entire sentence that contains the difference is marked as not equal.

49
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4.4 Running a Microsoft Word Document Comparison

When the two documents to be compared are loaded into the comparison window, a comparison is
automatically carried out  if the Autostart Comparison command is toggled on (which is the default
setting). In addition, comparisons can be explicitly started  any number of times with the Start Comparison
command.

When editing documents, they are compared dynamically as you type  if the Compare while Editing
command is toggled on.

You can run file comparisons using all three of the methods listed above; these methods are not mutually
exclusive. If the Show Options Before Comparison  command is toggled on, then the Comparison Options
dialog box is displayed each time before the comparison is run (except when it is run dynamically by DiffDog
while you edit). This is useful if you wish to run comparisons with different options.
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4.5 Configuring the Word Comparison Window

The Word Comparison window provides a toolbar which enables you to configure the view of the documents that
are displayed in the comparison window, and refresh the screen after comparisons.

Configuring the view
Since DiffDog runs Microsoft Word inside the Word Comparison window, some Microsoft Word functions are
available in DiffDog and you can use the buttons of the toolbar to switch them on or off.

·  Show/Hide Revisions and Comments: Revision marks and comments that have been added to
a Microsoft Word document are hidden by default when the document is displayed in DiffDog. Activate
the Show/Hide Revisions and Comments toggle to view them in the Word Comparison window. Please
note that this setting also influences the result of a comparison: hidden revisions and comments will
not be considered during a comparison.

·  Show/Hide formatting symbols: Shows or hides non-printing formatting characters such as
blanks, paragraph marks, tabs, etc.

Zooming

·  Zoom to Fit Page: Sizes both documents so that an entire page is displayed in each pane of the
Word Comparison window.

·  Zoom 100%: Zooms the documents in the panes to 100%. You will have to use the scrollbars to
navigate through the documents.

Refreshing the display

·  Refresh GUI: After you have edited a document in DiffDog, you can refresh the display by clicking
this button. Note that this does not reload the documents.
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4.6 Displaying Differences in Microsoft Word Documents

After you start a comparison, the differences between the two files are displayed as blocks of highlighted text
(which can be a sentence or a paragraph, depending on the setting in the Word Comparison Options ) and
the results of the comparison are reported in the Comparison Window Status Bar. Notice that the
corresponding differences in the two documents are linked for easier identification and analysis.

The current difference is highlighted in a different color than the other differences. In the screenshot above the
current difference is displayed in a darker green. These colors can be changed in the DiffDog Options . It is
important to know which difference is the current difference because merging  is always done for the current
difference only. You can navigate  among the differences with the navigation commands that are available in
the Diff and Merge menu and as toolbar icons.

Zooming into the documents
Since each pane of the Word Comparison window hosts an instance of Microsoft Word, you might want to
change the zoom of the documents. The Word Comparison toolbar provides two options for this: Zoom 100%
to view the details of the document and edit them, and Zoom to Fit Page to display the entire page for a better
overview. You can also change the zoom of an individual pane by clicking into it and changing the zoom with
the mouse wheel while holding the Ctrl key pressed.
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4.7 Editing Microsoft Word Documents in DiffDog

After you have run a comparison  and investigated the differences  of the two files, you can edit the
content of the files directly in DiffDog. You can use all the features of Microsoft Word that are available via the
context menu or keyboard shortcuts.

Finding and replacing text
In Word Comparison windows, DiffDog does not use its own Find and Replace functionality but gives you
access to Microsoft Word's Find and Replace dialog box instead.

To call Microsoft Word's Find and Replace dialog box:

· Place the cursor into the pane in which you want to search for text and press Ctrl+F,or click the Find

 button in the Standard toolbar.

For details on Microsoft Word's find and replace functionality please consult the relevant Microsoft Word help
pages.

Reloading documents
You can always undo all changes you have made to a document since you last saved it, and reload the file into
DiffDog. A warning message will be displayed if you are about to lose changes.

To reload a file into DiffDog:

1. In the respective pane of a comparison window, click the Reload  button.
2. If the file has changed since you last saved it, a warning message is displayed.

3. Click Yes if you want to reload, or No if you want to cancel the operation.
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4.8 Saving Microsoft Word Documents

To save a document you have edited in DiffDog, use the Save  or Save As  buttons in the respective
panes of the comparison window. Files can also be saved using the Close , Close All , and Save
commands in the File menu.

To save a file:

Do one of the following:

· To save an individual file, click the Save  button in its pane of the comparison window.

· To save an individual file under a new name or path, click the Save As  button in its pane of the
comparison window. The Windows Save As dialog box appears where you can specify the new name
or path for the file.

· To save both files of a comparison, select the menu option File | Save. The Save files dialog box
appears where you can select the files to be saved or choose to discharge the changes.

To save and close the files of a comparison:

1. Click the tab of the comparison window that contains the files you want to save and close.
2. Select the menu option File | Close.
3. If a file contains unsaved changes, the Save files dialog box appears. Make sure that the file's check

box is selected and click Save selected. The file is saved and the comparison window is closed.

To save and close the files of all comparisons:

1. Select the menu option File | Close all.
2. For every comparison window that contains a file with unsaved changes, the Save files dialog box

appears. Make sure that the  file's check box is selected and click Save selected. The file is saved
and the comparison window is closed.
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5 XML Schema Comparison

Altova website:  Compare XML

The comparing XML Schemas mechanism works as follows:

1. You load the two XML Schemas to compare. If an XML Schema has more than one global element,
DiffDog prompts you to select one of these as the root element. The other global components (global
elements and global types) will be loaded in the schema box and listed below the Root Element.

DiffDog displays in the schema box any of the following items, if they are declared in the schema.

Icon Description

An element declaration.

A reference to an element declaration.

An attribute declaration.

A named complex type.

2. DiffDog will automatically map elements in one schema to elements in the other. The mappings are
indicated with lines joining pairs of mapped elements (see screenshot above). Comparing XML
Schemas results in this mapping. You can  modify mappings  if you like. If you run a schema
comparison , however, the automatic mapping is returned.

3. After the mappings have been made, by running the XML Schema comparison (and modifying the
mapping if required), you can generate an XSLT stylesheet  or a MapForce mapping .

Note: Although you can right-click two XML Schemas in Windows Explorer and select Compare with
Altova DiffDog from the context menu, the selected XML Schemas will be compared as files in this
case.
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XML Schema comparisons can be saved  to an *.xsdif file. These files can later be reopened in DiffDog using
the menu command File | Open Comparison File....
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5.1 Opening an XML Schema Comparison Window

When opening a new XML Schema Comparison window, the XML Schema comparison is given a name of the
form XMLSchemaComparisonX, where X is an integer indicating that XML Schema comparison's position in the
sequence of XML Schema comparisons opened in the current DiffDog session. This name appears in a tab at
the bottom of the window.

Note that the Compare XML Schemas command opens only the XML Schema Comparison window; it does
not open any XML Schema within the window. The two XML Schemas to be compared must be opened
subsequently in the components of the comparison window, one in each component.

To open an empty XML Schema Comparison window:

· Select the menu option File | Compare XML Schemas or click the Compare XML Schemas 
button in the Standard toolbar.
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5.2 Selecting XML Schemas for Comparison

XML Schemas can be selected for comparison in various ways. You can open the XML Schemas in a new XML
Schema Comparison window, open an XML Schema comparison document (*.xsdif) from the file system, or
change the XML Schemas in the currently open XML Schema Comparison window. XML Schemas that have
already been compared before are available in a drop-down list in the title bar of each component. Note that you
can select only one schema per component.

To select XML Schemas in the active XML Schema Comparison window:

1. In the left component of an existing XML Schema Comparison window, do one of the following:

· Click the Browse  icon and select a file in the Windows Open dialog box.
· Double-click the title bar, enter the path to a file and press Enter.
· Click the  button and select a previously compared XML Schema from the drop-down list.

2. Repeat step 1 for the right component.

To open an XML Schema comparison document:

· Select the menu option File | Open Comparison File... and choose an *.xsdif file from the file
system. The comparison is opened in a new XML Schema Comparison window with the name of the
comparison document appearing in the comparison window tab.
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5.3 Setting the Active Root Element

A structural comparison of XML Schemas in DiffDog is done between two top-level global elements, called Root
Elements. If a schema has more than one global element, then you are prompted, in the Select Root Element
dialog (screenshot below), to select one of the global elements as the root element.

The selected global element is shown in the schema boxes (see screenshot below) as the respective Root
Element, and the other global elements are listed under the Global Elements item. The active root element is
mapped automatically and cannot be unmapped.
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When an XML Schema has already been loaded into a comparison component, you have several options for
changing the active root element:

· Manually map two unmapped elements and set one of them as active root element; the mapped
element in the opposite component can also be set as active root element, or you can leave the
opposite root element unchanged.

· Activate an unmapped root element in one component; this element will be automatically mapped to
the active root element on the other side of the comparison.

If a warning dialog box is displayed, you can always abort the operation by clicking the No button in the dialog
box. The root element is displayed in a separate section on top of the comparison component.

To set the active root element:

Do one of the following:

· When opening an XML Schema Comparison window and selecting the XML Schemas for comparison,
choose the active root element in the Select Root Element dialog box that pops up after you have
selected an XML Schema containing more than one global element.

· Right-click a mapped global element in one of the components and select Set as active root element
from the context menu. A dialog box appears where you can decide whether or not the corresponding
element on the opposite side should also be set as the active root element.
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If you click No, the selected element will be mapped to the current root element of the opposite
component.

· Right-click an unmapped global element in one of the components and select Set as active root
element from the context menu. The element is moved to the Root Element section and mapped to
the respective root element in the opposite component.
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5.4 Modifying the XML Schema Comparison Options

The XML Schema Comparison options can be changed in the XML Schema Comparison Options dialog box,

which is called by clicking the Comparison Options  icon in the Diff and Merge toolbar of an XML Schema
Comparison window or via the Tools menu when the active comparison window is an XML Schema Comparison
window.

You can also define whether or not DiffDog should start an automatic mapping  when XML Schemas are
loaded.

You define how DiffDog should transfer the changes in mapping of a global item to its children. Two options are
available:

· Transfer global item mapping changes to children

This option transfers the mapping of global items if these items appear as children of other items but
does not map the respective parent. In the screenshot below, the mapping of global item "Person" is
transferred only when it appears as child of global item "Department", whereas the mapping of parent
"Department" is not transferred.
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· Map to according parent and transfer global item mapping changes to children

This option transfers the mapping of global items even if they do not appear as children. In the
screenshot below, the mapping of both child "Person" and its parent "Department" is transferred.
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To modify the XML Schema comparison options:

1. Do one of the following:

· Select the menu option Tools | Comparison Options....

· Click the Comparison Options  icon in the Diff and Merge toolbar.

2. Change the settings in the XML Schema Comparison Options dialog box as required



© 2016-2022 Altova GmbH

Mapping Elements 111XML Schema Comparison

Altova DiffDog 2023 Enterprise Edition

5.5 Mapping Elements

When you select  two XML Schemas for comparison, their respective root elements will automatically be
mapped when the XML Schemas are loaded into the comparison components of the XML Schema Comparison
window. You will have to select the active root element  if an XML Schema contains more than one element
on root level.

The remaining elements as well as any child elements of the (active) root element will be mapped automatically
by DiffDog when you start  the comparison. If you are not satisfied with the proposed mappings, you can
manually change a mapping and re-run the comparison. Note that the mapping of the root element cannot be
changed! If the mapping of the root elements is incorrect, you have to replace  one (or both) of the root
elements to change the mapping.

If elements are referencing other elements, this is indicated with an icon. When such a referenced element is
mapped, DiffDog also maps all references to this element in the same way. These references are indicated with
an icon next to the element name (at the location where the reference occurs), and the mapping itself is
displayed with gray lines (see screenshot below).

You can still change these automatic mapping by drawing a new mapping connection; such manual mappings
will then be displayed with blue connector lines. A context menu option is also available allowing you to re-
apply the mapping of the global item to a referenced item.

To change or delete a mapping:

· To delete a mapping, right-click the element in either component or the line that connects two
elements, respectively, and choose Unmap selected from the context menu or hit the Del key.
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· To change an existing mapping, click the triangle next to the element name in one component and,
keeping the mouse button pressed, draw a line to the corresponding triangle in the opposite
component. Release the mouse button when the mouse cursor changes its shape.

To unmap all elements:

· Right-click into the title bar of either component and choose Unmap items from the context menu.
Note that the active root element cannot be unmapped.
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5.6 Saving XML Schema Comparison Files

After you have selected  XML Schemas for comparison and defined the appropriate comparison options ,
you can save the comparison to an XML Schema comparison file. This is either done via the File | Save As...
command or by right-clicking the tab of an XML Schema Comparison window and choosing Save from the
context menu. If you do a particular comparison on a regular basis, the use of an XML Schema comparison file
which can be opened directly may save you a considerable amount of working time.
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5.7 Running a Schema Comparison

After you have selected a root element , you can start a comparison. All global elements as well as their
child elements will be mapped automatically.

Note: When comparing XML Schemas, DiffDog tries to find matching pairs of elements on both sides of the
comparison rather than detecting or indicating differences between the two files. So, XML Schema comparison
is about finding and indicating the parts that are equal in two XML Schemas. This approach is different from
comparing files, directories, database schemas, or database data!

To start a comparison:

Do one of the following:

· Select the menu option Diff and Merge | Start XML Schema mapping or press F5.
· Right-click the title bar or any element of either component and choose Start XML Schema mapping

from the context menu.
· Right-click anywhere into the XML Schema Comparison window and choose Start XML Schema

mapping from the context menu.
· Right-click the tab of the XML Schema Comparison window and choose Start Comparison from the

context menu.
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5.8 Merging Differences in XML Schemas

If differences occur in compared XML Schemas, DiffDog does not merge the differences in the two compared
XML Schemas but provides XSLT Stylesheets  or MapForce Mappings  so that you are able to update the
XML files that have been generated with the compared XML Schemas. The respective commands are available
as menu options in the Diff and Merge menu, as context menu commands, or they can be called by clicking

the  and  toolbar options in the Diff and Merge toolbar.

If you click the Generate Result Left to Right  or the Generate Result Right to Left  button in the
Diff and Merge toolbar, a dialog box is displayed, where you can choose which result is to be generated.

Choose the required option and click OK.

116 117



116 XML Schema Comparison Generating an XSLT Stylesheet

© 2016-2022 Altova GmbHAltova DiffDog 2023 Enterprise Edition

5.9 Generating an XSLT Stylesheet

After you have compared  two XML Schemas in DiffDog, you can generate an XSLT stylesheet which can
later be executed on existing XML files so as to reflect the changes in the XML Schema in the XML files that
have previously been generated using this schema.

You can either save the XSLT or open it in XMLSpy® if you have XMLSpy installed on your computer. The
relevant commands are included in the context menu.

To generate an XSLT Stylesheet:

Do one of the following:

· Right-click the title bar of either component or anywhere into the XML Schema Comparison window and
select Generate XSLT Left to Right... or press Alt+Right. Alternatively, click the Generate Result

Left to Right  button in the Diff and Merge toolbar and select the Generate XSLT and save to file
radio button in the Generate result Left to Right dialog box.

· Right-click the title bar of either component or anywhere into the XML Schema Comparison window and
select Generate XSLT Right to Left... or press Alt+Left. Alternatively, click the Generate Result

Right to Left  button in the Diff and Merge toolbar and select the Generate XSLT and save to file
radio button in the Generate result Right to Left dialog box.

To display an XSLT Stylesheet in XMLSpy:

Do one of the following:

· Right-click the title bar of either component or anywhere into the XML Schema Comparison window and
select Open XSLT Left to Right in XMLSpy. Alternatively, click the Generate Result Left to Right

 button in the Diff and Merge toolbar and select the Open XSLT in XMLSpy radio button in the
Generate result Left to Right dialog box.

· Right-click the title bar of either component or anywhere into the XML Schema Comparison window and
select Open XSLT Right to Left in XMLSpy. Alternatively, click the Generate Result Right to Left

 button in the Diff and Merge toolbar and select the Open XSLT in XMLSpy radio button in the
Generate result Right to Left dialog box.
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5.10 Generating a MapForce Mapping

If you have MapForce® installed on your computer, you can create a MapForce Mapping for the compared root
element from within DiffDog and display it in a new instance of MapForce. Depending on whether you choose
the Left to Right or the Right to Left command, you can determine which file is used as source or target,
respectively.

If you choose the Generate MapForce mapping Left to Right command in the XML Schema Comparison
above, you will get the following mapping in MapForce:
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To generate a MapForce mapping:

1. Define the root element  for which you want to generate the MapForce mapping.
2. Run  an XML Schema comparison.
3. Right-click the title bar of either component or anywhere into the XML Schema Comparison window and

select Generate MapForce mapping Left to Right  or Generate MapForce mapping Right to
Left. The mapping opens in a new MapForce instance. Alternatively, click the Generate Result Left

to Right  or Generate Result Right to Left  button in the Diff and Merge toolbar and select the
Generate MapForce Mapping radio button in the Generate result dialog box.
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6 CSV and Database Data Comparison

You can compare data from CSV files or databases side-by-side. You can also perform mixed comparisons; for
example, you can compare data from a CSV file with data from a database table. When comparing two
databases, the objects to be compared can either belong to the same database, or reside in two different
databases. 

A database or CSV comparison is similar to file comparisons; that is, it involves a "left" component and a
"right" one. A "component" is just a representation of the database structure from where you can conveniently
select the tables or columns that are to be compared.

Database data comparison

In case of CSV files, the component includes only one table that represents the CSV file content. Each column
corresponds to a CSV field. The column names correspond to header fields if the source CSV has a header
row, and if you selected the First row is header row option when connecting to the CSV data source. If the
CSV has no header row, columns are named automatically, for example, "c1", "c2", and so on.

After comparing data, you can optionally merge differences either from left to right, or from right to left. It is
possible to merge all differences as one batch, or you can display the differences for each table in a data grid,
and then review and merge each difference individually at row level. For more information, see Viewing
Differences Between Tables  and Merging CSV and Database Differences .

If you perform the same data comparison frequently, you can save it to a database data comparison (.dbdif) file,
see Saving Comparison Files .

135 138

134



120 CSV and Database Data Comparison  

© 2016-2022 Altova GmbHAltova DiffDog 2023 Enterprise Edition

Prerequisites
· An active connection to a data source must exist in your project for each database table or file that is

to be compared side-by-side. This data populates the "left" and "right" components, respectively. For
more information, see Connecting to a Data Source . For CSV files, see Adding CSV Files as Data
Source .

· If you are comparing tables, each table must have a primary key column. DiffDog requires the primary
key column to sort the table rows before performing the actual comparison.

Limitations
· When comparing CSV files, the first column of each row is always considered the primary key

column. 
· If the primary key column is non-numeric, and if a change occurs in the key column, the entire row is

treated as a new row. This applies both to CSV files and to database comparisons. Consider the
following example:

The comparison result illustrated above was obtained by comparing two CSV files. As mentioned
before, the first column in CSV files is always the primary key. For this reason, even though value
"Bob" has been renamed to "Bobby", this change is reported as a new row (rather than a difference in
that particular column). On the other hand, the difference between "Birdsong" to "Beardsong" is
displayed as a difference in the same row, because that column is not a primary key.
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6.1 Running a Database Data Comparison

A database data comparison in DiffDog consists of the following steps.

Step 1: Connect to the "left" and "right" databases

1. On the File menu, click Compare Database Data. (Alternatively, click the Data Comparison 
toolbar button.) Follow the database wizard steps to connect to the database (see Connecting to a
Database ).

2. When prompted to select database objects for comparison, first choose a data source from the Data
Source list, and then select the check boxes next to the objects you want to include for comparison.
The Data Source list displays any active data sources that you've connected since starting DiffDog.

Note: From the dialog box above, you can optionally group, filter, or navigate database objects using the
buttons above the database tree structure. For more information, see Navigating Database Objects .

3. Click either Left Side or Right Side to add the data source to the left or right side of the comparison,
respectively, and then click OK. Be patient while DiffDog adds the selected objects to the comparison;
this may take a while for large databases. At this stage, only one of the comparison components has
an assigned data source (right or left, depending on what you selected).
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4. Click the Browse  button of the empty component, and choose the second data source from the

Data Source list, if one is available. Otherwise, click Quick Connect  and follow the wizard steps
to connect to the second data source.

5. Select the check boxes next to the tables you want to compare.

If the databases to be compared are SQLite or Access, you can also perform this step from Windows Explorer,
see Quick Comparison of SQLite and Access Databases .

Step 2: Map the objects to be compared (if applicable)
To perform a comparison, the objects on the left and right side of the comparison must be connected by a line
(a "mapping"). The mapping instructs DiffDog to compare these two objects specifically. By default, DiffDog will
attempt to match automatically the objects to be compared by their name, and thus create the corresponding
mappings. The mapping options can be adjusted from Tools | DiffDog Options | Database Comparison.
When necessary, you can create mappings manually, or adjust the existing ones. For example, you may need
to create a mapping manually between two objects if the object names are different in the "left" as opposed to
the "right" database. 

To create a mapping, click the triangle on the left component and, holding the left mouse button pressed, drag
it to a target triangle on the right component. To delete all mappings of a comparison, right-click the title bar of
either component and choose Unmap items from the context menu. To delete a single mapping, right-click the
appropriate object and choose Unmap selected from the context menu. Alternatively, click the connection line
between two mapped objects and press Delete.

Note: Unmapping a table will also unmap all columns of that table.
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Mappings in a data comparison

Step 3: Run the comparison
Once the mappings between objects are created, you can run the comparison as follows:

· On the Diff and Merge menu, click Start Comparison. (Alternatively, click the Start Comparison

 toolbar button, or press F5.)

At this stage, you can either explore the comparison results in more detail (see Viewing Differences Between
Tables  ), or generate the merge script (Merging CSV and Database Differences ).

Sorting, collapsing, and expanding tables
To simplify navigation through huge schemas which contain a lot of objects, you can collapse and expand
individual tables when you are examining the differences. If you double-click a table in the left component, the
same table is also collapsed or expanded in the right component, respectively (provided that a mapping exists
between the two tables). To collapse all tables in both components, do one of the following:

· On the Diff and Merge menu, click Collapse items.
· Right-click the title bar of a component, and select Collapse tables from the context menu.

You can also sort tables in ascending or descending order, as follows:

· Right-click the empty area and select Sort tables | Ascending or Sort Tables | Descending from the
context menu. The options Ascending mapped first and Descending mapped first will give priority
to tables that have mappings over those that don't.
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Adding or removing tables from a comparison

To add more tables to the comparison, or remove existing one from the comparison, click the Browse 
button in the upper-right corner of the database component and then select or clear the required check boxes. 

6.1.1 Navigating Database Objects

When selecting tables or columns for comparison, you can customize the way the database objects are
displayed in the "Select Database Objects for Comparison" dialog box. You can also apply miscellaneous
filters to quickly find specific database objects.

The dialog box illustrated above includes the following buttons in its toolbar:

· Layout 

· Filter folder contents 

· Show checked objects only 

· Object locator 
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Layout

The Layout  button controls how various database objects are displayed in the Select Database
Objects for Comparison dialog box. Note that this button changes the appearance based on the layout that is
currently selected. You can select from among the following predefined layouts:

Folders Organizes database objects into folders based on object type in a
hierarchical tree (for example, "Schemas", "Tables", and others).
This is the default setting in DiffDog.

No Schemas This layout is similar to the Folders layout, except that there are
no schema folders; tables are therefore not categorized by
schema.

Table Dependencies Categorizes tables according to their relationships with other
tables. The categories include tables with foreign keys, tables
referenced by foreign keys, tables without relations, and tables with
self-referencing foreign keys.

For some databases such as SQL Server, you can optionally display user tables and system tables into
separate folders, as follows:

· Right-click the "Tables" folder and select Sort into User and System Tables from the context menu.

Note that this function is available only when using the following layouts: 

· Folders 

· No Schemas 

Filter folder contents

Use the Filter  tool to filter database objects by name or part of a name. Objects are filtered as you type in
the name. 

To filter objects:

1. Click the Filter folder contents  button. Alternatively, select a database object and press
Ctrl+Alt+F to activate filtering. Notice that filter icons appear next to folders.
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2. Click the filter icon next to the folder you want to filter and select the desired filtering option, for
example, "Contains".

3. Start typing the filter text next to the  icon. The results are adjusted as you type.

Show checked objects only

Click Show checked objects only   to display only selected items. When you do this, all unselected
items are hidden and only the items that have been selected for comparison are displayed.

Object locator

The Object Locator  tool lets you find and filter database objects by any part of their name. 
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To find database objects using the Object Locator:

1. Click the Object Locator  button or press Ctrl+L. A combo box appears at the base of the dialog
box.

2. Optionally, change the Object Locator context by clicking the arrow icon  next to the combo box.
You can restrict the display of objects as follows:

From current Data
Source

Displays only objects from the currently selected data source.

From Focused Item Displays only objects nested under the folder or object that is currently
selected.

All Displays all objects from all data sources that are currently connected.

3. Optionally, enter the string you want to look for (for example, "feed"). The drop-down list displays all
elements that contain that string.
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6.2 Quick Comparison of SQLite and Access Databases

When SQLite or Access databases are involved in the comparison, you can easily start the comparison
directly from Windows Explorer. Starting database comparisons from Windows Explorer is applicable only to
SQLite and Access databases, since they are file-based. This is an easier alternative to starting the
comparison from DiffDog, as described in Running a Database Data Comparison  and Running a Database
Schema Comparison .

For example, when the two database files to be compared are SQLite or Access, you can quickly start the
comparison as follows:

· Having selected the two database files in Windows Explorer, right-click any of them, and then select
Compare with DiffDog from the context menu.

This action opens a database schema comparison and populates both sides of the comparison, for example:

Note that the left side may be a SQLite file and the right side may be an Access file, or vice versa.

You can also start a database comparison by selecting just one database file, for example:

· Right-click the SQLite or Access database file in Windows Explorer, and then select Compare with
DiffDog from the context menu. 

If DiffDog is not running already, this action opens a database schema comparison, and populates the left side
of the comparison with the selected database file. If DiffDog is already running, then the outcome is one of the
following:
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· If a data comparison window is open, in focus, and one of the sides already contains a database, then
DiffDog shows a dialog box similar to the one below:

Click Yes to add the new file to the current data comparison, or otherwise No to open a new
comparison window.

· If a schema comparison window is open, in focus, and one of the sides already contains a database,
then DiffDog shows a dialog box asking you to add the new database to the current schema
comparison.

· If no data or schema comparison is active, or if both sides already contain databases, DiffDog opens a
new database schema comparison.

To turn a schema comparison into a data comparison, right-click an empty area in the comparison window and
then select the Open in new Data Comparison from the context menu. A similar menu command is available
in a schema comparison window, for turning a data comparison into a schema comparison.
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6.3 Comparing CSV Files

CSV file comparisons are very similar to database data comparisons. CSV files are treated just as any other
data source, and you can connect to them using the same connection wizard used with databases. This
example describes how to compare two CSV files; however, you can also add a database on either side of the
comparison. 

Step 1: Add the "left" and "right" data source

1. On the File menu, click Compare Database Data. Alternatively, click the Data Comparison 
toolbar button. Follow the wizard steps and browse for the CSV file. Make sure to select the correct
separator (comma, semicolon, or tab) and to indicate whether the first row of the CSV file is a header
row. For more information, see Adding CSV Files as Data Source . 

2. When prompted to give a name to the data source, type a descriptive name to easily identify this CSV
file, and click OK. 

3. Select the check box next to the CSV table ("data", in this example), and then click either Left Side
or Right Side to designate this CSV as the left or the right side of the comparison. 

4. So far, you have added only the first data source. To add the second one, click the Browse  button
of the empty component, and choose the second data source from the Data Source list, if one is
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available. Otherwise, click Quick Connect  and follow the wizard steps to connect to the second
data source.

At this stage, you should have at least one object displayed on each side of the comparison, for example:

In CSV files, the column names shown in the components above are the ones that appear on the first row of the
CSV file. This assumes that you have selected the Treat first row as header option while adding the CSV
data source. Otherwise, columns are displayed as c1, c2, c3, and so on, according to their ordinal number,
starting with 1.

Step 2: Map column pairs
You can now indicate the column pairs that are to be included in the comparison by drawing mapping
connections between them, for example:
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To create a mapping, click the triangle on the left component and, holding the left mouse button pressed, drag
it to a target triangle on the right component. To delete all mappings of a comparison, right-click the title bar of
either component and choose Unmap items from the context menu. To delete a single mapping, right-click the
appropriate object and choose Unmap selected from the context menu. Alternatively, click the connection line
between two mapped objects and press Delete.

Note: Unmapping a table will also unmap all columns of that table.

Step 3: Run the comparison
Now that the mappings are created, you can run the comparison as follows:

· On the Diff and Merge menu, click Start Comparison. (Alternatively, click the Start Comparison

 toolbar button, or press F5.)

At this stage, the  icon appears on the mapping line if the compared data is not equal. Move the mouse
cursor over this icon to view a quick summary, for example:
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For information about exploring the comparison results in more detail, see Viewing Differences Between
Tables .

Optionally, you can also merge data between two CSV files, or between a CSV file and a database, in either
direction, see Merging CSV and Database Differences .
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6.4 Saving Comparisons

After running a CSV or database data comparison, you can save it to a file. This will save you time in future,
whenever you want to compare the same data sources. Database data comparison (.dbdif) files store the
connection details of the databases or CSV files involved in comparison, as well as the database objects
selected for comparison. Passwords are stored in encrypted form inside comparisons files.

To save a data comparison to a file:

1. Run a comparison.
2. On the File menu, click Save As, and select "Altova Database Data Comparison (.dbdif)" as file type.

To open a data comparison file:

· On the File menu, click Open Comparison File, and browse for the .dbdif file.

With DiffDog Server, you can run database data comparisons (.dbdif files) on Linux, macOS or Windows
operating systems. For more information, see Automation with DiffDog Server .143
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6.5 Viewing Differences Between Tables

Every time after you run a data comparison  or a CSV comparison , the high-level results are displayed
directly in the Data Comparison window. Namely, the result of a comparison is indicated by the following icons:

The compared objects are equal in both components

Differences exist between the objects in the left and right components

Objects that are different are highlighted with green color. A balloon tip with additional information appears if
you move the mouse cursor over a comparison icon.

To view a more detailed comparison result, do one of the following:

· Click the comparison result icon  for a given table.
· Right-click a table where differences exist, and select Show selected results from the context menu.
· Right-click an empty area in the comparison window, and select Show results from the context menu.

This opens a grid where differences between each column are displayed side-by-side, called the "Comparison
Result View", as further described below.

Note: If a dialog box appears with the following text: "Data is equal, do you want to open content?", this
indicates that the command above was run for a selection of tables where there are no differences.
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Comparison Result View
This view displays differences between a given table pair. As illustrated below, each column is displayed twice
(as it stands in the "left" table as opposed to the "right" table). In the example below, the column quantity
was changed in two occurrences; also, a new row (id = 11) exists only in the "right" table.

Use the toolbar buttons to customize which rows should be displayed in this view, or to navigate differences.

Icon Command Description

Show/Hide all equal rows Shows or hides rows that are equal in the left and right
component.

Show/Hide all different rows Shows or hides rows that are different in the left and right
component.

Show/Hide rows that are only on
the left

Shows or hides rows that exist only in the table that is
contained in the left component.

Show/Hide rows that are only on
the right

Shows or hides rows that exist only in the table that is
contained in the right component.

Show/Hide rows that cannot be
merged from left to right

Shows or hides rows that are different in the left and right
component and can be merged only from the right to the left
side and not from the left to the right side.

Show/Hide rows that cannot be
merged from right to left

Shows or hides rows that are different in the left and right
component and can be merged only from the left to the right
side and not from the right to the left side.

Show/Hide columns which don't
have any differences

Shows or hides columns where no differences exist.
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Icon Command Description

Next difference (Alt+Down) Selects the next difference as the current difference. If this
command is disabled, click any difference on the grid first.

Previous difference (Alt+Up) Selects the previous difference as the current difference.

Last difference (Alt+End) Selects the last difference in the document as the current
difference.

First difference (Alt+Home) Selects the first difference in the document as the current
difference.

Copy from left to right Displays a dialog box where you can merge differences from
the left to the right database or CSV file, see also Merging
CSV and Database Differences .

If this command is disabled, click any difference on the grid
first.

Copy from right to left Displays a dialog box where you can merge differences from
the right to the left database or CSV file.

It is possible to customize the appearance of the Comparison Result View, see Database Data Comparison
Options .
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6.6 Merging CSV and Database Differences

After performing a CSV or database data comparison, you can optionally merge differences either from the left
to the right database or CSV file, or vice versa. Differences can be merged either in batch for the entire
database, or individually at table or even row level. 

By default, database transactions as well as rollback on error is enabled on data merging (assuming the
database supports this), see Database Data Comparison Options .

Notes: 

· When merging data to CSV files, transactions and rollback on error is not supported.
· It is not possible to merge columns that have an incompatible data type (for example, string to numeric

type). Also, sometimes a merge is possible only in one direction (for example, a numeric type may be
converted to a string type, but not the opposite).

Warning
In case of CSV comparisons, if the first column of the file is not unique, it is not recommended to do a
merge. When there is no row uniqueness, then multiple unrelated rows might be affected by DELETE and
UPDATE statements.

DiffDog will ignore incompatible merges and will notify you, before merging, if such occurrences exist. In the
Comparison Result view, merges that are only possible only in one direction are marked with a small red arrow
joined with a green arrow. The direction of the green arrow indicates the direction where the merge is possible.
For example, in the image below, the description column (of type "text") cannot be mapped to the quantity
column because the latter is numeric. However, the quantity column can be mapped to the description
column.

Comparison Result View
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Executing the merge
After performing a CSV or database data comparison, you can merge the changes in any of the following ways:

· To merge differences at CSV file or database level, right-click an empty area in the Comparison window
and select Merge all Left to Right.

· To merge differences at table level, right-click the table in the Comparison window and select Merge
Selected Left to Right. For CSV files, this option is equivalent to the previous one, because CSV files
contain only one table.

· To merge differences at row or cell level, first display the Comparison Result view, as described in
Viewing Differences Between Tables . Next, right-click a row (or the affected cells) in the

Comparison Result View, and then select  Copy from left to right from the context menu.
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6.7 Database Data Comparison Options

There are several groups of options which affect database data comparison, and they can be categorized as
follows:

Option group How to access

General database data comparison
options, including options for database
transactions, rollback, and memory
usage

1. Open a new database data comparison window (see
Running a Database Data Comparison ).

2. On the Tools menu, click Comparison Options.
3. Click the Database Data tab.

Note that a database comparison window must be in focus for the
Database Data tab to appear.

For more information, see General Options .

Options for comparing XML fields.
These are applicable only if native (not
string) comparison is enabled and the
database supports and contains XML
fields

1. On the Tools menu, click Comparison Options.
2. Click the XML tab.

For more information, see XML Comparison Options .

Options that control automatic
mapping of tables and columns, as
well as the appearance of tables in the
comparison window

1. On the Tools menu, click DiffDog Options.
2. Click the Database Comparison tab.

For more information, see Database Comparison .

Options for configuring the appearance
of the Comparison Result View

1. On the Tools menu, click DiffDog Options.
2. Click the Database Data Result View tab.

For more information, see Database Data Result View .

6.7.1 General Options

The general database data comparison options are listed below. You can access these options as follows:

1. Open a new database data comparison window (see Running a Database Data Comparison ).
2. On the Tools menu, click Comparison Options.
3. Click the Database Data tab.

Note that a database comparison window must be in focus for the Database Data tab to appear.
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Comparison Mode
You can choose from among two comparison modes: native type or as string. The native type considers the
data type of the column that is compared, whereas everything will be converted into strings before comparison if
you use the string representation type.

Comparison Options
Clear the Ignore case in comparison check box if upper and lower casing should not be ignored when
checking for differences. Select the Ignore whitespaces in comparison option if you do not want to consider
whitespaces when comparing database data. Whitespace characters are space, tab, carriage return, and line
feed. If you do not want to make a difference between an empty field and a field containing the NULL value,
select the Treat [NULL] as empty string check box.

Numeric Options
Floating point numbers can be filled up with trailing zeros by selecting the Append trailing zeros to floating
point numbers check box.
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Optimization Options
If you do not care to see rows that are equal in both tables of a comparison, select the Keep only different
rows in memory check box. In this case, only different rows are retrieved and displayed in the Result window.

Execution Options
You can define whether you want to process comparison of multiple tables sequentially or parallel. Changes
can be committed with or without the use of transactions and you can decide whether or not you want to
rollback on errors.
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6.8 Automation with DiffDog Server

DiffDog Server is a cross-platform differencing tool which supports, among other comparison kinds, the
comparison of CSV and database data. DiffDog Server provides a command line for automated execution of
comparisons. With DiffDog Server, you can either set up the comparisons jobs directly on the server, or,
alternatively, run .dbdif files created with DiffDog, as described in Saving Comparison Files .

To run a .dbdif comparison file with DiffDog Server, supply the file path as argument to the run command, for
example:

diffdogserver run path\to\comparison.dbdif

where diffdogserver is the path to the DiffDog Server executable on the Linux, macOS, or Windows
machine.

Running *.dbdif files with DiffDog Server is most convenient if DiffDog Server runs either on the same
computer as DiffDog desktop, or on a Windows machine. If DiffDog Server runs on a different machine or
operating system, the following limitations apply:

· If the comparison involves CSV files, running .dbdif files is supported only on Windows servers. For
the comparison to be successful, all the CSV file paths that were valid on the desktop machine
must be valid on the server machine. 

· If database connections are involved, the server machine must be configured and capable to
handle the database connection. Namely, the database drivers and any other prerequisites
required by the connection must be present on the target operating system as well. For example,
if the .dbdif file includes a connection that requires an ODBC driver from the database vendor, that
driver must be installed on the server machine as well. Note that some database connection
methods supported on Windows are not supported on Linux and macOS. For more information,
see the DiffDog Server documentation.

If you set up comparison jobs directly in DiffDog Server (as opposed to using *.dbdif files), you can run
them regardless of the platform.

DiffDog Server reports the comparison outcome by means of the exit code ("0" means equal data, "1" means
there are differences, and "2" indicates an error). The detailed comparison results are shown by default at the
command line, but you can also get them as a file in XML, text, or SQL format. The latter format is applicable if
the right side of the comparison is a database, and it consists of SQL statements that merge data from the left
to the right side.

For more information about DiffDog Server, see the Altova website.
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7 Database Schema Comparison

A database schema comparison enables you to compare objects of two different database schemas, in terms
of their structure or size. Database objects that can be compared include tables, columns, views, functions,
and stored procedures. Comparison works differently for tables, as opposed to views, functions, or stored
procedures. Namely, in case of tables, the comparison results report the structural differences (such as
different columns, constraints, data types, and so on). In case of views, functions, and stored procedures, the
comparison results inform you if the size of the object is the same or different in database A (left-side of
comparison) as compared to database B (right-side of comparison).

Note: Line-by-line text comparison of database object definitions is not supported. To compare two object
definitions (for example, database views) line-by-line, first save the definitions to files and then open
both files in the file comparison view.

To start a database schema comparison, click the Schema Comparison  toolbar button. Two database
components are displayed side by side (a "left" component and a "right" component). Before running the actual
comparison, you need to assign a data source to each of the left and right components. Then you can select
for comparison either all objects of a schema, or specific schema objects. To change the objects included in

comparison, click the Browse  button on the right or left component, and select or clear the required check
boxes. For more information, see Running a Database Schema Comparison .

Sample database schema comparison

The sample database schema comparison above illustrates the result of comparing a stored procedure, a table,
and a view between two SQL Server databases, "ZooDB" and "ZooDBTarget". The table definitions are equal in
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both the source and target schema (which is indicated by the  sign), while the stored procedure and view

definition is different (which is indicated by the  sign).

A database schema comparison can be saved as a file. Database schema comparison files have the .dbsdif
extension. A comparison file stores the connection details of the database(s) involved in comparison, the
database objects selected for comparison, as well as any configuration options you have defined in the
"Properties" window (see also Database Schema Comparison Files ).

Various database comparison options are configurable. For example, you can have DatabaseSpy automatically
match the tables or columns to be compared (by name, data type, or both), or perform the mapping manually.
The comparison options can be adjusted from Tools | DiffDog Options | Database Comparison.

After running a database schema comparison, you can generate a merge script to update either the left or the
right database. You can review and execute the merge script directly in DiffDog, open it with DatabaseSpy, or
save it to a file. It is also possible to select specific objects to be included in the merge script (for example, one
or several columns of a table). For more information, see Merging Database Schemas .

Note: The merge script synchronizes only differences resulting after comparing structure of tables (this
includes changes to columns, keys, or constraints). Merging differences between other object types
(such as stored procedures, functions, and views) is not supported.
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7.1 Running a Database Schema Comparison

A database schema comparison in DiffDog involves the steps shown below.

Step 1: Connect to the databases that are to be compared
1. On the File menu, click Compare Database Schemas. (Alternatively, click the Schema

Comparison  toolbar button.) At this stage, you may be prompted to add a new data source, if no
connected data source already exists. In this case, click Yes and follow the wizard steps to create a
new data source (see Connecting to a Database ).

2. When prompted to select database objects for comparison, first choose a data source from the Data
Source list, and then select the check boxes next to the objects you want to include for comparison.
The Data Source list displays any active data sources that you've connected since starting DiffDog.

Note: From the dialog box above, you can optionally group, filter, or navigate database objects using the
buttons above the database tree structure. For more information, see Navigating Database Objects .

3. Click either Left Side or Right Side to add the data source to the left or right side of the comparison,
respectively, and then click OK. Be patient while DiffDog adds the selected objects to the comparison.
At this stage, only one of the comparison components (right or left, depending on what you selected)
has an assigned data source.
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4. Click the Browse  button of the empty component, and choose the second data source from the

Data Source list, if one is available. Otherwise, click Quick Connect  , and follow the wizard steps
to connect to the second data source.

5. Select the check boxes next to the objects you want to compare, and then click Left Side (or Right
Side, depending on the case).

If the databases to be compared are SQLite or Access, you can also perform this step from Windows Explorer,
see Quick Comparison of SQLite and Access Databases .

Step 2: Map the objects to be compared (if applicable)
To perform a comparison, the objects on the left and right side of the comparison must be connected by a line
(a "mapping"). The mapping instructs DiffDog to compare these two objects specifically. By default, DiffDog will
attempt to match automatically the objects to be compared by their name, and thus create the corresponding
mappings. The mapping options can be adjusted from Tools | DiffDog Options | Database Comparison.
When necessary, you can create mappings manually, or adjust the existing ones. For example, you may need
to create a mapping manually between two objects if the object names are different in the "left" as opposed to
the "right" database. To create a mapping, click the triangle on the left component and, holding the left mouse
button pressed, drag it to a target triangle on the right component.

To delete all mappings of a comparison, right-click the title bar of either component and choose Unmap items
from the context menu. To delete a single mapping, right-click the appropriate object and choose Unmap
selected from the context menu. Alternatively, click the connection line between two mapped objects and
press Delete.

Note: Unmapping a table will also unmap all columns of that table.

Step 3: Run the comparison
Once the mappings between objects are created, you can run the comparison:

· On the Diff and Merge menu, click Start Comparison. (Alternatively, click the Start Comparison

 toolbar button, or press F5.)

The result of a comparison is indicated by the following icons:

The compared objects are equal in both components

Differences exist between the objects in the left and right components

A corresponding item is missing in the opposite component

Schema objects that are different are highlighted with green colour.

To simplify navigation through huge schemas which contain a lot of objects, you can collapse and expand
individual objects when you are examining the differences. If you double-click an item in one component, both
versions of the item are collapsed or expanded, respectively, simultaneously in both components. To collapse
all items in both components, do one of the following:

· On the Diff and Merge menu, click Collapse items.
· Right-click the title bar of a component, and select Collapse items from the context menu.
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7.2 Database Schema Comparison Files

After running a database schema comparison, you can save it to a file. This will save you time in future,
whenever you want to compare the same database schemas. Database schema comparison (.dbsdif) files
store the connection details of the databases involved in comparison, the database objects selected for
comparison, as well as any configuration options you have defined in the "Properties" window. (Note that
passwords stored in database schema comparison files are encrypted.)

To save a schema comparison to a file:

1. Run a comparison (see Running a Database Schema Comparison ).
2. On the File menu, click Save As, and select "Altova Database Schema Comparison (.dbsdif)" as file

type.

To open a schema comparison file:

· On the File menu, click Open Comparison File, and browse for the .dbsdif file.
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7.3 Merging Database Schemas

After running a schema comparison between two database schemas (the "left" and the "right" one), table
differences can be synchronized (merged) between the two databases. Since the merge operation affects the
structure of the database, it is not applied directly. Instead, DiffDog generates a merge script. The generated
merge script can apply changes either from the "left" database to "right", or the other way round, from "right" to
"left". 

Note: The merge script synchronizes only differences resulting after comparing structure of tables (this
includes changes to columns, keys, or constraints). Merging differences between other object types
(such as stored procedures, functions, and views) is not supported.

Once the merge script is generated, you can choose to execute the merge script directly in DiffDog, open it
with DatabaseSpy for execution, or save it to a file for later execution.

Before executing the merge script against the database, it is always recommended to review it. If the structural
differences between database schemas are numerous, the generated merge script will be equally big. To avoid
a potentially dangerous update of multiple items in the target database through a big script, you could generate
smaller scripts and apply them progressively. For example, you can select specific items (columns,
constraints) that should be included in the merge, and then generate the script only for selected objects.

To generate and execute a merge script:

1. Run a database schema comparison (see Running a Database Schema Comparison ).
2. Optionally, if you want to merge only specific items, select these items in a component using

Ctrl+Click. Note that it has no influence on the direction of the merge whether you select the items in
the left or in the right component (for example, you can select items in the right component and still
choose to merge from left to right).

Important: Child elements of a table or column are not automatically included in the merge if you
select just the parent. For this reason, when selecting a parent object (for example, a table), make
sure to select also any child items that should be merged (such as columns or constraints). For
example, it the column name is equal but the data type is different (as shown in the image below), you
must select the data type item to create a valid merge script.

3. Do one of the following:

· On the Diff and Merge menu, select Copy from Left to Right.

· Click the Copy from left to right  toolbar button.

The commands above assume you want to merge the database structure from left to right. Otherwise,
use the corresponding reverse (right to left) commands.
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The SQL merge script is displayed in the "Merge Schema" dialog box. If no items have been selected
before the merge was started (step 2 above), the Use all Items option is selected and the "global"
merge script is displayed in the comparison window. The Use selected Items option is active if one or
more items have been selected for merging. In this case, you can still decide to merge all items by
selecting the Use all Items option.

4. Review the merge script, and click Execute.

If the merge script should be incorrect, you can cancel the operation, save the SQL merge script to a file and
edit it with an external editor, or show and edit the SQL merge script in DatabaseSpy, if installed.

To execute the merge script in DatabaseSpy:

1. Right-click either a component header or one of the selected items, and select Show merge script:
Left to Right in DatabaseSpy from the context menu (or, depending on the case, Show merge
script: Right to Left in DatabaseSpy). This opens DatabaseSpy, creates a new project and adds a
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data source connection to the target database (that is, the database where the changes will occur). If a
project is already open in DatabaseSpy, a new data source connection is added to the project and you
may be asked to define a name for that data source. The merge script is displayed in an SQL Editor
window, where you can check the script and edit it if required.

2. Connect to the data source, click the Execute  button or press F5 to execute the change script
and commit the schema changes to the database.

To save the merge script to a file:

· Right-click either a component header or one of the selected items, and select Save merge script:
Left to Right... from the context menu (or, depending on the case, Save merge script: Right to
Left...). 
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8 Connecting to a Data Source

In the most simple case, a database can be a local file such as a Microsoft Access or SQLite database file. In
a more advanced scenario, a database may reside on a remote or network database server which does not
necessarily use the same operating system as the application that connects to it and consumes data. For
example, while DiffDog runs on a Windows operating system, the database from which you want to access
data (for example, MySQL) might run on a Linux machine.

To interact with various database types, both remote and local, DiffDog relies on the data connection interfaces
and database drivers that are already available on your operating system or released periodically by the major
database vendors. In the constantly evolving landscape of database technologies, this approach caters for
better cross-platform flexibility and interoperability. 

The following diagram illustrates, in a simplified way, data connectivity options available between DiffDog
(illustrated as a generic client application) and a data store (which may be a database server or database file).

* Direct native connections are supported for SQLite, PostgreSQL, CouchDB and MongoDB databases. To
connect to such databases, no additional drivers are required to be installed on your system.

As shown in the diagram above, DiffDog can access any of the major database types through the following data
access technologies:

· ADO (Microsoft® ActiveX® Data Objects), which, in its turn, uses an underlying OLE DB (Object
Linking and Embedding, Database) provider

· ADO.NET (A set of libraries available in the Microsoft .NET Framework that enable interaction with
data)
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· JDBC (Java Database Connectivity)
· ODBC (Open Database Connectivity)

Note: Some ADO.NET providers are not supported or have limited support. See ADO.NET Support Notes .

About data access technologies
The data connection interface you should choose largely depends on your existing software infrastructure. You
will typically choose the data access technology and the database driver which integrates tighter with the
database system to which you want to connect. For example, to connect to a Microsoft Access 2013
database, you would build an ADO connection string that uses a native provider such as the Microsoft Office
Access Database Engine OLE DB Provider. To connect to Oracle, on the other hand, you may want to
download and install the latest JDBC, ODBC, or ADO.NET interfaces from the Oracle website.

While drivers for Windows products (such as Microsoft Access or SQL Server) may already be available on
your Windows operating system, they may not be available for other database types. Major database vendors
routinely release publicly available database client software and drivers which provide cross-platform access to
the respective database through any combination of ADO, ADO.NET, ODBC, or JDBC. In addition to this,
several third party drivers may be available for any of the above technologies. In most cases, there is more than
one way to connect to the required database from your operating system, and, consequently, from DiffDog. The
available features, performance parameters, and the known issues will typically vary based on the data access
technology or drivers used.
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8.1 Start Database Connection Wizard

DiffDog provides a Database Copnnection Wizard that guides you through the steps required to set up a
connection to a data source. Before you go through the wizard steps, be aware that for some database types it
is necessary to install and separately configure several database prerequisites, such as a database driver or
database client software. These are normally provided by the respective database vendors, and include
documentation tailored to your specific Windows version. For a list of database drivers grouped by database
type, see Database Drivers Overview .

To start the Database Connection Wizard (see screenshot below), do the following:

· On the File menu, click Compare Database Schemas or Compare Database Data.

The Database Connection Wizard (screenshot below) is started. On the left hand side of the window, you can
select the most suitable from the following ways to connect to your database:

· Connection Wizard, which prompts you to choose your database type and then guides you through the
steps for connecting to a database of that type

· Select an existing connection
· Select a data access technology: ADO, ADO.NET, ODBC, or JDBC
· A native PostgreSQL connection
· CSV/TSV files

In the Connection Wizard pane (see screenshot below) databases can be sorted alphabetically by the name of
the database type or by recent usage. Select the option you want in the Sort By combo box. After you have
selected the database type to which you want to connect, click Next.
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The wizard will take you through the next steps according to the database type, connection technology (ADO,
ADO.NET, ODBC, JDBC), and driver that will be used. For examples applicable to each database type, see
Database Connection Examples .

Alternatively to using Connection Wizard, you can use one of the following database access technologies: 
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· Setting up an ADO Connection
· Setting up an ADO.NET Connection
· Setting up an ODBC Connection
· Setting up a JDBC Connection
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8.2 Database Drivers Overview

The following table lists common database drivers you can use to connect to a particular database through a
particular data access technology. Note that this list does not aim to be either exhaustive or prescriptive; you
can use other native or third party alternatives in addition to the drivers shown below.

Even though a number of database drivers might be already available on your Windows operating system, you
may still need to download an alternative driver. For some databases, the latest driver supplied by the database
vendor is likely to perform better than the driver that shipped with the operating system.

Database vendors may provide drivers either as separate downloadable packages, or bundled with database
client software. In the latter case, the database client software normally includes any required database drivers,
or provides you with an option during installation to select the drivers and components you wish to install.
Database client software typically consists of administration and configuration utilities used to simplify
database administration and connectivity, as well as documentation on how to install and configure the
database client and any of its components.

Configuring the database client correctly is crucial for establishing a successful connection to the database.
Before installing and using the database client software, it is strongly recommended to read carefully the
installation and configuration instructions of the database client; these may vary for each database version and
for each Windows version.

To understand the capabilities and limitations of each data access technology with respect to each database
type, refer to the documentation of that particular database product and also test the connection against your
specific environment. To avoid common connectivity issues, note the following:

· Some ADO.NET providers are not supported or have limited support. See ADO.NET Support Notes .
· When installing a database driver, it is recommended that it has the same platform as the Altova

application (32-bit or 64-bit). For example, if you are using a 32-bit Altova application on a 64-bit
operating system, install the 32-bit driver, and set up your database connection using the 32-bit driver,
see also Viewing the Available ODBC Drivers .

· When setting up an ODBC data source, it is recommended to create the data source name (DSN) as
System DSN instead of User DSN. For more information, see Setting up an ODBC Connection .

· When setting up a JDBC data source, ensure that JRE (Java Runtime Environment) or Java
Development Kit (JDK) is installed and that the CLASSPATH environment variable of the operating
system is configured. For more information, see Setting up a JDBC Connection .

· For the installation instructions and support details of any drivers or database client software that you
install from a database vendor, check the documentation provided with the installation package.

Database Interface Drivers

Firebird ADO.NET Firebird ADO.NET Data Provider (https://www.firebirdsql.org/en/additional-
downloads/)

JDBC Firebird JDBC driver ( https://www.firebirdsql.org/en/jdbc-driver/ )

ODBC Firebird ODBC driver ( https://www.firebirdsql.org/en/odbc-driver/ )

IBM DB2 ADO IBM OLE DB Provider for DB2

ADO.NET IBM Data Server Provider for .NET
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Database Interface Drivers

JDBC IBM Data Server Driver for JDBC and SQLJ

ODBC IBM DB2 ODBC Driver

IBM DB2 for i ADO · IBM DB2 for i5/OS IBMDA400 OLE DB Provider
· IBM DB2 for i5/OS IBMDARLA OLE DB Provider
· IBM DB2 for i5/OS IBMDASQL OLE DB Provider

ADO.NET .NET Framework Data Provider for IBM i

JDBC IBM Toolbox for Java JDBC Driver

ODBC iSeries Access ODBC Driver

IBM Informix ADO IBM Informix OLE DB Provider

JDBC IBM Informix JDBC Driver

ODBC IBM Informix ODBC Driver

Microsoft
Access

ADO · Microsoft Jet OLE DB Provider
· Microsoft Access Database Engine OLE DB Provider

ADO.NET .NET Framework Data Provider for OLE DB

ODBC · Microsoft Access Driver

MariaDB ADO.NET In the absence of a dedicated .NET connector for MariaDB, use
Connector/NET for MySQL
(https://dev.mysql.com/downloads/connector/net/).

JDBC MariaDB Connector/J (https://downloads.mariadb.org/)

ODBC MariaDB Connector/ODBC (https://downloads.mariadb.org/)

Microsoft SQL
Server

ADO · Microsoft OLE DB Driver for SQL Server (MSOLEDBSQL)
· Microsoft OLE DB Provider for SQL Server (SQLOLEDB)
· SQL Server Native Client (SQLNCLI)

ADO.NET · .NET Framework Data Provider for SQL Server
· .NET Framework Data Provider for OLE DB

JDBC · Microsoft JDBC Driver for SQL Server ( https://docs.microsoft.com/en-
us/sql/connect/jdbc/microsoft-jdbc-driver-for-sql-server )

ODBC · ODBC Driver for Microsoft SQL Server ( https://docs.microsoft.com/en-
us/SQL/connect/odbc/download-odbc-driver-for-sql-server )

MySQL ADO.NET · Connector/NET (https://dev.mysql.com/downloads/connector/net/)

JDBC Connector/J ( https://dev.mysql.com/downloads/connector/j/ )

ODBC Connector/ODBC ( https://dev.mysql.com/downloads/connector/odbc/ )

https://dev.mysql.com/downloads/connector/net/
https://downloads.mariadb.org/
https://downloads.mariadb.org/
https://docs.microsoft.com/en-us/sql/connect/oledb/download-oledb-driver-for-sql-server?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/connect/jdbc/microsoft-jdbc-driver-for-sql-server
https://docs.microsoft.com/en-us/sql/connect/jdbc/microsoft-jdbc-driver-for-sql-server
https://docs.microsoft.com/en-us/SQL/connect/odbc/download-odbc-driver-for-sql-server
https://docs.microsoft.com/en-us/SQL/connect/odbc/download-odbc-driver-for-sql-server
https://dev.mysql.com/downloads/connector/net/
https://dev.mysql.com/downloads/connector/j/
https://dev.mysql.com/downloads/connector/odbc/
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Database Interface Drivers

Oracle ADO · Oracle Provider for OLE DB
· Microsoft OLE DB Provider for Oracle

ADO.NET Oracle Data Provider for .NET
(http://www.oracle.com/technetwork/topics/dotnet/index-085163.html)

JDBC · JDBC Thin Driver
· JDBC Oracle Call Interface (OCI) Driver
These drivers are typically installed during the installation of your Oracle
database client. Connect through the OCI Driver (not the Thin Driver) if you
are using the Oracle XML DB component.

ODBC · Microsoft ODBC for Oracle
· Oracle ODBC Driver (typically installed during the installation of your

Oracle database client)

PostgreSQL JDBC PostgreSQL JDBC Driver ( https://jdbc.postgresql.org/download.html )

ODBC psqlODBC ( https://odbc.postgresql.org/ )

Native
Connection

Available. There is no need to install any drivers if using native connection.

Progress
OpenEdge

JDBC JDBC Connector ( https://www.progress.com/jdbc/openedge )

ODBC ODBC Connector ( https://www.progress.com/odbc/openedge )

SQLite Native
Connection

Available. There is no need to install any drivers if using native connection.

Sybase ADO Sybase ASE OLE DB Provider

JDBC jConnect™ for JDBC

ODBC Sybase ASE ODBC Driver

Teradata ADO.NET .NET Data Provider for Teradata
(https://downloads.teradata.com/download/connectivity/net-data-provider-for-
teradata)

JDBC Teradata JDBC Driver
(https://downloads.teradata.com/download/connectivity/jdbc-driver)

ODBC Teradata ODBC Driver for Windows
(https://downloads.teradata.com/download/connectivity/odbc-driver/windows)

http://www.oracle.com/technetwork/topics/dotnet/index-085163.html
https://jdbc.postgresql.org/download.html
https://odbc.postgresql.org/
https://www.progress.com/jdbc/openedge
https://www.progress.com/odbc/openedge
https://downloads.teradata.com/download/connectivity/net-data-provider-for-teradata
https://downloads.teradata.com/download/connectivity/net-data-provider-for-teradata
https://downloads.teradata.com/download/connectivity/jdbc-driver
https://downloads.teradata.com/download/connectivity/odbc-driver/windows
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8.3 ADO Connection

Microsoft ActiveX Data Objects (ADO) is a data access technology that enables you to connect to a variety of
data sources through OLE DB. OLE DB is an alternative interface to ODBC or JDBC; it provides uniform
access to data in a COM (Component Object Model) environment. ADO is a precursor of the newer
ADO.NET  and is still one of the possible ways to connect to Microsoft native databases such as Microsoft
Access or SQL Server, although you can also use it for other data sources.

Importantly, you can choose between multiple ADO providers, and some of them must be downloaded and
installed on your workstation before you can use them. For example, for connecting to SQL Server, the
following ADO providers are available:

· Microsoft OLE DB Driver for SQL Server (MSOLEDBSQL)
· Microsoft OLE DB Provider for SQL Server (SQLOLEDB)
· SQL Server Native Client (SQLNCLI)

From the providers listed above, the recommended one is MSOLEDBSQL; you can download it from
https://docs.microsoft.com/en-us/sql/connect/oledb/download-oledb-driver-for-sql-server?view=sql-server-ver15.
Note that it must match the platform of DiffDog (32-bit or 64-bit). The SQLOLEDB and SQLNCLI providers are
considered deprecated and thus are not recommended.

The Microsoft OLE DB Provider for SQL Server (SQLOLEDB) is known to have issues with parameter
binding of complex queries like Common Table Expressions (CTE) and nested SELECT statements.

To set up an ADO connection:

1. Start the database connection wizard .
2. Click ADO Connections.
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3. Click Build.

4. Select the data provider through which you want to connect. The table below lists a few common
scenarios.
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To connect to this database... Use this provider...

Microsoft Access · Microsoft Office Access Database Engine OLE DB
Provider (recommended)

· Microsoft Jet OLE DB Provider

If the Microsoft Office Access Database Engine OLE DB
Provider is not available in the list, make sure that you have
installed either Microsoft Access or the Microsoft Access
Database Engine Redistributable (https://www.microsoft.com/en-
us/download/details.aspx?id=54920) on your computer.

SQL Server · Microsoft OLE DB Driver for SQL Server
(MSOLEDBSQL) - this is the recommended OLE DB
provider. In order for this provider to appear in the list, it
must be downloaded from https://docs.microsoft.com/en-
us/sql/connect/oledb/download-oledb-driver-for-sql-
server?view=sql-server-ver15 and installed.

· Microsoft OLE DB Provider for SQL Server
(OLEDBSQL)

· SQL Server Native Client (SQLNCLI)

Other database Select the provider applicable to your database.

If an OLE DB provider to your database is not available, install the
required driver from the database vendor (see Database Drivers
Overview ). Alternatively, set up an ADO.NET, ODBC, or JDBC
connection. 

If the operating system has an ODBC driver to the required
database, you could also use the Microsoft OLE DB Provider
for ODBC Drivers, or preferably opt for an ODBC connection .

5. Having selected the provider of choice, click Next and complete the wizard.

The subsequent wizard steps are specific to the provider you chose. For SQL Server, you will need to provide or
select the host name of the database server, the authentication method, the database name, as well as the
database username and password. For an example, see Connecting to Microsoft SQL Server (ADO) . For
Microsoft Access, you will be asked to browse for or provide the path to the database file. For an example, see
Connecting to Microsoft Access (ADO) .

The complete list of initialization properties (connection parameters) is available in the All tab of the connection
dialog box—these properties vary depending on the chosen provider and may need to be set explicitly in order
for the connection to be possible. The following sections provide guidance on configuring the basic initialization
properties for Microsoft Access and SQL Server databases:

· Setting up the SQL Server Data Link Properties
· Setting up the Microsoft Access Data Link Properties
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8.3.1 Connecting to an Existing Microsoft Access Database

This approach is suitable when you want to connect to a Microsoft Access database which is not password-
protected. If the database is password-protected, set up the database password as shown in Connecting to
Microsoft Access (ADO) .

To connect to an existing Microsoft Access database:

1. Run the database connection wizard (see Starting the Database Connection Wizard ).
2. Select Microsoft Access (ADO), and then click Next.
3. Browse for the database file, or enter the path to it (either relative or absolute).
4. Click Connect.

8.3.2 Setting up the SQL Server Data Link Properties

When you connect to a Microsoft SQL Server database through ADO , you may need to set the following
connection properties in the All tab of the Data Link Properties dialog box.

Data Link  Properties dialog box
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Property Notes

Integrated Security If you selected the SQL Server Native Client data provider on the
Provider tab, set this property to a space character.

Persist Security Info Set this property to True.

8.3.3 Setting up the Microsoft Access Data Link Properties

When you connect to a Microsoft Access database through ADO , you may need to set the following
connection properties in the All tab of the Data Link Properties dialog box.

Data Link  Properties dialog box

Property Notes

Data Source This property stores the path to the Microsoft Access database file. To
avoid database connectivity issues, it is recommended to use the UNC
(Universal Naming Convention) path format, for example:

\\anyserver\share$\filepath
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Property Notes

Jet OLEDB:System Database This property stores the path to the workgroup information file. You
may need to explicitly set the value of this property before you can
connect to a Microsoft Access database.

If you cannot connect due to a "workgroup information file" error, locate
the workgroup information file (System.MDW) applicable to your user
profile, and set the property value to the path of the System.MDW file.

Jet OLEDB:Database Password If the database is password-protected, set the value of this property to
the database password.
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8.4 ADO.NET Connection

ADO.NET is a set of Microsoft .NET Framework libraries designed to interact with data, including data from
databases. To connect to a database from DiffDog through ADO.NET, Microsoft .NET Framework 4 or later is
required. As shown below, you connect to a database through ADO.NET by selecting a .NET provider and
supplying a connection string.

A .NET data provider is a collection of classes that enables connecting to a particular type of data source (for
example, a SQL Server, or an Oracle database), executing commands against it, and fetching data from it. In
other words, with ADO.NET, an application such as DiffDog interacts with a database through a data provider.
Each data provider is optimized to work with the specific type of data source that it is designed for. There are
two types of .NET providers:

1. Supplied by default with Microsoft .NET Framework.
2. Supplied by major database vendors, as an extension to the .NET Framework. Such ADO.NET

providers must be installed separately and can typically be downloaded from the website of the
respective database vendor.

Note: Certain ADO.NET providers are not supported or have limited support. See ADO.NET Support
Notes .

To set up an ADO.NET connection:

1. Start the database connection wizard .
2. Click ADO.NET Connections.
3. Select a .NET data provider from the list.

The list of providers available by default with the .NET Framework appears in the "Provider" list.
Vendor-specific .NET data providers are available in the list only if they are already installed on
your system. To become available, vendor-specific .NET providers must be installed into the GAC
(Global Assembly Cache), by running the .msi or .exe file supplied by the database vendor.

4. Enter a database connection string. A connection string defines the database connection information,
as semicolon-delimited key/value pairs of connection parameters. For example, a connection string
such as Data Source=DBSQLSERV;Initial Catalog=ProductsDB;User

ID=dbuser;Password=dbpass connects to the SQL Server database ProductsDB on server

DBSQLSERV, with the user name dbuser and password dbpass. You can create a connection string by
typing the key/value pairs directly into the "Connection String" dialog box. Another option is to create it
with Visual Studio (see Creating a Connection String in Visual Studio ).

The syntax of the connection string depends on the provider selected from the "Provider" list. For
examples, see Sample ADO.NET Connection Strings .
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5. Click Connect.

8.4.1 Creating a Connection String in Visual Studio

In order to connect to a data source using ADO.NET, a valid database connection string is required. The
following instructions show you how to create a connection string from Visual Studio. 

To create a connection string in Visual Studio:

1. On the Tools menu, click Connect to Database.
2. Select a data source from the list (in this example, Microsoft SQL Server). The Data Provider is filled

automatically based on your choice.
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3. Click Continue.
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4. Enter the server host name and the user name and password to the database. In this example, we are
connecting to the database ProductsDB on server DBSQLSERV, using SQL Server authentication.

5. Click OK. 

If the database connection is successful, it appears in the Server Explorer window. You can display the Server
Explorer window using the menu command View | Server Explorer. To obtain the database connection string,
right-click the connection in the Server Explorer window, and select Properties. The connection string is now
displayed in the Properties window of Visual Studio. Note that, before pasting the string into the "Connection
String" box of DiffDog, you will need to replace the asterisk ( * ) characters with the actual password.
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8.4.2 Sample ADO.NET Connection Strings

To set up an ADO.NET connection, you need to select an ADO.NET provider from the database connection
dialog box and enter a connection string (see also Setting up an ADO.NET Connection ). Sample ADO.NET
connection strings for various databases are listed below under the .NET provider where they apply.

.NET Data Provider for Teradata
This provider can be downloaded from Teradata website
(https://downloads.teradata.com/download/connectivity/net-data-provider-for-teradata). A sample connection
string looks as follows:

Data Source=ServerAddress;User Id=user;Password=password;

.NET Framework Data Provider for IBM i
This provider is installed as part of IBM i Access Client Solutions - Windows Application Package. A sample
connection string looks as follows:

DataSource=ServerAddress;UserID=user;Password=password;DataCompression=True;

For more information, see the ".NET Provider Technical Reference" help file included in the installation package
above.

.NET Framework Data Provider for MySQL
This provider can be downloaded from MySQL website (https://dev.mysql.com/downloads/connector/net/). A
sample connection string looks as follows:

Server=127.0.0.1;Uid=root;Pwd=12345;Database=test;

See also: https://dev.mysql.com/doc/connector-net/en/connector-net-programming-connecting-connection-
string.html

.NET Framework Data Provider for SQL Server
A sample connection string looks as follows:

Data Source=DBSQLSERV;Initial Catalog=ProductsDB;User ID=dbuser;Password=dbpass

See also: https://msdn.microsoft.com/en-us/library/ms254500(v=vs.110).aspx 

IBM DB2 Data Provider 10.1.2 for .NET Framework 4.0

Database=PRODUCTS;UID=user;Password=password;Server=localhost:50000;
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Note: This provider is typically installed with the IBM DB2 Data Server Client package. If the provider is
missing from the list of ADO.NET providers after installing IBM DB2 Data Server Client package, refer
to the following technical note: https://www-01.ibm.com/support/docview.wss?uid=swg21429586.

See also:
https://www.ibm.com/support/knowledgecenter/en/SSEPGG_10.1.0/com.ibm.swg.im.dbclient.adonet.ref.doc/d
oc/DB2ConnectionClassConnectionStringProperty.html

Oracle Data Provider for .NET (ODP.NET)
The installation package which includes the ODP.NET provider can be downloaded from the Oracle website
(see http://www.oracle.com/technetwork/topics/dotnet/downloads/index.html). A sample connection string
looks as follows:

Data Source=DSORCL;User Id=user;Password=password;

Where DSORCL is the name of the data source which points to an Oracle service name defined in the
tnsnames.ora file, as described in Connecting to Oracle (ODBC) .

To connect without configuring a service name in the tnsnames.ora file, use a string such as:

Data Source=(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=host)(PORT=port)))

(CONNECT_DATA=(SERVER=DEDICATED)(SERVICE_NAME=MyOracleSID)));User

Id=user;Password=password;

See also: https://docs.oracle.com/cd/B28359_01/win.111/b28375/featConnecting.htm 

8.4.3 ADO.NET Support Notes

The following table lists known ADO.NET database drivers that are currently not supported or have limited
support in DiffDog.

Database Driver Support notes

All databases .Net Framework Data Provider
for ODBC

Limited support. Known issues exist with
Microsoft Access connections. It is
recommended to use ODBC direct
connections instead.

.Net Framework Data Provider
for OleDb

Limited support. Known issues exist with
Microsoft Access connections. It is
recommended to use ADO direct connections
instead. 

Firebird Firebird ADO.NET Data Provider Limited support. It is recommended to use
ODBC or JDBC instead.

Informix IBM Informix Data Provider for Not supported. Use DB2 Data Server
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Database Driver Support notes

.NET Framework 4.0 Provider instead.

IBM DB2 for i (iSeries) .Net Framework Data Provider
for i5/OS

Not supported. Use .Net Framework Data
Provider for IBM i instead, installed as part
of the IBM i Access Client Solutions -
Windows Application Package.

Oracle .Net Framework Data Provider
for Oracle

Limited support. Although this driver is
provided with the .NET Framework, its usage
is discouraged by Microsoft, because it is
deprecated. 

PostgreSQL - No ADO.NET drivers for this vendor are
supported. Use a native connection instead.

Sybase - No ADO.NET drivers for this vendor are
supported.
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8.5 ODBC Connection

ODBC (Open Database Connectivity) is a widely used data access technology that enables you to connect to
a database from DiffDog. It can be used either as primary means to connect to a database, or as an alternative
to native, OLE DB, or JDBC-driven connections.

To connect to a database through ODBC, first you need to create an ODBC data source name (DSN) on the
operating system. This step is not required if the DSN has already been created, perhaps by another user of
the operating system. The DSN represents a uniform way to describe the database connection to any ODBC-
aware client application on the operating system, including DiffDog. DSNs can be of the following types:

· System DSN
· User DSN
· File DSN

A System data source is accessible by all users with privileges on the operating system. A User data source is
available to the user who created it. Finally, if you create a File DSN, the data source will be created as a file
with the .dsn extension which you can share with other users, provided that they have installed the drivers used
by the data source. 

Any DSNs already available on your machine are listed by the database connection dialog box when you click
ODBC connections on the ODBC connections dialog box.

ODBC Connections dialog box

If a DSN to the required database is not available, the DiffDog database connection wizard will assist you to
create it; however, you can also create it directly on your Windows operating system. In either case, before you
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proceed, ensure that the ODBC driver applicable for your database is in the list of ODBC drivers available to the
operating system (see Viewing the Available ODBC Drivers  ).

To connect by using a new DSN:

1. Start the database connection wizard . 
2. On the database connection dialog box, click ODBC Connections.
3. Select a data source type (User DSN, System DSN, File DSN).

To create a System DSN, you need administrative rights on the operating system, and DiffDog
must be run as administrator.

4. Click Add  .
5. Select a driver, and then click User DSN or System DSN (depending on the type of the DSN you want

to create). If the driver applicable to your database is not listed, download it from the database vendor
and install it (see Database Drivers Overview  ).

6. On the dialog box that pops up, fill in any driver specific connection information to complete the setup.

For the connection to be successful, you will need to provide the host name (or IP address) of the database
server, as well as the database username and password. There may be other optional connection parameters—
these parameters vary between database providers. For detailed information about the parameters specific to
each connection method, consult the documentation of the driver provider. Once created, the DSN becomes
available in the list of data source names. This enables you to reuse the database connection details any time
you want to connect to the database. Note that User DSNs are added to the list of User DSNs whereas
System DSNs are added to the list of System DSNs.

To connect by using an existing DSN:

1. Start the database connection wizard . 
2. Click ODBC Connections.
3. Choose the type of the existing data source (User DSN, System DSN, File DSN).
4. Click the existing DSN record, and then click Connect.

To build a connection string based on an existing .dsn file:

1. Start the database connection wizard . 
2. Click ODBC Connections.
3. Select Build a connection string, and then click Build.
4. If you want to build the connection string using a File DSN, click the File Data Source tab. Otherwise,

click the Machine Data Source tab. (System DSNs and User DSNs are known as "Machine" data
sources.) 

5. Select the required .dsn file, and then click OK.

To connect by using a prepared connection string:

1. Start the database connection wizard . 
2. Click ODBC Connections.
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3. Select Build a connection string. 
4. Paste the connection string into the provided box, and then click Connect.

8.5.1 Available ODBC Drivers

You can view the ODBC drivers available on your operating system in the ODBC Data Source Administrator.
You can access the ODBC Data Source Administrator (Odbcad32.exe) from the Windows Control Panel,
under Administrative Tools. On 64-bit operating systems, there are two versions of this executable:

· The 32-bit version of the Odbcad32.exe file is located in the C:\Windows\SysWoW64 directory
(assuming that C: is your system drive).

· The 64-bit version of the Odbcad32.exe file is located in the C:\Windows\System32 directory.

Any installed 32-bit database drivers are visible in the 32-bit version of ODBC Data Source Administrator, while
64-bit drivers—in the 64-bit version. Therefore, ensure that you check the database drivers from the relevant
version of ODBC Data Source Administrator.

ODBC Data Source Administrator

If the driver to your target database does not exist in the list, or if you want to add an alternative driver, you will
need to download it from the database vendor (see Database Drivers Overview  ). Once the ODBC driver is
available on your system, you are ready to create ODBC connections with it (see Setting up an ODBC
Connection  ).
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8.6 JDBC Connection

JDBC (Java Database Connectivity) is a database access interface which is part of the Java software platform
from Oracle. JDBC connections are generally more resource-intensive than ODBC connections but may provide
features not available through ODBC.

Prerequisites
· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either

Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK.
· The JDBC drivers from the database vendor must be installed. These may be JDBC drivers installed as

part of a database client installation, or JDBC libraries (.jar files) downloaded separately, if available
and supported by the database, see also Database Connection Examples .

· The CLASSPATH environment variable must include the path to the JDBC driver (one or several .jar files)
on your Windows operating system. When you install some database clients, the installer may
configure this variable automatically. See also Configuring the CLASSPATH .

Connecting to SQL Server via JDBC with Windows credentials
If you connect to SQL Server through JDBC with Windows credentials (integrated security), note the following:

· The sqljdbc_auth.dll file included in the JDBC driver package must be copied to a directory that is on
the system PATH environment variable. There are two such files, one for the x86 and one for x64
platform. Make sure that you add to the PATH the one that corresponds to your JDK platform. 

· The JDBC connection string must include the property integratedSecurity=true. 

For further information, refer to Microsoft JDBC driver for SQL Server documentation,
https://docs.microsoft.com/en-us/sql/connect/jdbc/building-the-connection-url.

Setting up a JDBC connection
1. Start the database connection wizard . 
2. Click JDBC Connections.
3. Optionally, enter a semicolon-separated list of .jar file paths in the "Classpaths" text box. The .jar

libraries entered here will be loaded into the environment in addition to those already defined in the
CLASSPATH environment variable. When you finish editing the "Classpaths" text box, any JDBC drivers
found in the source .jar libraries are automatically added to the "Driver" list (see the next step).
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4. Next to "Driver", select a JDBC driver from the list, or enter a Java class name. Note that this list
contains any JDBC drivers configured through the CLASSPATH environment variable (see Configuring the
CLASSPATH ), as well as those found in the "Classpaths" text box.

The JDBC driver paths defined in the CLASSPATH variable, as well as any .jar file paths entered
directly in the database connection dialog box are all supplied to the Java Virtual Machine (JVM).
The JVM then decides which drivers to use in order to establish a connection. It is recommended
to keep track of Java classes loaded into the JVM so as not to create potential JDBC driver
conflicts and avoid unexpected results when connecting to the database.

5. Enter the username and password to the database in the corresponding boxes.
6. In the Database URL text box, enter the JDBC connection URL (string) in the format specific to your

database type. The following table describes the syntax of JDBC connection URLs (strings) for
common database types.

Database JDBC Connection URL

Firebird jdbc:firebirdsql://<host>[:<port>]/<database path or

alias>

IBM DB2 jdbc:db2://hostName:port/databaseName

IBM DB2 for i jdbc:as400://[host]
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Database JDBC Connection URL

IBM Informix jdbc:informix-
sqli://hostName:port/databaseName:INFORMIXSERVER=myserver

MariaDB jdbc:mariadb://hostName:port/databaseName

Microsoft SQL Server jdbc:sqlserver://hostName:port;databaseName=name

MySQL jdbc:mysql://hostName:port/databaseName

Oracle jdbc:oracle:thin:@hostName:port:SID

jdbc:oracle:thin:@//hostName:port/service

Oracle XML DB jdbc:oracle:oci:@//hostName:port:service

PostgreSQL jdbc:postgresql://hostName:port/databaseName

Progress OpenEdge jdbc:datadirect:openedge://host:port;databaseName=db_name

Sybase jdbc:sybase:Tds:hostName:port/databaseName

Teradata jdbc:teradata://databaseServerName

Note: Syntax variations to the formats listed above are also possible (for example, the database URL may
exclude the port or may include the username and password to the database). Check the
documentation of the database vendor for further details.

7. Click Connect.

8.6.1 Configuring the CLASSPATH

The CLASSPATH environment variable is used by the Java Runtime Environment (JRE) or the Java Development
Kit (JDK) to locate Java classes and other resource files on your operating system. When you connect to a
database through JDBC, this variable must be configured to include the path to the JDBC driver on your
operating system, and, in some cases, the path to additional library files specific to the database type you are
using.

The following table lists sample file paths that must be typically included in the CLASSPATH variable.
Importantly, you may need to adjust this information based on the location of the JDBC driver on your system,
the JDBC driver name, as well as the JRE/JDK version present on your operating system. To avoid connectivity
problems, check the installation instructions and any pre-installation or post-installation configuration steps
applicable to the JDBC driver installed on your operating system.

Database Sample CLASSPATH entries

Firebird C:\Program Files\Firebird\Jaybird-2.2.8-JDK_1.8\jaybird-full-
2.2.8.jar

IBM DB2 C:\Program Files (x86)\IBM\SQLLIB\java\db2jcc.jar;C:\Program
Files (x86)\IBM\SQLLIB\java\db2jcc_license_cu.jar;
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Database Sample CLASSPATH entries

IBM DB2 for i C:\jt400\jt400.jar;

IBM Informix C:\Informix_JDBC_Driver\lib\ifxjdbc.jar;

Microsoft SQL Server C:\Program Files\Microsoft JDBC Driver 4.0 for SQL
Server\sqljdbc_4.0\enu\sqljdbc.jar

MariaDB <installation directory>\mariadb-java-client-2.2.0.jar

MySQL <installation directory>\mysql-connector-java-version-bin.jar;

Oracle ORACLE_HOME\jdbc\lib\ojdbc6.jar;

Oracle (with XML DB) ORACLE_HOME\jdbc\lib\ojdbc6.jar;ORACLE_HOME\LIB\xmlparserv2.jar;

ORACLE_HOME\RDBMS\jlib\xdb.jar;

PostgreSQL <installation directory>\postgresql.jar

Progress OpenEdge %DLC%\java\openedge.jar;%DLC%\java\pool.jar;

Note: Assuming the Progress OpenEdge SDK is installed on the machine, %
DLC% is the directory where OpenEdge is installed.

Sybase C:\sybase\jConnect-7_0\classes\jconn4.jar

Teradata <installation directory>\tdgssconfig.jar;<installation

directory>\terajdbc4.jar

· Changing the CLASSPATH variable may affect the behavior of Java applications on your machine. To
understand possible implications before you proceed, refer to the Java documentation.

· Environment variables can be user or system. To change system environment variables, you need
administrative rights on the operating system.

· After you change the environment variable, restart any running programs for settings to take effect.
Alternatively, log off or restart your operating system.

To configure the CLASSPATH on Windows 7:

1. Open the Start menu and right-click Computer.
2. Click Properties.
3. Click Advanced system settings.
4. In the Advanced tab, click Environment Variables, 
5. Locate the CLASSPATH variable under user or system environment variables, and then click Edit. If

the CLASSPATH variable does not exist, click New to create it.
6. Edit the variable value to include the path on your operating system where the JDBC driver is located.

To separate the JDBC driver path from other paths that may already be in the CLASSPATH variable,
use the semi-colon separator ( ; ).
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To configure the CLASSPATH on Windows 10:

1. Press the Windows key and start typing "environment variables".
2. Click the suggestion Edit the system environment variables.
3. Click Environment Variables.
4. Locate the CLASSPATH variable under user or system environment variables, and then click Edit. If

the CLASSPATH variable does not exist, click New to create it.
5. Edit the variable value to include the path on your operating system where the JDBC driver is located.

To separate the JDBC driver path from other paths that may already be in the CLASSPATH variable,
use the semi-colon separator ( ; ).



© 2016-2022 Altova GmbH

PostgreSQL Connection 181Connecting to a Data Source

Altova DiffDog 2023 Enterprise Edition

8.7 PostgreSQL Connection

Connections to PostgreSQL databases can be set up either as native connections, or connections via ODBC,
JDBC, and other drivers. The advantage of setting up a native connection is that no drivers are required to be
installed on your system. 

If you prefer to establish a connection by means of a non-native driver, see the following topics:

· Setting up a JDBC Connection
· Connecting to PostgreSQL (ODBC)

Otherwise, if you want to set up a native connection to PostgreSQL, follow the steps below. To proceed, you
need the following prerequisites: host name, port, database name, username, and password.

To set up a native PostgreSQL connection:

1. Start the database connection wizard . 
2. Click PostgreSQL Connections.
3. Enter the host (localhost, if PostgreSQL runs on the same machine), port (typically 5432, this is

optional), the database name, username, and password in the corresponding boxes.
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4. Click Connect.

If the PostgreSQL database server is on a different machine, note the following:

· The PostgreSQL database server must be configured to accept connections from clients. Specifically,
the pg_hba.conf file must be configured to allow non-local connections. Secondly, the
postgresql.conf file must be configured to listen on specified IP address(es) and port. For more
information, check the PostgreSQL documentation (https://www.postgresql.org/docs/9.5/static/client-
authentication-problems.html).

· The server machine must be configured to accept connections on the designated port (typically, 5432)
through the firewall. For example, on a database server running on Windows, a rule may need to be
created to allow connections on port 5432 through the firewall, from Control Panel > Windows
Firewall > Advanced Settings > Inbound Rules.

https://www.postgresql.org/docs/9.5/static/client-authentication-problems.html
https://www.postgresql.org/docs/9.5/static/client-authentication-problems.html
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8.8 SQLite Connection

SQLite is a file-based, self-contained database type, which makes it ideal in scenarios where portability and
ease of configuration is important. Since SQLite databases are natively supported by DiffDog, you do not need
to install any drivers to connect to them.

SQLite database support notes
· On Linux, statement execution timeout for SQLite databases is not supported.
· Full text search tables are not supported.
· SQLite allows values of different data types in each row of a given table. All processed values must be

compatible with the declared column type; therefore, unexpected values can be retrieved and run-time
errors may occur if your SQLite database has row values which are not the same as the declared
column type. 

Important

It is recommended to create tables with the STRICT keyword to ensure more predictable behavior of your
data. Otherwise, the data may not be read or written correctly when values of different types are mixed in one
column. To find out more about STRICT tables, see the SQLite documentation.

8.8.1 Connect to an Existing SQLite Database

To connect to an existing SQLite database:

1. Run the database connection wizard (see Starting the Database Connection Wizard ).
2. Select SQLite, and then click Next.
3. Browse for the SQLite database file, or enter the path (either relative or absolute) to the database. The

Connect button becomes enabled once you enter the path to a SQLite database file.
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4. Optionally, select the Disable Foreign Keys check box, see Foreign Key Constraints . 
5. Click Connect.

8.8.2 Foreign Key Constraints

When you connect to an existing SQLite database from DiffDog, foreign key constraints are enabled by default.
Foreign key constraints help preserve the integrity of data in your database. For example, when foreign keys
are enabled, it is not possible to delete a record from a table if it has dependencies in another table. 

In certain cases, you may want to temporarily override this behavior and disable foreign keys, perhaps, in order
to update or insert multiple rows of data without getting data validation errors. To explicitly disable foreign keys
before connecting to the SQLite database, select the Disable Foreign Keys option available on the database
connection wizard.
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"Connect to SQLite" wizard page

When foreign keys are disabled, you will be able to perform operations against data that would otherwise not be
possible due to validation checks. At the same time, however, there is also the risk of introducing incorrect
data into the database, or creating "orphaned" rows. (An example of an "orphaned" row would be an address in
the "addresses" table not linked to any person in the "person" table, because the person was deleted but its
associated address was not.)
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8.9 CSV/TSV File as Data Source

In addition to databases, you can establish data connections to comma-separated values (CSV) or tab-
separated values (TSV) files. In order for the CSV file to open correctly, the fields in each row must be
separated by one the following delimiters: comma, tab, or semicolon. Also, each line must contain the same
number of fields throughout the file. The file extension is not important. 

To connect to a CSV or TSV file:

1. Run the database connection wizard (see Starting the Database Connection Wizard ).
2. Select CSV/TSV files from the left side of the dialog box.
3. Click Browse and select the source file, or enter the path to the file. The Connect button becomes

enabled once you enter the path to a file.
4. Select the separator used in the source file (tab, comma, or semicolon).
5. To treat the first row as a header row, select the First row is header row check box. 

6. Click Connect.
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8.10 Database Connection Examples

This section includes examples for connecting to a database from DiffDog through ADO, ODBC, or JDBC. The
ADO.NET connection examples are listed separately, see Sample ADO.NET Connection Strings . For
instructions about establishing a native connection to PostgreSQL and SQLite, see Setting up a PostgreSQL
Connection  and Setting up a SQLite Connection , respectively.

Note the following:

· The instructions may differ if your Windows configuration, network environment and the database client
or server software are not the same as the ones described in each example. 

· For most database types, it is possible to connect using more than one data access technology
(ADO, ADO.NET, ODBC, JDBC) or driver. The performance of the database connection, as well as its
features and limitations will depend on the selected driver, database client software (if applicable), and
any additional connectivity parameters that you may have configured outside DiffDog.

8.10.1 Firebird (JDBC)

This example illustrates how to connect to a Firebird database server through JDBC. 

Prerequisites:

· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either
Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK.
· The Firebird JDBC driver must be available on your operating system (it takes the form of a .jar file

which provides connectivity to the database). The driver can be downloaded from the Firebird website
( https://www.firebirdsql.org/ ). This example uses Jaybird 2.2.8.

· You have the following database connection details: host, database path or alias, username, and
password.

To connect to Firebird through JDBC:

1. Start the database connection wizard . 
2. Click JDBC Connections.
3. Next to "Classpaths", enter the path to the .jar file which provides connectivity to the database. If

necessary, you can also enter a semicolon-separated list of .jar file paths. In this example, the
required .jar file is located at the following path: C:\jdbc\firebird\jaybird-full-2.2.8.jar. Note that you
can leave the "Classpaths" text box empty if you have added the .jar file path(s) to the CLASSPATH
environment variable of the operating system (see also Configuring the CLASSPATH ). 

4. In the "Driver" box, select org.firebirdsql.jdbc.FBDriver. Note that this entry is available if a valid .jar
file path is found either in the "Classpath" text box, or in the operating system's CLASSPATH
environment variable (see the previous step).
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5. Enter the username and password to the database in the corresponding text boxes.
6. Enter the connection string to the database server in the Database URL text box, by replacing the

highlighted values with the ones applicable to your database server.

jdbc:firebirdsql://<host>[:<port>]/<database path or alias>

7. Click Connect.

8.10.2 Firebird (ODBC)

This example illustrates how to connect to a Firebird 2.5.4 database running on a Linux server. 

Prerequisites:

· The Firebird database server is configured to accept TCP/IP connections from clients.
· The Firebird ODBC driver must be installed on your operating system. This example uses the Firebird

ODBC driver version 2.0.3.154 downloaded from the Firebird website ( https://www.firebirdsql.org/ ). 
· The Firebird client must be installed on your operating system. Note that there is no standalone

installer available for the Firebird 2.5.4 client; the client is part of the Firebird server installation
package. You can download the Firebird server installation package from the Firebird website
( https://www.firebirdsql.org/ ), look for "Windows executable installer for full Superclassic/Classic or
Superserver". To install only the client files, choose "Minimum client install - no server, no tools"
when going through the wizard steps.

https://www.firebirdsql.org/
https://www.firebirdsql.org/
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Important:

· The platform of both the Firebird ODBC driver and client (32-bit or 64-bit) must correspond
to that of DiffDog.

· The version of the Firebird client must correspond to the version of Firebird server to which
you are connecting.

· You have the following database connection details: server host name or IP address, database path (or
alias) on the server, user name, and password.

To connect to Firebird via ODBC:

1. Start the database connection wizard . 
2. Click ODBC Connections. 

3. Select User DSN (or System DSN, if you have administrative privileges), and then click Add  .

4. Select the Firebird driver, and then click User DSN (or System DSN, depending on what you selected
in the previous step). If the Firebird driver is not available in the list, make sure that it is installed on
your operating system (see also Viewing the Available ODBC Drivers  ).
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5. Enter the database connection details as follows:

Data Source Name (DSN) Enter a descriptive name for the data source you are creating.

Database Enter the server host name or IP address, followed by a colon,
followed by the database alias (or path). In this example, the host
name is firebirdserv, and the database alias is products, as
follows:

firebirdserv:products

Using a database alias assumes that, on the server side, the
database administrator has configured the alias products to point to
the actual Firebird (.fdb) database file on the server (see the Firebird
documentation for more details). 

You can also use the server IP address instead of the host name,
and a path instead of an alias; therefore, any of the following sample
connection strings are valid:

firebirdserver:/var/Firebird/databases/butterflies.fdb
127.0.0.1:D:\Misc\Lenders.fdb
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If the database is on the local Windows machine, click Browse and
select the Firebird (.fdb) database file directly.

Client Enter the path to the fbclient.dll file. By default, this is the bin
subdirectory of the Firebird installation directory.

Database Account Enter the database user name supplied by the database
administrator (in this example, PROD_ADMIN).

Password Enter the database password supplied by the database
administrator.

6. Click OK.

8.10.3 IBM DB2 (JDBC)

This example illustrates how to connect to an IBM DB2 database server through JDBC.

Prerequisites:

· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either
Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK. This example uses
Oracle's OpenJDK 11.0 64-bit, and, consequently, the 64-bit version of DiffDog.

· The JDBC driver (one or several .jar files that provide connectivity to the database) must be available on
your operating system. This example uses the JDBC driver available after installing the IBM Data
Server Client version 10.1 (64-bit). For the JDBC drivers to be installed, choose a Typical installation,
or select this option explicitly on the installation wizard.
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If you did not change the default installation path, the required .jar files will be in the C:\Program
Files\IBM\SQLLIB\java directory after installation.

· You need the following database connection details: host, port, database name, username, and
password.

To connect to IBM DB2 through JDBC:

1. Start the database connection wizard .
2. Click JDBC Connections.
3. Next to "Classpaths", enter the path to the .jar file which provides connectivity to the database. This

examples refers to C:\Program Files\IBM\SQLLIB\java\db2jcc.jar. You may need to refer to the
db2jcc4.jar driver, depending on the database server version. For driver compatibility, refer to IBM
documentation (http://www-01.ibm.com/support/docview.wss?uid=swg21363866). Note that you can
leave the "Classpaths" text box empty if you have added the .jar file path(s) to the CLASSPATH
environment variable of the operating system (see also Configuring the CLASSPATH ).

4. In the "Driver" box, select com.ibm.db2.jcc.DB2Driver. This entry becomes available only if a valid
.jar file path was found either in the "Classpaths" text box, or in the operating system's CLASSPATH
environment variable (see the previous step).
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5. Enter the username and password of the database user in the corresponding text boxes.
6. Enter the JDBC connection string in the Database URL text box. Make sure to replace the connection

details with the ones applicable to your database server.

jdbc:db2://hostName:port/databaseName

7. Click Connect.

8.10.4 IBM DB2 (ODBC)

This example illustrates how to connect to an IBM DB2 database through ODBC.

Prerequisites:

· IBM Data Server Client must be installed and configured on your operating system (this example uses
IBM Data Server Client 9.7). For installation instructions, check the documentation supplied with your
IBM DB2 software. After installing the IBM Data Server Client, check if the ODBC drivers are available
on your machine (see Viewing the Available ODBC Drivers ).

· Create a database alias. There are several ways to do this:
o From IBM DB2 Configuration Assistant

o From IBM DB2 Command Line Processor

o From the ODBC data source wizard (for this case, the instructions are shown below)

· You have the following database connection details: host, database, port, username, and password.

To connect to IBM DB2:

1. Start the database connection wizard  and select IBM DB2 (ODBC/JDBC).
2. Click Next.
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3. Select ODBC, and click Next. If prompted to edit the list of known drivers for the database, select the
database drivers applicable to IBM DB2 (see Prerequisites ), and click Next.193
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4. Select the IBM DB2 driver from the list, and then click Connect. (To edit the list of available drivers,
click Edit Drivers, and then check or uncheck the IBM DB2 drivers you wish to add or remove,
respectively.)
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5. Enter a data source name (in this example, DB2DSN), and then click Add.

6. On the Data Source tab, enter the user name and password to the database.
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7. On the TCP/IP tab, enter the database name, a name for the alias, the host name and the port
number, and then click OK.
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8. Enter again the username and password, and then click OK.
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8.10.5 IBM DB2 for i (JDBC)

This example illustrates how to connect to an IBM DB2 for i database server through JDBC.

Prerequisites:

· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either
Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK. This example uses
Oracle's OpenJDK 11.0 64-bit, and, consequently, the 64-bit version of DiffDog.

· The JDBC driver (one or several .jar files that provide connectivity to the database) must be available on
your operating system. This example uses the open source Toolbox for Java/JTOpen version 9.8
(http://jt400.sourceforge.net/). After you download the package and unpack to a local directory, the
required .jar files will be available in the lib subdirectory.

· You need the following database connection details: host, username, and password.

To connect to IBM DB2 for i through JDBC:

1. Start the database connection wizard .
2. Click JDBC Connections.
3. Next to "Classpaths", enter the path to the .jar file which provides connectivity to the database. In this

example, the required .jar file is at the following path: C:\jdbc\jtopen_9_8\jt400.jar. Note that you can
leave the "Classpaths" text box empty if you have added the .jar file path(s) to the CLASSPATH
environment variable of the operating system (see also Configuring the CLASSPATH ).

4. In the "Driver" box, select com.ibm.as400.access.AS400JDBCDriver. This entry becomes available
only if a valid .jar file path was found either in the "Classpaths" text box, or in the operating system's
CLASSPATH environment variable (see the previous step).

5. Enter the username and password of the database user in the corresponding text boxes.
6. Enter the JDBC connection string in the Database URL text box. Make sure to replace host with the

host name or IP address of your database server.

jdbc:as400://host
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7. Click Connect.

8.10.6 IBM DB2 for i (ODBC)

This example illustrates how to connect to an IBM DB2 for i database through ODBC. 

Prerequisites:

· IBM System i Access for Windows must be installed on your operating system (this example uses
IBM System i Access for Windows V6R1M0). For installation instructions, check the documentation
supplied with your IBM DB2 for i software. After installation, check if the ODBC driver is available on
your machine (see Viewing the Available ODBC Drivers ).

· You have the following database connection details: the I.P. address of the database server, database
user name, and password.

· Run System i Navigator and follow the wizard to create a new connection. When prompted to specify a
system, enter the I.P. address of the database server. After creating the connection, it is
recommended to verify it (click on the connection, and select File > Diagnostics > Verify
Connection). If you get connectivity errors, contact the database server administrator.

To connect to IBM DB2 for i:

1. Start the database connection wizard . 
2. Click ODBC connections.
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3. Click User DSN (alternatively, click System DSN, or File DSN, in which case the subsequent
instructions will be similar).

4. Click Add  .
5. Select the iSeries Access ODBC Driver from the list, and click User DSN (or System DSN, if

applicable).

6. Enter a data source name and select the connection from the System combo box. In this example, the
data source name is iSeriesDSN and the System is 192.0.2.0.

7. Click Connection Options, select Use the User ID specified below and enter the name of the
database user (in this example, DBUSER).
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8. Click OK. The new data source becomes available in the list of DSNs.
9. Click Connect.
10. Enter the user name and password to the database when prompted, and then click OK.

8.10.7 IBM Informix (JDBC)

This example illustrates how to connect to an IBM Informix database server through JDBC. 

Prerequisites:

· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either
Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK.
· The JDBC driver (one or several .jar files that provide connectivity to the database) must be available on

your operating system. In this example, IBM Informix JDBC driver version 3.70 is used. For the driver's
installation instructions, see the documentation accompanying the driver or the "IBM Informix JDBC
Driver Programmer's Guide").

· You have the following database connection details: host, name of the Informix server, database, port,
username, and password.
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To connect to IBM Informix through JDBC:

1. Start the database connection wizard . 
2. Click JDBC Connections.
3. Next to "Classpaths", enter the path to the .jar file which provides connectivity to the database. If

necessary, you can also enter a semicolon-separated list of .jar file paths. In this example, the
required .jar file is located at the following path: C:\Informix_JDBC_Driver\lib\ifxjdbc.jar. Note that
you can leave the "Classpaths" text box empty if you have added the .jar file path(s) to the
CLASSPATH environment variable of the operating system (see also Configuring the CLASSPATH
). 

4. In the "Driver" box, select com.informix.jdbc.IfxDriver. Note that this entry is available if a valid .jar
file path is found either in the "Classpaths" text box, or in the operating system's CLASSPATH
environment variable (see the previous step).

5. Enter the username and password to the database in the corresponding text boxes.
6. Enter the connection string to the database server in the Database URL text box, by replacing the

highlighted values with the ones applicable to your database server.

jdbc:informix-sqli://hostName:port/databaseName:INFORMIXSERVER=myserver;

7. Click Connect.
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8.10.8 MariaDB (ODBC)

This example illustrates how to connect to a MariaDB database server through ODBC. 

Prerequisites:

· The MariaDB Connector/ODBC (https://downloads.mariadb.org/connector-odbc/) must be installed.
· You have the following database connection details: host, database, port, username, and password.

To connect to MariaDB through ODBC:

1. Start the database connection wizard . 
2. Select MariaDB (ODBC), and then click Next. 

3. Select Create a new Data Source Name (DSN) with the driver, and choose MariaDB ODBC 3.0
Driver. If no such driver is available in the list, click Edit Drivers, and select any available MariaDB
drivers (the list contains all ODBC drivers installed on your operating system).

4. Click Connect.
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5. Enter name and, optionally, a description that will help you identify this ODBC data source in future.

6. Fill in the database connection credentials (TCP/IP Server, User, Password), select a database, and
then click Test DSN. Upon successful connection, a message box appears:
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7. Click Next and complete the wizard. Other parameters may be required, depending on the case (for
example, SSL certificates if you are connecting to MariaDB through a secure connection).

Note: If the database server is remote, it must be configured by the server administrator to accept remote
connections from your machine's IP address. 

8.10.9 Microsoft Access (ADO)

A simple way to connect to a Microsoft Access database is to follow the wizard and browse for the database
file, as shown in Connecting to an Existing Microsoft Access Database . An alternative approach is to set up
an ADO connection explicitly, as shown in this topic. This approach is useful if your database is password-
protected.  

It is also possible to connect to Microsoft Access through an ODBC connection, but it has limitations, so it is
best to avoid it.

To connect to a password-protected Microsoft Access database:

1. Start the database connection wizard . 
2. Click ADO Connections.
3. Click Build.
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4. Select the Microsoft Office 15.0 Access Database Engine OLE DB Provider, and then click Next.
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5. In the Data Source box, enter the path to the Microsoft Access file in UNC format, for example, \
\myserver\\mynetworkshare\Reports\Revenue.accdb, where myserver is the name of the server
and mynetworkshare is the name of the network share.

6. On the All tab, double click the Jet OLEDB:Database Password property and enter the database
password as property value.

Note: If you are still unable to connect, locate the workgroup information file (System.MDW) applicable to
your user profile, and set the value of the Jet OLEDB: System database property to the path of the
System.MDW file.

8.10.10 Microsoft SQL Server (ADO)

This example illustrates how to connect to a SQL Server database through ADO. These instructions are
applicable when you use the recommended Microsoft OLE DB Driver for SQL Server (MSOLEDBSQL),
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which is available for download at https://docs.microsoft.com/en-us/sql/connect/oledb/download-oledb-driver-for-
sql-server?view=sql-server-ver15. 

Before following these instructions, make sure that you have downloaded and installed the provider above
on your workstation. The ADO provider must match the platform of DiffDog (32-bit or 64-bit).

If you would like to use other ADO providers such as SQL Server Native Client (SQLNCLI) or Microsoft OLE
DB Provider for SQL Server (SQLOLEDB), the instructions are similar, but these providers are deprecated
and thus not recommended. Also, for the connection to be successful with a deprecated provider, you may
need to set additional connection properties as described in Setting up the SQL Server Data Link Properties
.

The Microsoft OLE DB Provider for SQL Server (SQLOLEDB) is known to have issues with parameter
binding of complex queries like Common Table Expressions (CTE) and nested SELECT statements.

To connect to SQL Server:

1. Start the database connection wizard .
2. Select Microsoft SQL Server (ADO), and then click Next. The list of available ADO providers is

displayed. In this example, the Microsoft OLE DB Driver for SQL Server is used. If it's not in the list,
make sure that it is installed on your computer, as mentioned above.

3. Click Next. The Data Link Properties dialog box appears.
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4. Select or enter the name of the database server, for example, SQLSERV01. If you are connecting to a
named SQL Server instance, the server name looks like SQLSERV01\SOMEINSTANCE.

5. If the database server was configured to allow connections from users authenticated on the Windows
domain, select Windows Authentication. Otherwise, select SQL Server Authentication, clear the
Blank password check box, and enter the database credentials in the relevant boxes.

6. Select the Allow saving password check box and the database to which you are connecting (in this
example, "Nanonull").
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7. To test the connection at this time, click Test Connection. This is an optional, recommended step.
8. Click OK.

8.10.11 Microsoft SQL Server (ODBC)

This example illustrates how to connect to a SQL Server database through ODBC.

Prerequisites:

· Download and install the Microsoft ODBC Driver for SQL Server from the Microsoft website, see
https://docs.microsoft.com/en-us/SQL/connect/odbc/download-odbc-driver-for-sql-server. This example
uses Microsoft ODBC Driver 17 for SQL Server to connect to a SQL Server 2016 database. You
might want to download a different ODBC driver version, depending on the version of SQL Server where
you want to connect. For information about ODBC driver versions supported by your SQL Server
database, refer to the driver's system requirements.

https://docs.microsoft.com/en-us/SQL/connect/odbc/download-odbc-driver-for-sql-server
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To connect to SQL Server using ODBC:

1. Start the database connection wizard .
2. Click ODBC Connections.

3. Select User DSN (or System DSN, if you have administrative privileges), and then click Add  .
4. Select the driver from the list. Note that the driver appears in the list only after it has been installed.

5. Click User DSN (or System DSN if you are creating a System DSN).

Creating a System DSN requires that DiffDog be run as an administrator. Therefore, in order to
create a System DSN, cancel the wizard, make sure that you run DiffDog as an administrator, and
perform the steps above again.

6. Enter a name and, optionally, a description to identify this connection, and then select from the list the
SQL Server to which you are connecting (SQLSERV01 in this example).
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7. If the database server was configured to allow connections from users authenticated on the Windows
domain, select With Integrated Windows authentication. Otherwise, select one of the other
options, as applicable. This example uses With SQL Server authentication... , which requires that
the user name and password be entered in the relevant boxes.
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8. Optionally, select the Change the default database to check box and enter the name of the
database to which you are connecting (in this example, Sandbox).
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9. Click Next and, optionally, configure additional parameters for this connection.



216 Connecting to a Data Source Database Connection Examples

© 2016-2022 Altova GmbHAltova DiffDog 2023 Enterprise Edition

10. Click Finish. A confirmation dialog box listing the connection details opens.
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11. Click OK. The data source now appears in the list of User or System data sources, as configured, for
example:

8.10.12 MySQL (ODBC)

This example illustrates how to connect to a MySQL database server from a Windows machine through the
ODBC driver. The MySQL ODBC driver is not available on Windows, so it must be downloaded and installed
separately. This example uses MySQL Connector/ODBC 8.0.
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Prerequisites:

· MySQL ODBC driver must be installed on your operating system. Check the MySQL documentation
for the driver version recommended for your database server version (see
https://dev.mysql.com/downloads/connector/odbc/).

· You have the following database connection details: host, database, port, username, and password.

If you installed MySQL Connector/ODBC for 64-bit platform, make sure to install DiffDog for 64-bit platform
as well.

To connect to MySQL via ODBC:

1. Start the database connection wizard . 
2. Select MySQL (ODBC), and then click Next. 

3. Select Create a new Data Source Name (DSN) with the driver, and select a MySQL driver. If no
MySQL driver is available in the list, click Edit Drivers, and select any available MySQL drivers (the
list contains all ODBC drivers installed on your operating system).

If you installed DiffDog 64-bit, then the 64-bit ODBC drivers are shown in the list. Otherwise, the
32-bit ODBC drivers are shown. See also Viewing the Available ODBC Drivers .

4. Click Connect.
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5. In the Data Source Name box, enter a descriptive name that will help you identify this ODBC data
source in future.

6. Fill in the database connection credentials (TCP/IP Server, User, Password), select a database, and
then click OK.

Note: If the database server is remote, it must be configured by the server administrator to accept remote
connections from your machine's IP address. Also, if you click Details>>, there are several additional
parameters available for configuration. Check the driver's documentation before changing their default
values.

8.10.13 Oracle (JDBC)

This example shows you how to connect to an Oracle database server from a client machine, using the JDBC
interface. The connection is created as a pure Java connection, using the Oracle Instant Client Package
(Basic) available from the Oracle website. The advantage of this connection type is that it requires only the Java
environment and the .jar libraries supplied by the Oracle Instant Client Package, saving you the effort to install
and configure a more complex database client.

Prerequisites:

· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either
Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
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may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK.
· The Oracle Instant Client Package (Basic) must be available on your operating system. The

package can be downloaded from the official Oracle website. This example uses Oracle Instant Client
Package version 12.1.0.2.0, for Windows 32-bit and, consequently, Oracle JDK 32-bit.

· You have the following database connection details: host, port, service name, username, and
password.

To connect to Oracle through the Instant Client Package:

1. Start the database connection wizard . 
2. Click JDBC Connections.
3. Next to "Classpaths", enter the path to the .jar file which provides connectivity to the database. If

necessary, you can also enter a semicolon-separated list of .jar file paths. In this example, the
required .jar file is located at the following path: C:\jdbc\instantclient_12_1\ojdbc7.jar. Note that you
can leave the "Classpaths" text box empty if you have added the .jar file path(s) to the CLASSPATH
environment variable of the operating system (see also Configuring the CLASSPATH ).

4. In the "Driver" box, select either oracle.jdbc.OracleDriver or oracle.jdbc.driver.OracleDriver. Note
that these entries are available if a valid .jar file path is found either in the "Classpaths" text box, or in
the operating system's CLASSPATH environment variable (see the previous step).

5. Enter the username and password to the database in the corresponding text boxes.

6. Enter the connection string to the database server in the Database URL text box, by replacing the
highlighted values with the ones applicable to your database server.
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jdbc:oracle:thin:@//host:port:service

7. Click Connect.

8.10.14 Oracle (ODBC)

This example illustrates a common scenario where you connect from DiffDog to an Oracle database server on a
network machine, through an Oracle database client installed on the local operating system.

The example includes instructions for setting up an ODBC data source (DSN) using the database connection
wizard in DiffDog. If you have already created a DSN, or if you prefer to create it directly from the ODBC Data
Source administrator in Windows, you can do so, and then select it when prompted by the wizard. For more
information about ODBC data sources, see Setting up an ODBC Connection . 

Prerequisites:

· The Oracle database client (which includes the ODBC Oracle driver) must be installed and configured
on your operating system. For instructions on how to install and configure an Oracle database client,
refer to the documentation supplied with your Oracle software.

· The tnsnames.ora file located in Oracle home directory contains an entry that describes the database
connection parameters, in a format similar to this:

ORCL =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = server01)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SID = orcl)
      (SERVER = DEDICATED)
    )
  )

The path to the tnsnames.ora file depends on the location where Oracle home directory was installed.
For Oracle database client 11.2.0, the default Oracle home directory path could be as follows:

C:\app\username\product\11.2.0\client_1\network\admin\tnsnames.ora

You can add new entries to the tnsnames.ora file either by pasting the connection details and saving
the file, or by running the Oracle Net Configuration Assistant wizard (if available). If you want these
values to appear in dropdown lists during the configuration process, then you may need to add the path
to the admin folder as a TNS_ADMIN environment variable.

To connect to Oracle using ODBC:

1. Start the database connection wizard . 
2. Select Oracle (ODBC / JDBC), and then click Next. 
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3. Select ODBC.

4. Click Edit Drivers.
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5. Select the Oracle drivers you wish to use (in this example, Oracle in OraClient11g_home1). The list
displays the Oracle drivers available on your system after installation of Oracle client.

6. Click Back.
7. Select Create a new data source name (DSN) with the driver, and then select the Oracle driver

chosen in step 4.
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Avoid using the Microsoft-supplied driver called Microsoft ODBC for Oracle driver. Microsoft
recommends using the ODBC driver provided by Oracle (see http://msdn.microsoft.com/en-
us/library/ms714756%28v=vs.85%29.aspx)

8. Click Connect.

http://msdn.microsoft.com/en-us/library/ms714756%28v=vs.85%29.aspx
http://msdn.microsoft.com/en-us/library/ms714756%28v=vs.85%29.aspx
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9. In the Data Source Name text box, enter a name to identify the data source (in this example, Oracle
DSN 1). 

10. In the TNS Service Name box, enter the connection name as it is defined in the tnsnames.ora file (see
prerequisites ). In this example, the connection name is ORCL. Note: If you wish to have the
dropdown list of the combo box populated with the values of the tnsnames.ora file, then you may need
to add the path to the admin folder as a TNS_ADMIN environment variable.

11. Click OK.

12. Enter the username and password to the database, and then click OK.

8.10.15 PostgreSQL (ODBC)

This example illustrates how to connect to a PostgreSQL database server from a Windows machine through
the ODBC driver. The PostgreSQL ODBC driver is not available on Windows, so it must be downloaded and
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installed separately. This example uses the psqlODBC driver (version 11.0) downloaded from the official website
(see also Database Drivers Overview ).

Note: You can also connect to a PostgreSQL database server directly (without the ODBC driver), see Setting
up a PostgreSQL Connection .

Prerequisites:

· psqlODBC driver must be installed on your operating system.
· You have the following database connection details: server, port, database, user name, and password.

To set up a connection to PostgreSQL using ODBC:

1. Start the database connection wizard . 
2. Click ODBC Connections.
3. Select the User DSN option.

4. Click Create a new DSN   and select the driver from the drop-down list. If no PostgreSQL driver is
available in the list, make sure that the PostgreSQL ODBC driver is installed on your operating system,
as mentioned in the prerequisites above.

5. Click User DSN.
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6. Fill in the database connection credentials (these must be supplied by the database owner), and then
click Save. 

The connection is now available in the list of ODBC connections. To connect to the database, you can either
double-click the connection or select it, and then click Connect.
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8.10.16 Progress OpenEdge (JDBC)

This example illustrates how to connect to a Progress OpenEdge 11.6 database server through JDBC. 

Prerequisites

· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either
Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK.
· The operating system's PATH environment variable must include the path to the bin directory of the

JRE or JDK installation directory, for example C:\Program Files (x86)\Java\jre1.8.0_51\bin.
· The Progress OpenEdge JDBC driver must be available on your operating system. In this example,

JDBC connectivity is provided by the openedge.jar and pool.jar driver component files available in C:
\Progress\OpenEdge\java as part of the OpenEdge SDK installation.

· You have the following database connection details: host, port, database name, username, and
password.

Connecting to OpenEdge through JDBC

1. Start the database connection wizard . 
2. Click JDBC Connections.
3. Next to "Classpaths", enter the path to the .jar file which provides connectivity to the database. If

necessary, you can also enter a semicolon-separated list of .jar file paths. In this example, the
required .jar file paths are: C:\Progress\OpenEdge\java\openedge.jar;C:

\Progress\OpenEdge\java\pool.jar;. Note that you can leave the "Classpaths" text box empty if

you have added the .jar file path(s) to the CLASSPATH environment variable of the operating system
(see also Configuring the CLASSPATH ). 

4. In the "Driver" box, select com.ddtek.jdbc.openedge.OpenEdgeDriver. Note that this entry is
available if a valid .jar file path is found either in the "Classpaths" text box, or in the operating system's
CLASSPATH environment variable (see the previous step).
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5. Enter the username and password to the database in the corresponding text boxes.
6. Enter the connection string to the database server in the Database URL text box, by replacing the

highlighted values with the ones applicable to your database server.

jdbc:datadirect:openedge://host:port;databaseName=db_name

7. Click Connect.

8.10.17 Progress OpenEdge (ODBC)

This example illustrates how to connect to a Progress OpenEdge database server through the Progress
OpenEdge 11.6 ODBC driver.

Prerequisites:

· The ODBC Connector for Progress OpenEdge driver must be installed on your operating system. The
Progress OpenEdge ODBC driver can be downloaded from the vendor's website (see also Database
Drivers Overview ). Make sure to download the 32-bit driver when running the 32-bit version of
DiffDog, and the 64-bit driver when running the 64-bit version. After installation, check if the ODBC
driver is available on your machine (see also Viewing the Available ODBC Drivers ).
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· You have the following database connection details: host name, port number, database name, user ID,
and password.

Connecting to Progress OpenEdge through ODBC

1. Start the database connection wizard . 
2. Click ODBC Connections.
3. Click User DSN (alternatively, click System DSN, or File DSN, in which case the subsequent

instructions will be similar).

4. Click Add  .
5. Select the Progress OpenEdge Driver from the list, and click User DSN (or System DSN, if

applicable).
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6. Fill in the database connection credentials (Database, Server, Port, User Name, Password), and then
click OK. To verify connectivity before saving the entered data, click Test Connect.

7. Click OK. The new data source now appears in the list of ODBC data sources.
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8. Click Connect.

8.10.18 Sybase (JDBC)

This example illustrates how to connect to a Sybase database server through JDBC. 

Prerequisites:

· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either
Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK.
· Sybase jConnect component must be installed on your operating system (in this example, jConnect

7.0 is used, installed as part of the Sybase Adaptive Server Enterprise PC Client installation). For the
installation instructions of the database client, refer to Sybase documentation.

· You have the following database connection details: host, port, database name, username, and
password.
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To connect to Sybase through JDBC:

1. Start the database connection wizard . 
2. Click JDBC Connections.
3. Next to "Classpaths", enter the path to the .jar file which provides connectivity to the database. If

necessary, you can also enter a semicolon-separated list of .jar file paths. In this example, the
required .jar file path is: C:\sybase\jConnect-7_0\classes\jconn4.jar. Note that you can leave the
"Classpaths" text box empty if you have added the .jar file path(s) to the CLASSPATH environment
variable of the operating system (see also Configuring the CLASSPATH ). 

4. In the "Driver" box, select com.sybase.jdbc4.jdbc.SybDriver. Note that this entry is available if a
valid .jar file path is found either in the "Classpaths" text box, or in the operating system's
CLASSPATH environment variable (see the previous step).

5. Enter the username and password to the database in the corresponding text boxes.
6. Enter the connection string to the database server in the Database URL text box, by replacing the

highlighted values with the ones applicable to your database server.

jdbc:sybase:Tds:hostName:port/databaseName

7. Click Connect.

154

178



234 Connecting to a Data Source Database Connection Examples

© 2016-2022 Altova GmbHAltova DiffDog 2023 Enterprise Edition

8.10.19 Teradata (JDBC)

This example illustrates how to connect to a Teradata database server through JDBC. 

Prerequisites:

· JRE (Java Runtime Environment) or Java Development Kit (JDK) must be installed. This may be either
Oracle JDK or an open source build such as Oracle OpenJDK. DiffDog will determine the path to the
Java Virtual Machine (JVM) from the following locations, in this order: a) The custom JVM path you
may have set in application Options, see Java Settings ; b) The JVM path found in the Windows
registry; c) The JAVA_HOME environment variable.

· Make sure that the platform of DiffDog (32-bit, 64-bit) matches that of the JRE/JDK.
· The JDBC driver (one or more .jar files that provide connectivity to the database) must be available on

your operating system. In this example, Teradata JDBC Driver 16.20.00.02 is used. For more
information, see https://downloads.teradata.com/download/connectivity/jdbc-driver.

· You have the following database connection details: host, database, port, username, and password.

To connect to Teradata through JDBC:

1. Start the database connection wizard . 
2. Click JDBC Connections.
3. Next to "Classpaths", enter the path to the .jar file which provides connectivity to the database. If

necessary, you can also enter a semicolon-separated list of .jar file paths. In this example, the .jar files
are located at the following path: C:\jdbc\teradata\. Note that you can leave the "Classpaths" text box
empty if you have added the .jar file path(s) to the CLASSPATH environment variable of the operating
system (see also Configuring the CLASSPATH ). 

4. In the "Driver" box, select com.teradata.jdbc.TeraDriver. Note that this entry is available if a valid .jar
file path is found either in the "Classpath" text box, or in the operating system's CLASSPATH
environment variable (see the previous step).
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5. Enter the username and password to the database in the corresponding text boxes.
6. Enter the connection string to the database server in the Database URL text box, by replacing the

highlighted value with the one applicable to your database server.

jdbc:teradata://databaseServerName

7. Click Connect.
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8.10.20 Teradata (ODBC)

This example illustrates how to connect to a Teradata database server through ODBC. 

Prerequisites:

· The Teradata ODBC driver must be installed (see
https://downloads.teradata.com/download/connectivity/odbc-driver/windows. This example uses
Teradata ODBC Driver for Windows version 16.20.00.

· You have the following database connection details: host, username, and password.

To connect to Teradata through ODBC:

1. Press the Windows key, start typing "ODBC", and select Set up ODBC data sources (32-bit) from
the list of suggestions. If you have a 64-bit ODBC driver, select Set up ODBC data sources (64-bit)
and use 64-bit DiffDog in the subsequent steps.

2. Click the System DSN tab, and then click Add.

https://downloads.teradata.com/download/connectivity/odbc-driver/windows
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3. Select Teradata Database ODBC Driver and click Finish.



238 Connecting to a Data Source Database Connection Examples

© 2016-2022 Altova GmbHAltova DiffDog 2023 Enterprise Edition

4. Enter name and, optionally, a description that will help you identify this ODBC data source in future.
Also, enter the database connection credentials (Database server, User, Password), and, optionally,
select a database.

5. Click OK. The data source now appears in the list. 
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6. Run DiffDog and start the database connection wizard . 
7. Click ODBC Connections. 
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8. Click System DSN, select the data source created previously, and then click Connect.

Note: If you get the following error: "The driver returned invalid (or failed to return) SQL_DRIVER_ODBC_VER:

03.80", make sure that the path to the ODBC client (for example, C:\Program
Files\Teradata\Client\16.10\bin, if you installed it to this location) exists in your system's PATH

environment variable. If this path is missing, add it manually.
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9 Navigating Differences

When the results of a comparison are first displayed in File Comparisons, Word Comparisons, and Directory
Comparisons, it is always the first difference that is the current difference. In Database Data Comparisons and
Database Schema Comparisons as well as in XML Schema Comparisons, no difference is selected when the
result window is first displayed. You can navigate through the differences by selecting other differences to be
the current difference or move the selection of the current difference by using the following navigation
commands in the Diff and Merge menu and toolbar:

·  Next Difference (Alt+Down): Selects the next difference as the current difference.

·  Previous Difference (Alt+Up): Selects the previous difference as the current difference.

·  Last Difference (Alt+End): Selects the last difference in the document as the current difference.

·  First Difference (Alt+Home): Selects the first difference in the document as the current
difference.

·  Display Current Difference (Ctrl+Enter): Scrolls through the document to display the current
difference. This command is useful if you have scrolled to some point that causes the current difference
to be outside the display area (document pane).

·  Make Current Difference (Alt+Enter): Makes the selected difference the current difference, and
sets it as the difference from which to navigate. The Make Current Difference command is useful if
you wish to jump directly to a particular difference and navigate from there. In Database Data
Comparisons and Database Schema Comparisons, clicking a difference will always make it the current
difference, this command is therefore not available in Database Schema Comparison windows.

If the icons described above are not displayed in your toolbar, you can include them by checking the Diff and
Merge option in the Toolbars tab  of the Customize dialog box.

Note: The navigation commands move the selection of the current difference in both documents/tables. If you
wish to edit  highlighted text, you must place the cursor in the highlighted text (in the appropriate
document).

Current difference and editing

If, in a File Comparison window, you start typing into the document and the Compare While Editing  
toggle in the Diff and Merge menu is off, all difference highlighting disappears in both documents. If the
Compare While Editing toggle is on, then if you type in something that results in a difference it is highlighted
as the current difference; if you make a modification that removes a difference, the difference immediately
following the cursor position is highlighted as the current difference.

To make a difference the current difference:

1. Place the cursor in the required difference (which could be anywhere in the document) or navigate to it

using the Next Difference  or Previous Difference  navigation commands listed above.
2. If applicable, select the menu option Diff and Merge | Make Current Difference or press Alt+Enter

or select the corresponding toolbar icon  from the Diff and Merge toolbar.
Note that, in Database Data Comparison Result windows, every difference that you select automatically
becomes the current difference.
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10 Merging Differences

After running a file , directory , Microsoft Word document , database data , or database schema
comparison in a comparison window, you can merge differences that exist between the
directories/files/Microsoft Word documents/tables in the two panes or components, respectively.

In File Comparison windows and Word Comparison windows,a difference (that is, a text fragment for
which there is no, or no identical, corresponding text fragment in the compared file) can be copied over from
one file to the corresponding location in the other file. Note that in Microsoft Word document comparisons both
text and formatting will be copied from the source to the target file.

In Directory Comparison windows, the selected non-equal file (a file for which no, or no equal, corresponding
file exists in the compared directory) can be copied from one directory to the other directory.

In Database Data Comparison windows, data of (i) the selected table(s) or (ii) all tables can be copied from
one component to the other component. In Database Data Comparison Result windows, non-equal data of
the selected rows can be copied from one table to the other table. In both windows, a warning message
providing details of the changes is displayed and has to be confirmed before the changes are committed to the
database. The necessary database structure change scripts are generated and executed in the background.

In Database Schema Comparison windows, the structure of (i) the selected item(s) or (ii) all items can be
copied from one component to the other component. Please note that the merge is not executed immediately;
DiffDog  always shows the database structure change script first and provides the options to save it to a file or
display it in DatabaseSpy (if installed).

You use the following commands to merge a difference:

 Copy from Left to Right (Alt+Right)

· For the selected difference in a file comparison or Microsoft Word comparison, copies text from the
document in the left pane to the document in the right pane.

· For the selected non-equal file in a directory comparison, copies the file from the (directory in the) left
pane to the (directory in the) right pane.

· For the selected table in a database data comparison, copies the table's data from the (table in the) left
component to the (table in the) right component.

· For the selected non-equal row in a database data comparison result, copies the data from the row in
the left column to the row in the right column.

· For the selected non-equal item in a database schema comparison, opens the Merge Schema Left to
Right dialog box, where the resulting change script is displayed. In this dialog box you can choose to
execute the SQL, save it to a file, or show it in DatabaseSpy (if installed).

 Copy from Right to Left (Alt+Left)

· For the selected difference in a file comparison or Microsoft Word comparison, copies text from the
document in the right pane to the document in the left pane.

· For the selected non-equal file in a directory comparison, copies the file from the (directory in the) right
pane to the (directory in the) left pane.

· For the selected table in a database data comparison, copies the table's data from the (table in the)
right component to the (table in the) left component.
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· For the selected non-equal row in a database data comparison result, copies the data from the row in
the right column to the row in the left column.

· For the selected non-equal item in a database schema comparison, opens the Merge Schema Right to
Left dialog box, where the resulting change script is displayed. In this dialog box you can choose to
execute the SQL, save it to a file, or show it in DatabaseSpy (if installed).

In file and Microsoft Word comparisons, the source difference is copied in its entirety (i.e., the entire unit
highlighted in the current difference background color overwrites the entire difference in the target document).
Merged differences in file and Microsoft Word document comparisons can be shown in a different background
color. This setting is made in the File Comparison tab  of the DiffDog Options dialog box.

To merge a difference in file, Microsoft Word, and directory comparisons:

1. Place the cursor in the required difference (which could be anywhere in the document) or navigate to it

using the Next Difference  or Previous Difference  navigation commands listed above.
2. If applicable, select the menu option Diff and Merge | Make Current Difference or press Alt+Enter

or select the corresponding toolbar icon  from the Diff and Merge toolbar.

3. Do one of the following:

· Select the menu option Diff and Merge | Copy from Left to Right or click the corresponding

toolbar icon  or press Alt+Right if you want to copy from the left pane to the right pane.

· Select the menu option Diff and Merge | Copy from Right to Left or click the corresponding

toolbar icon  or press Alt+Left to copy from the right pane to the left pane.

To merge database data:

· To merge every difference in all tables of a database comparison, select the menu option Diff and
Merge | Copy from Left to Right (Alt+Right) or Copy from Right to Left (Alt+Left), respectively.

· To merge every difference in selected tables of a database comparison, select one or several tables in
the left or right component and choose the menu option Diff and Merge | Copy from Left to Right
(Alt+Right) or Copy from Right to Left (Alt+Left), respectively. Alternatively, right-click the desired
tables and choose Merge selected Left to Right or Merge selected Right to Left, respectively, from
the context menu.

An information box with an overview appears. Optionally, click the Show Details button, and click Yes to
confirm the merge.

· To merge selected differences in a result window of a database comparison:

1. Select a table in the left or right component and choose the menu option Diff and Merge | Show
results or right-click a table and choose Show selected results from the context menu.

Alternatively, click the comparison result  icon.
2. In the Database Data Comparison Result window, place the cursor in the required difference (which

could be anywhere in the document) or navigate to it using the Next Difference  or Previous

Difference  navigation commands listed above.
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3. Select the menu option Diff and Merge | Copy from Left to Right (Alt+Right) or Copy from
Right to Left (Alt+Left), respectively).

4. In the Merge data (x to y) dialog box that appears, choose either the Merge the selected rows and
cells or the Merge the whole table radio button.

5. Click Yes to confirm the merge.

To merge database schemas:

1. Place the cursor in the required difference and do the following:
· Select the menu option Diff and Merge | Copy from Left to Right or click the corresponding

toolbar icon  or press Alt+Right if you want to copy from the left pane to the right pane.
· Select the menu option Diff and Merge | Copy from Right to Left or click the corresponding

toolbar icon  or press Alt+Left to copy from the right pane to the left pane.

The Merge Schema Left|Right to Right|Left dialog box appears and shows the SQL that will change the
schema in the database.

2. Chose one of the following options:

· Click Execute to commit the changes to the database.
· Click Save SQL to File to save the script to a file for later execution.
· If you have DatabaseSpy installed, click Show SQL in DatabaseSpy to display the SQL in

DatabaseSpy's SQL Editor where you can check, edit, and execute the script.
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11 Exporting Differences

For file and directory comparisons, the differences can be exported to file. Differences can be exported either in

XML  or in text  format; the available format depends on the comparison mode , according to the
following table:

File comparison n.a. n.a.

Directory comparison

To export differences to file:

1. Run a file or directory comparison.
2. On the File menu, click Export differences.
3. Enter a destination file name, select the desired format (XML or text), and click Save.

If you are comparing files using the XML comparison  mode, note that a certain combination of options
causes the Export Differences command to be disabled (grayed out). To enable the command, do the
following:

1. On the Tools menu, click Comparison Options.
2. Click the XML tab.
3. Select the Detailed differencing check box.
4. Clear the Ignore node depth check box.
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12 Saving and Loading Comparisons

The settings selected for a file or directory comparison can be saved in a .filedif or .dirdif file, respectively. The
.filedif extension is used for file and MS Word comparisons. The .dirdif contains Word options only if saved from
the Enterprise edition. When a .filedif or .dirdif file is opened with DiffDog, the GUI loads the two objects to be
compared using the settings saved in the .filedif or .dirdif file. This feature is useful if you wish to repeat a
comparison of two files or two folders at a later time with the same settings as the current settings for that
comparison.

Saving .filedif and .dirdif files
To save the settings of the comparison, select the command File | Save As. Select the appropriate filetype
(.filedif or .dirdif), enter the filename you want and click Save. The file is saved to the specified location. DiffDog
will be the default editor of these file extensions; this will have been set by the installer at the time of
installation.

Opening .filedif and .dirdif files
To open a comparison file (.filedif or .dirdif), select the command File | Open Comparison File, browse for the
comparison file, and click Open. You can also drag-and-drop the file from Windows Explorer into DiffDog. Full
URL support (that is, local, http, and ftp) is available.

A .dirdif file can be opened in any edition, irrespective of which edition the file was saved from. (MS Word
options can only be saved in the Enterprise edition.) If you are using a Professional Edition and the .dirdif file
contains Word options (which are not supported in the Professional edition), then an error message appears on
opening the file.

Command line support
You can also use the command line  to open one comparison file at a time, for example:

DiffDog.exe C:\test1.filedif 
DiffDog.exe C:\test*.filedif 
DiffDog.exe C:\test.*dif 

The asterisk ( * ) wildcard is allowed when opening .filedif or .dirdif files.

Running Comparisons with DiffDog Server
If you have licensed DiffDog Server, you can run .filedif or .dirdif comparisons at the command line with DiffDog
Server. To do this, supply the .filedif or .dirdif file path as argument to the import command. 

Running *.filedif and *.dirdif files with DiffDog Server is supported only on Windows. For the comparison to
be successful, all the file or directory paths that were valid on the desktop machine must be valid on the
server machine. If you set up the comparison jobs directly in DiffDog Server (as opposed to using *.filedif or
*.dirdif files), you can run them regardless of the platform.

If you need to redirect the comparison output to a file in XML or text format, take the following steps:

1. Open an existing .dirdif or .filedif file (or create a new comparison) in DiffDog.
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2. On the Tools menu, click Comparison Document Options.
3. Do one of the following:

a. To use no redirection to a file, click No Export (this is the default option).
b. To redirect the report to a text file, click Text file, and then enter the path in the adjacent text

box. 
c. To redirect the report to an XML file, click XML file, and then enter the path in the adjacent text

box. 
4. On the File menu, click Save As, and then save the comparison as .filedif (or .dirdif, if applicable).

For more information, refer to DiffDog Server documentation (https://www.altova.com/documentation).

https://www.altova.com/documentation
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13 Comparison Management Options

The Diff and Merge menu includes a series of commands that are used to customize the file, directory,
Microsoft Word document, and database comparisons and can be summed up as comparison management
options. Apart from the option to explicitly start a comparison (see below), options to automate certain
comparison functions  as well as to facilitate the selection of recently compared pairs  are available.

Starting a comparison
The Start Comparison command in the Diff and Merge menu applies to File Comparison as well as Directory
Comparison, XML Schema Comparison, Word Comparison, and Database Comparison windows and is used to
explicitly start a comparison at any time. Please note that a comparison starts automatically and this
command is thus not needed if the Autostart Comparison  or Compare while Editing  comparison
management options are toggled on.

To explicitly start a comparison:

· Select the menu option Diff and Merge | Start Comparison or press F5. Alternatively, you can also

click the corresponding toolbar button  in the Diff and Merge toolbar or right-click the tab of a
comparison window and select the Start Comparison command from the context menu that appears.
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13.1 Automatic Comparison Functions

DiffDog provides options that automatically start a comparison when files are loaded or edited. In addition, you
can display the comparison options each time before a comparison is actually started. Note that all of these
options are toggle commands.

Autostart Comparison
If the Autostart Comparison option is toggled on, then a comparison is automatically made when files or
directories are loaded into a comparison window. If this option is toggled off, then a comparison (file or
directory) must be explicitly started .

To autostart comparisons:

· Activate the menu option Diff and Merge | Autostart Comparison or activate the corresponding

toolbar icon  in the Diff and Merge toolbar.

Compare while Editing
A toggle to compare or not compare documents in File Comparison windows while editing. If toggled on,
differences are highlighted as you edit. If toggled off, highlighting of differences is turned off in both documents
as soon as you start typing in either document; to highlight differences after editing, you must run a
comparison .

To compare files while editing:

· Activate the menu option Diff and Merge | Compare while Editing or activate the corresponding

toolbar icon  in the Diff and Merge toolbar.

Show Options Before Comparison
This command is toggled either on or off for individual comparison windows. When toggled on for a comparison
window, the Comparison Options dialog box is displayed each time a comparison is made in that window. Note
that the Comparison Options dialog box is not displayed before comparisons made dynamically by DiffDog
while you edit a document.

To show the options before comparison:

· Activate the menu option Diff and Merge | Show Options Before Comparison or activate the

corresponding toolbar icon  in the Diff and Merge toolbar.
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13.2 Recently Compared Pairs

The menu item Diff and Merge | Support Recently Compared Pairs lets you enable or disable the "recently
compared pairs" feature. More specifically, if this option is on, a history of the most recently compared files or
directories is kept whenever you compare a pair of files or directories. You can select any recently compared
file or directory from the drop-down list at the top of the comparison window, for example:

Selecting an item from the list above causes the "Recently Compared Pairs" dialog box to appear. This dialog
box lists all the files (or directories, if applicable) with which the selected entry was compared recently, for
example:

To compare the file or directory with any of the recently compared items, select the corresponding item, and
click OK.

Note: Clicking Cancel causes the selected file or directory to open in one pane without opening any
previously compared file or directory in the other pane. Clicking Cancel does not stop the selected file
or directory from being opened. If you do not wish to have the "Recently Compared Pairs" dialog box
appear each time you open a document, then toggle the Support Recently Compared Pairs option
off.
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13.3 Auto-Mapping XML Schemas

If the Automap on Load XML Schema toggle is activated in the Diff and Merge menu, DiffDog performs an
automatic mapping of the XML Schemas in the comparison components when the documents are loaded into
the XML Schema Comparison window.
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14 DiffDog Options

The Tools | DiffDog Options command enables you to define global application settings. These settings are
specified in a dialog box and saved in the registry. They apply to all current and future document windows. The
Apply button in the DiffDog Options dialog box displays the changes in the currently open documents and fixes
the current settings. The changes are seen immediately in the background windows.

Each page of the DiffDog Options dialog box is described in detail in this section.

To change DiffDog settings:

1. Select Tools | DiffDog Options... or select the DiffDog Options  button in the Diff and Merge
toolbar.
The DiffDog Options dialog box appears.

2. Select the tabs for the following options:

· Application
· File Comparison
· Directory Comparison
· Database Comparison
· Database Data Result View
· File Types
· Network Proxy Settings
· Java Settings

3. Make the desired changes and click OK.
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14.1 Application

In the Application tab of the DiffDog Options dialog box, you define the startup options of the application.

Startup
Three radio buttons are available to define whether DiffDog starts up with an empty File Comparison window, an
empty Directory Comparison window, or no comparison window.

If the Allow multiple instances check box is deactivated, starting DiffDog when an instance of DiffDog is
already running causes a new comparison window (file, directory, or empty) to open in the already running
instance of DiffDog.

Windows Explorer Integration
If the Add "Compare with Altova DiffDog" entry to the Windows Explorer context menu check box is
selected, you can start a file or directory comparison directly from Windows Explorer by selecting the
respective files or directories and choosing Compare with Altova DiffDog from the context menu.
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Encoding
You can select the encoding with which to open an XML file or non-XML files, respectively, where the encoding
cannot be detected.

Program logo
The Show on startup option—if checked—displays the splash screen (logo) when DiffDog starts. The Show
on print option is read-only; it prints the program logo when a comparison result is printed.
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14.2 File Comparison

The File comparison tab enables you to set preferences for file comparisons. These options range from
display attributes to file actions, and apply to all open and subsequently opened file comparisons.

Backup files
This option lets you configure whether the original file should be saved if you decide to save a version of it that
you have edited in DiffDog, and, in such cases, how the original file and edited file should be named. The newly
named files are created when you save an edited file. The following options are available.

· No backup: The original file is overwritten by the edited file, and the name of the original file is retained.
· Replace extension with .BAK: If the original file was called abc.xml, changes are written to this file,

and a copy of the original is saved as abc.bak.
· Append .BAK to extension: If the original file was called abc.xml, changes are written to this file, and a

copy of the original is saved as abc.xml.bak.

Tip: The .BAK files can be set to be XML-conformant , and used for comparisons with other XML files.264
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If ZIP-conformant files change, DiffDog creates a backup for the individual files that have changed inside the ZIP
rather than a backup of the ZIP itself.

Automatic reload of changed files
If a file that is open in DiffDog has been changed by another application or another person, DiffDog can reload
the changed file, with or without prompting you to reload.

Editing
You can make a difference in the compared documents the current difference by clicking in it if the Clicking a
difference makes it the current difference check box is activated.

The properties of the display font can be freely chosen. Clicking the Font button opens the Font dialog box for
this purpose.

Colors
You can choose different background colors for highlighting differences in compared documents, including:

· the current difference (that is, the difference that is currently in focus, or selected)
· merged differences (that is, all merged differences that have not been saved as yet)
· the current merged difference (a merged difference that is currently selected)
· any conflict, or the currently selected conflict (this option is applicable only when comparing files 3-

way, see Three-Way Comparisons )

To reset the default colors, click the Default colors button. Note that these colors are also used in Word
comparison windows.

Pretty-Print
The Pretty-Print XML files when loading option automatically creates a more user-friendly display when XML
files that are originally delivered in a continuous stream without line breaks are loaded into File Comparison
windows.
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14.3 Directory Comparison

The Directory comparison tab enables you to create filters  that determine what files will be considered in
directory comparisons.

Note: After exiting this dialog box by clicking OK, you still have to select the required filter in the Directory
Comparison window. Clicking OK does not select the filter for use; it saves the changes and exits the
dialog box.

File/Directory filters
Filters are available for selection in the toolbar of the Directory Comparison window and in the Open
Comparison dialog box if the Compare directories option has been selected.

The File/Directory filters group box contains several buttons for defining, organizing, and deleting the filters:

·  Opens the Edit Filter dialog for the selected filter, where you can change the filter definition.

·  Opens the Edit Filter dialog, where you can create a new filter. When the definition is completed,
the filter is added to the list of available filters below the filter that has been selected when the button
has been clicked.

·  Moves the selected filter one position down in the list of filters.
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·  Moves the selected filter one position up in the list of filters.

·  Creates a copy of the selected filter.

·  Pastes the copy of a filter below the selected filter.

·  Deletes the selected filter.

Default file/directory filters
This group box contains a drop-down list with the available default filters. Select a filter and click Create to
open the Edit Filter dialog box, where you can create a new filter based on the definition of the selected default.
Edit name and filter definition as required and click OK to add a new filter to the list of available filters in the
File/Directory filters group box.

Modification Alerts
If the Enable alerts for modifications inside directories check box is activated, DiffDog displays a warning
message when the content of the displayed folders is changed outside of DiffDog. You can then decide whether
or not you want to update the display.

Quick comparison
In this group box, you can define whether size only, or size and modification date should be considered during
quick comparison. When Size and modification time is selected. you can also activate the Allow time
difference of exactly 1 hour check box. A time difference of exactly one hour may occur shortly after the shift
to, or from, daylight saving time when the system time is changed automatically. Activating the Allow time
difference of exactly 1 hour check box will prevent such files from being displayed as different.

Confirm merge operation
You can define whether or not a warning message should be displayed before files are deleted, copied, or
replaced during directory merge operations.

If you activate the Don't show this dialog again! in this dialog box, the corresponding option is automatically
deactivated in the DiffDog Options dialog box.
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14.3.1 Defining a Filter

The Edit Filter dialog provides several options to restrict the directory comparison:

· Consider only files of a certain type
· Consider only specific directories
· Ignore certain files or directories
· Compare files or directories with certain attributes
· Define a date range for files/directories to be compared
· Restrict files to a certain file size

Note that if a file type is included in both the Include only files and Ignore files field, then that file type is
ignored in a directory comparison.

For Directory Comparison windows that were opened before a new filter is selected, you must reload both
directories so that the new filters are applied to these comparison windows.
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Modification date
In the Modification date group box, you can enter a From and/or a Till date to define a date range for directory
comparison. Only files within that particular date range will be considered when the directories are compared.
To include all files from or until a particular date, select only the corresponding check box (From or Till,
respectively) and leave the second check box unchecked. After you select the From or Till check box, you
can either type or select the part of the date that you want to change.

To define a filter for directory comparison:

1. Do one of the following:

a. Select the menu option Tools | DiffDog Options and click the Directory Comparison tab.

b. Click the Edit Filter  button in the toolbar of a Directory Comparison window. Note that, if a
filter is already selected from the drop-down list, then you will be editing that filter instead of
creating a new one.

2. Click the  button to open the Edit Filter dialog.
3. In the Edit Filter dialog, enter a descriptive name in the Filter name field.
4. To restrict the comparison to certain file types, enter the file extension in the Include only files field.

To exclude file types from comparison, enter the file extension in the Ignore files field. Note that file
types are listed in the form *.ext, and that the delimiter between file types in a filter is the semi-colon

(;).

5. To include or ignore specific sub-folders of a directory during comparison, enter the name of the
folder(s) in the Include only directories field or the Ignore directories field, respectively. You can
also use the wildcard character * to enter only parts of folder names. Note that the delimiter between
individual folder names in a filter is the semi-colon (;).

6. To include files or directories that have certain attributes applied, activate the respective check box(es)
in the File/Directory attributes group box. Files or directories with unchecked attributes will not be
shown in the Directory Comparison window. Note that hidden files in hidden directories will not be
shown if the Hidden check box is activated for files but deactivated for directories.

7. Activate the From and/or Till check boxes in the Modification date group box, if you want to restrict
the comparison to a certain date range.

8. Activate the From and/or Till check boxes in the File size group box, if you want to restrict the
comparison to files of a certain size. Enter a number and select the appropriate unit from the drop-
down list.

9. Click OK to save the changes.
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14.4 Database Comparison

The Database comparison tab defines how compared data and structure in  tables are displayed in the
comparison components and whether tables and/or columns should be mapped automatically when added to a
comparison. Additional settings related to database data comparison are defined on the XML  and Text
tabs of the Comparison Options dialog box.

Display Options
In order to be able to open a Database Comparison window without having to specify data source and tables to
be compared, clear the Show table selection for new documents check box. If you prefer that all tables be
shown with the columns not expanded, clear the Show tables initially expanded check box. You can
deactivate the display of the schema name for tables in components, and show the data source name in the
component header.

Automatic table and column mapping
This group of options is applicable when you perform database data and schema comparisons. By default,
when tables are added to a comparison, they are automatically mapped. To disable automatic mapping of
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tables or columns, clear the Map tables automatically or Map columns automatically check box,
respectively.

If automatic mapping is enabled for columns, you can further specify how DiffDog should create the mapping:

· Find mapping by name: DiffDog checks for matching column names in both tables. By default,
matching is case insensitive (for example, "Expenses" will match to "expenses"). To perform a case
sensitive matching, clear the Ignore case when mapping by name check box.

· Find mapping by type:  DiffDog maps columns that have a different name but share the same data
type. It is recommended to use this option only in small databases, provided that each column of the
same table has a different type; otherwise, unwanted mappings are likely to occur.

· Find mapping by name and type: DiffDog considers first the column name and then its data type
when mapping.

· Find mapping based on column position: Columns will only be mapped if the ordinal position at the
time of table creation is identical in both tables. This way you can compare tables that are equally
designed but use different column names.

In addition, you can specify whether or not binary data columns, XML columns, identity columns, calculated
columns, or the case of a column name should be ignored. If you want to map item names that match to a
large extent but are not exactly equal (e.g. "expenses2008" and "expenses_09"), clear the Exact match when
mapping by name check box.

Schema comparison
If you select the Try to map unconnected items during comparison check box, DiffDog will try to find
corresponding items for unmapped items in the opposite component when a schema (not data) comparison is
started.
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14.5 Database Data Result View

The Database Data Result View tab of the DiffDog Options dialog box provides options for customizing the
display of the comparison results.

Display options
Activate the relevant check boxes if you want to display horizontal or vertical lines, or line numbers in the
Compare Result View. You can also adapt the default gutter width if you want to separate the compared
columns from each other more clearly.
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14.6 File Types

In the File types tab, you can set the default comparison mode of various file types. File types are identified by
their extension (.asp, .biz, etc.), and the comparison mode  can be XML, text, binary, ZIP-conformant, or

Microsoft Word.

File types
This pane is used to select the file extension for which the options in the group boxes Default file
comparison mode and Use syntax coloring are defined. Please note that any changes that you make in
these two group boxes only apply to the file type currently selected in the File Types pane.

Default file comparison mode
To assign a default comparison mode for a particular file type, in the Default file comparison mode group box,
choose one of the following radio buttons:

· XML-conformant file
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An instance of that file type is checked for XML conformance, and is treated as an XML file if it is
conformant. An XML-conformant file may be compared as XML or text.

· Textual comparison
· Binary comparison

An instance of that file type is considered as binary file. A byte-by-byte comparison is used in directory
comparison. Files of this type will not be displayed in text view.

· ZIP-conformant file
An instance of that file type is considered as a sub-directory in directory comparison. In file
comparison, files of this type are compared as binaries.

· Microsoft Word comparison (Enterprise Edition)
An instance of that file is considered as Microsoft Word document and can be compared in a Microsoft
Word comparison.

The comparison mode can be overridden for individual file comparisons by selecting the desired comparison
mode in the Diff and Merge menu. DiffDog detects binary files automatically.

Use syntax coloring
You can choose from among the following options for syntax coloring:

· No syntax coloring
· XML-conformant syntax coloring
· Source code-conformant syntax coloring

Edit file type list
To add a new file type to the list in the File types pane, click the Add New File Extension button. To delete a
file type from the list, select the file extension in the list and then click the Delete Selected File Extension
button.
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14.7 Network Proxy Settings

The Network  Proxy section enables you to configure custom proxy settings. These settings affect how the
application connects to the Internet (for XML validation purposes, for example). By default, the application uses
the system's proxy settings, so you should not need to change the proxy settings in most cases. If necessary,
however, you can set an alternative network proxy by selecting, in the Proxy Configuration combo box, either
Automatic or Manual to configure the settings accordingly.

Note: The network proxy settings are shared among all Altova MissionKit applications. So, if you change the
settings in one application, all MissionKit applications will be affected.

Use system proxy settings
Uses the Internet Explorer (IE) settings configurable via the system proxy settings. It also queries the settings
configured with netsh.exe winhttp.

Automatic proxy configuration
The following options are provided:

· Auto-detect settings: Looks up a WPAD script (http://wpad.LOCALDOMAIN/wpad.dat) via DHCP or

DNS, and uses this script for proxy setup.
· Script URL: Specify an HTTP URL to a proxy-auto-configuration (.pac) script that is to be used for

proxy setup.
· Reload: Resets and reloads the current auto-proxy-configuration. This action requires Windows 8 or

newer, and may need up to 30s to take effect.

Manual proxy configuration
Manually specify the fully qualified host name and port for the proxies of the respective protocols. A supported
scheme may be included in the host name (for example: http://hostname). It is not required that the scheme

is the same as the respective protocol if the proxy supports the scheme.
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The following options are provided:

· HTTP Proxy: Uses the specified host name and port for the HTTP protocol. If Use this proxy server for
all protocols is selected, then the specified HTTP proxy is used for all protocols.

· SSL Proxy: Uses the specified host name and port for the SSL protocol.
· No Proxy for: A semi-colon (;) separated list of fully qualified host names, domain names, or IP

addresses for hosts that should be used without a proxy. IP addresses may not be truncated and IPv6
addresses have to be enclosed by square brackets (for example:
[2606:2800:220:1:248:1893:25c8:1946]). Domain names must start with a leading dot (for

example: .example.com).

· Do not use the proxy server for local addresses: If checked, adds <local> to the No Proxy for list. If

this option is selected, then the following will not use the proxy: (i) 127.0.0.1, (ii) [::1], (iii) all host

names not containing a dot character (.).

Current proxy settings
Provides a verbose log of the proxy detection. It can be refreshed with the Refresh button to the right of the
Test URL field (for example, when changing the test URL, or when the proxy settings have been changed).

· Test URL: A test URL can be used to see which proxy is used for that specific URL. No I/O is done
with this URL. This field must not be empty if proxy-auto-configuration is used (either through Use
system proxy settings or Authomatic proxy configuration).
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14.8 Java Settings

In the Java section (see screenshot below), you can optionally enter the path to a Java VM (Virtual Machine)
on your file system. Note that adding a custom Java VM path is not always necessary. By default, DiffDog
attempts to detect the Java VM path automatically by reading (in this order) the Windows registry and the
JAVA_HOME environment variable. The custom path added in this dialog box will take priority over any other
Java VM path detected automatically.

You may need to add a custom Java VM path, for example, if you are using a Java virtual machine which does
not have an installer and does not create registry entries (e.g., Oracle's OpenJDK). You might also want to set
this path if you need to override, for whatever reason, any Java VM path detected automatically by DiffDog.

Note the following:

· The Java VM path is shared between Altova desktop (not server) applications. Consequently, if you
change it in one application, it will automatically apply to all other Altova applications.

· The path must point to the jvm.dll file from the \bin\server or \bin\client directory, relative to the

directory where the JDK was installed.
· The DiffDog platform (32-bit, 64-bit) must be the same as that of the JDK. 
· After changing the Java VM path, you may need to restart DiffDog for the new settings to take effect.

Changing the Java VM path affects database connectivity via JDBC.
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15 Menu Commands

The User Reference section contains a complete description of all DiffDog menu commands. We've tried to
make this user manual as comprehensive as possible. If, however, you have questions which are not covered in
the User Reference or other parts of this documentation, please look up the FAQs and Discussion Forums on
the Altova website. If you are still not able to have your problem satisfactorily addressed, please do not hesitate
to contact us through the Support Center on the Altova website.

Note that in the File  and Edit  menus, all standard Windows commands are supported, as well as
DiffDog-related commands.
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15.1 Toolbar Icons

Icons in the toolbar are shortcuts for various commands, most of which are also available as menu commands.
You can make any toolbars visible/invisible using the Toolbars tab  of the Customize dialog (Tools |
Customize). To move a toolbar, drag its handle to the desired location. The available toolbars are described
below.

Standard toolbar
The Standard toolbar (see screenshot below) contains file and general editing commands, which can also be
accessed in the File , Edit , and XML  menus.

Comparison toolbars
The Comparison Mode toolbar (see screenshot below) enables you to select a comparison mode for files and
directories. This group of commands is available in the Diff and Merge menu.

The Diff and Merge toolbar (see screenshot below) enables you to start comparisons, navigate through
differences between files, merge differences, and set application and comparison options. All these commands
are available in the Diff and Merge menu and in the Tools menu.

The Directory Content toolbar (see screenshot below) enables you to configure the display of Directory
Comparison windows. Note that—except for the directory synchronization commands, which are included in
the Diff and Merge menu—these commands are available only as toolbar buttons. To find out more about
commands in the Directory Content toolbar, see Configuring the View  and Running a Directory
Comparison .

The Word Comparison toolbar enables you to configure the display of Word Comparison windows. Note that
these commands are available only as toolbar buttons. For more information about commands in the Word
Comparison toolbar, see Configuring the Word Comparison Window .

The Database Data Comparison Mode toolbar (see screenshot below) enables you to select a comparison
mode for database data. These commands are also available in the Diff and Merge menu.
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The Database Data Comparison Result toolbar (see screenshot below) enables you to configure the display
of Database Data Comparison Result windows. For more information about commands in the Database Data
Comparison Result toolbar, see Viewing Differences Between Tables .

The 3-way Comparison toolbar (see screenshot below) enables you to navigate and merge differences in
three-way comparisons .

Text/grid view
The Grid toolbar (see screenshot below) is enabled in Grid View  in File Comparison windows. With the Grid
commands, you can make structural editing changes and modify the Grid View of your XML document. Only
well-formed XML documents can be seen in Grid View mode.

The commands below, which are available only as toolbar buttons, enable you to take the following actions in
Grid View mode:

·  (Expand all selected): Expands one or more selected nodes in Grid View.

·  (Collapse all selected): Collapses the selected nodes.

·  (Fully expand all selected): Expands all selected nodes and their descendant nodes.

·  (Collapse unselected): Collapses all selected nodes and their descendant nodes.

·  (Optimal widths): Sets columns to optimal widths.

The Text toolbar (see screenshot below) enables you to configure the display and navigation features of Text
View . All these commands are available as Text View menu commands .

Icons in the Grid Edit toolbar (see screenshot below) are used for editing in Grid View . For information
about these commands, see Grid View Menu . This toolbar is deactivated by default. If you want to make the
toolbar visible in the interface, select the menu command Tools | Customize and check the box Grid Edit in
the Toolbars  tab.
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15.2 File Menu

The File menu contains all commands relevant to manipulating files, in the order common to most Windows
software products.

In addition to the standard Open , Save , Print , Print Setup , and Exit  commands, DiffDog offers
a range of application-specific commands. Note that in File Comparison and Directory Comparison windows,
each of the two panes also has pane-specific icons located near the top of each pane to open and refresh the
file/directory in that pane and (for file comparisons) to save the file in that pane.

15.2.1 Compare Files

The Compare Files  command opens a new empty window with two empty panes for file comparison. The
two files to be compared must be opened subsequently in the panes of the comparison window. See Running a
File Comparison .
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15.2.2 Compare Files 3-way

The Compare Files 3-Way  command opens a new window containing three comparison panes, see Three-
Way Comparisons .

15.2.3 Compare Directories

The Compare Directories  command opens a new empty window  for directory comparison. The two
directories to be compared must be opened  separately in each pane.

15.2.4 Compare XML Schemas

The Compare XML Schemas  command opens a new empty window  for XML Schema comparison.
The two XML Schemas to be compared must be opened  subsequently in the components of the
comparison window.

15.2.5 Compare MS-Word Files

The Compare MS-Word Files  command opens a new empty window  with two empty Microsoft Word
documents for Microsoft Word file comparison. The two Microsoft Word documents to be compared must be
opened  subsequently in the panes of the comparison window.

15.2.6 Compare Database Data

The Compare Database Data  command opens a new empty window for  database data comparison. The
two databases to be compared must be opened and the tables to be compared must be selected separately in
each component. For more information, see Comparing Database Data .

15.2.7 Compare Database Schemas

The Compare Database Schemas  command opens a new empty window for  database schema
comparison. The two databases to be compared must be opened and the schemas to be compared must be
selected separately in each component. For more information, see Comparing Database Schemas .
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15.2.8 Open

The Open  (Ctrl+O) command enables you to open a File Comparison window or Directory Comparison
window with the files or directories already selected. This is in contrast with the Compare Files  and 
Compare Directories  commands, which open empty comparison windows.

Note that the layout of the dialog box changes depending on whether you choose Compare files or Compare
directories in the Mode group box.

Database data comparison files (*.dbdif) cannot be opened with this command, you have to use the Open
Comparison File...  command.

15.2.9 Open Comparison File

The Open Comparison File command enables you to open a Database Data Comparison window, Database
Schema window, or XML Schema Comparison window with the data sources and tables or XML Schemas,
respectively, already selected. This is in contrast with the Compare Database Data , Compare Database
Schema , or Compare XML Schema  commands, which open an empty Comparison window.

15.2.10 Close

The Close command closes the active comparison window. If you have unsaved changes in either document of
a file comparison being closed, the Save files dialog box appears. Both files in the file comparison are
displayed, as well as the comparison document itself. If a file contains unsaved changes, it is checked.
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15.2.11 Close All

The Close all command closes all open comparison windows. If a document in a file comparison contains
unsaved changes, the Save files dialog box (see screenshot  above) appears for that file comparison.
Directory comparisons are closed without any prompt.

If more than one file comparison contains document/s with unsaved changes, a Save files dialog box is
displayed for each File Comparison window before the window is closed.

15.2.12 Save

The Save  (Ctrl+S) command is available only for file comparisons and database data comparisons. For file
comparisons, it pops up the Save files dialog box, where you can decide whether to save or discard the
changes for each individual file, including the comparison file itself.

Note: Clicking the Save  icon of an individual pane in a File Comparison window causes the document

in that pane to be saved without further prompting. The Save As  icon enables you to save the
document in that pane with a different file name.

15.2.13 Save As

The Save As command pops up the familiar Windows Save As dialog box, in which you enter the name and
location of the file you wish to save the active file as.

15.2.14 Export Differences

The Export differences command allows you to export differences to a file . This menu option is available
only for file and directory comparisons.

15.2.15 Print

The Print  ( Ctrl+P ) command pops up the Windows Print dialog box, in which you enter details about the
print job. Note that this command prints the active document, that is, the document in which the cursor is
when the command is invoked.

Note: You can print the active document from both Text View  and Grid View . The output will be a
printout of the selected view.
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15.2.16 Print Preview

The Print Preview  command displays a preview of how the active document will be printed.

15.2.17 Print Setup

The Print Setup command pops up the Windows Print Setup dialog, in which you can change printer settings
for the print job and other printer properties. Settings include page orientation, paper size, and paper source.
After you exit the Print Setup dialog, you must still use the Print command to print a document.

15.2.18 Exit

This command exits the DiffDog application. If documents in one or more File Comparison windows contain
unsaved changes, DiffDog pops up the Save files dialog box separately for each file comparison containing an
unsaved change. 

If you have not saved a database data comparison to a database data comparison file (*.dbdif) when you close
DiffDog, a message box appears and prompts you to save the Database Data Comparison window.

After you have answered the prompts, DiffDog closes.
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15.3 Edit Menu

In DiffDog, you can edit documents  displayed in a File Comparison window. You edit a document either by
typing directly into it, and/or by using keyboard shortcuts or commands in the Edit menu.

The commands in the Edit menu include standard editing functions, such as Undo , Cut , Copy ,
Paste , and a powerful Find  and Replace  function. These commands are described in the sub-
sections of this section.

Note: Editing commands are document-specific and that Edit menu commands are not available when a
directory comparison or a Database Data Comparison Result window is active.

15.3.1 Undo

The Undo  ( Alt+Backspace, Ctrl+Z ) command enables you to undo an unlimited number of previous
actions for each document separately. To undo previous actions in any document, place the cursor in that
document and select the Undo command. You can switch among documents in multiple open file
comparisons. In each document, the Undos will continue from the point where it was last left.

Please consider the following when using the Undo and Redo  commands:

· The Undo and Redo commands also undo and redo merged differences an unlimited number of times.
· It is important to place the cursor in the document that has been changed. For example, if you merge a

difference from the Left Pane to the Right Pane, then the Undo for this action will only be available if
the cursor is placed in the Right Pane (because this pane contains the document that has been
changed).

· The Undo and Redo history is lost when the view is switched from Text View to Grid View, or vice
versa.

· The Edit menu and the Undo and Redo commands are not available in Directory Comparison and
Database Data Comparison Result windows.
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15.3.2 Redo

The Redo  ( Ctrl+Y ) command reverses a previous Undo  command, and can be executed as many
times as an Undo was performed. Like the Undo command, the Redo command is also document-specific,
and you can switch among documents.

Note that the Edit menu and, therefore, this command are not available in Directory Comparison and Database
Data Comparison Result windows.

15.3.3 Cut

The Cut  ( Shift+Delete, Ctrl+X ) command copies the selected text to the clipboard and deletes it from its
present location.

Note that the Edit menu and, therefore, this command are not available in Directory Comparison and Database
Data Comparison Result windows.

15.3.4 Copy

The Copy  ( Ctrl+C ) command copies the selected text to the clipboard. This can be used to duplicate
data within DiffDog or to move data to another application.

Note that the Edit menu and, therefore, this command are not available in Directory Comparison and Database
Data Comparison Result windows.

15.3.5 Paste

The Paste  ( Ctrl+V ) command inserts the contents of the clipboard at the current cursor position of any
document you make active in DiffDog. You can also paste text from the clipboard into any other document in
an application that supports pasting from the clipboard.

Note that the Edit menu and, therefore, this command are not available in Directory Comparison and Database
Data Comparison Result windows.

15.3.6 Delete

The Delete ( Del ) command enables you to delete a selection in the document.

Note that the Edit menu and, therefore, this command are not available in Directory Comparison and Database
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Data Comparison Result windows.

15.3.7 Select All

The Select All command enables you to select all the content of a file in one of the file comparison panes .
Place the mouse cursor inside the pane with the file you would like to select and click Select All in the Edit
menu.

15.3.8 Find

The Find ( Ctrl+F ) command pops up the Find  dialog box, in which you can specify the string you
want to find and other options for the search.

Note that the Edit menu and, therefore, this command are not available in Directory Comparison and Database
Data Comparison Result windows.

15.3.9 Find next

The Find next  ( F3 ) command repeats the last Find...  command to search for the next occurrence of
the requested text. Clicking this command when the Find dialog box is open, closes the Find dialog box before
taking you to the next occurrence of the search string.

Note that the Edit menu and, therefore, this command are not available in Directory Comparison and Database
Data Comparison Result windows.

15.3.10 Replace

The Replace  ( Ctrl+H ) command enables you to find and replace one text string with another text string.
It features the same options as the Find...  command. You can replace each item individually or you can
use the Replace All button to perform a global search-and-replace operation.

Note that the Edit menu and, therefore, this command are not available in Directory Comparison and Database
Data Comparison Result windows.
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15.4 View Menu

The View menu contains the following commands:

· Text View
· Grid View
· Toolbars
· Status Bar
· Toggle 2-way/3-way Comparison
· Synchronized Scrolling
· Go to line/char

15.4.1 Text View

The Text View command is available in File Comparison windows (not Directory Comparison or Database Data
Comparison windows), and switches both files of the active File Comparison window to Text View. Note that
both files are always displayed in the same view. To switch the view, you can also use the Text View tab of
either pane; the tabs are located at the bottom of each pane.

15.4.2 Grid View

The Grid View command is available in File Comparison windows (not Directory Comparison or Database Data
Comparison windows), and switches both files of the active File Comparison window to Grid View. Note that
both files are always displayed in the same view. To switch the view, you can also use the Grid View tab of
either pane; the tabs are located at the bottom of each pane.

15.4.3 Toolbars

The Toolbars menu item contains a submenu with commands that show or hide the respective application
toolbars. 

Toolbar settings take effect depending on the current comparison mode. For example, if toolbar settings are
made with a File Comparison window open, the settings apply to all File Comparison windows that are currently
open and that will be opened subsequently. You can restore all toolbars to their default state by running the
menu command Tools | Restore Toolbars and Windows.

The Customize submenu item is a shortcut for the Tools | Customize...  command.
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15.4.4 Status Bar

The Status Bar, located at the bottom of the DiffDog application window, displays the following application-level
information:

· A description of menu command and toolbar icon actions; displayed when the mouse cursor is placed
over the command or icon. This information is on the left side in the Status Bar.

· Position of the cursor in a document, in terms of line number and character number (lower-right corner)
· Status of the Caps Lock, Num Lock and Scroll Lock keys (lower-right corner)
· If you are using the 64-bit version of DiffDog, this is indicated in the status bar with the suffix (x64) after

the application name. There is no suffix for the 32-bit version.

You can toggle the Status Bar on and off using the Status Bar command in File Comparison, XML Schema
Comparison, Directory Comparison, Database Data Comparison, and Database Schema Comparison windows.

Note: Do not confuse the Application Status Bar described here with the File Comparison and Directory
Comparison Status Bars, which are located at the bottom of Comparison Windows and contain
information about that comparison. Comparison Window status bars are described in the DiffDog
Interface  section.

15.4.5 Toggle 2-way/3-way Comparison

Switches the active comparison window from a two-pane comparison into a three-way comparison mode, and
vice versa. For more information, see Three-Way Comparisons .

15.4.6 Synchronized Scrolling

The Synchronized Scrolling command opens a sub-menu, where you can set this option separately for
horizontal and vertical scrolling.

Synchronized scrolling is available in File Comparison windows. If documents extend over a horizontal or
vertical length greater than the size of its containing pane, horizontal and vertical scrollbars, respectively,
appear at the bottom and right of the pane, respectively. When synchronized scrolling is enabled, both
documents can be scrolled simultaneously so that corresponding sections of the two documents are displayed
simultaneously.

If you scroll through one document (by moving the scrollbar, clicking the scroll arrows, or using the mouse
wheel) when synchronized scrolling is toggled on, the document in the other pane will also scroll (horizontally
or vertically) so that the corresponding part of the document is displayed.

Please note that synchronized scrolling is possible only after a file comparison has been carried out (since the
correspondence of sections in the two documents can only be determined after a comparison is made).
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Settings for synchronized scrolling apply to the application as a whole, and take effect immediately for all open
File Comparison windows and subsequently opened File Comparison windows.

Note that this command is not available in Database Data Comparison and Database Data Comparison Result
windows.

15.4.7 Go to line/char

The Go to line/char  ( Ctrl+G ) feature is available in File Comparison windows only, and enables you to
go to a particular location in the active document using line and character coordinates. The command pops up
the Go to text line/character dialog (screenshot below).

Enter the required line and character numbers in the respective text boxes, and click OK. This positions the
cursor at the specified location.

Note: In Grid View, the Go to line/char feature highlights the grid cell closest to the line or character number
you enter.

Note that this command is not available in Database Data Comparison and Database Data Comparison Result
windows.
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15.5 Text View Menu

The Text View menu contains commands that apply to the Text View display of documents in File
Comparison windows. They enable you to customize the display of documents.

15.5.1 Word Wrap

The Word Wrap  command enables or disables word wrapping in Text View .

15.5.2 Pretty-Print XML Text

The Pretty-Print XML Text  command reformats the active XML document in Text View to give a structured
display of the document. Each child node is offset from its parent by four space characters.

Note: The Pretty-Print XML Text command is not a toggle command. Once the command is executed, the
pretty-printed format cannot be undone by clicking the Pretty-Print XML Text command again. To undo
the pretty-printed format, you must use the Undo  (Ctrl+Z or Alt+Backspace) command.

15.5.3 Insert/Remove Bookmark

The Insert/Remove Bookmark  command is available in Text View  only. It inserts a bookmark at the
current cursor position, or removes the bookmark if the cursor is in a line that has been bookmarked previously.

Bookmarked lines are displayed in one of two ways: If the bookmarks margin has been enabled, then a solid
cyan-colored ellipse appears to the left of the text in the bookmark margin. If the bookmarks margin has not
been enabled, then the complete line containing the cursor is highlighted in cyan.
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Tip: You can assign a keyboard shortcut for this command in the Keyboard tab  of the Customize dialog
box.

15.5.4 Go to Next Bookmark

The Go to Next Bookmark  command is available in Text View  only. It places the text cursor at the
beginning of the next bookmarked line.

Tip: You can assign a keyboard shortcut for this command in the Keyboard tab  of the Customize dialog
box.

15.5.5 Go to Previous Bookmark

The Go to Previous Bookmark  command is available in Text View  only. It places the text cursor at
the beginning of the previous bookmarked line.

Tip: You can assign a keyboard shortcut for this command in the Keyboard tab  of the Customize dialog
box.

15.5.6 Remove All Bookmarks

The Remove All Bookmarks  command is available in Text View  only. It removes all currently defined
bookmarks in the active document. Note that the Undo  command does not undo the effects of this
command.

Tip: You can assign a keyboard shortcut for this command in the Keyboard tab  of the Customize dialog
box.

15.5.7 Toggle All Folds

The Toggle All Folds  command toggles the active document between two states: (i) all nodes expanded,
and (ii) all nodes collapsed.

15.5.8 Text View Settings

The Text View Settings command opens the Text View Settings dialog box where you can define settings
for the display of line number, bookmark, and source folding margins, specify the tab size, and define which
visual aids are available in Text View.
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15.6 Grid View Menu

The Grid View Menu contains commands for working with documents in the Grid View  of File Comparison
windows.

These commands are not available in Text View.

15.6.1 Insert

Placing the cursor over the Insert command pops up a sub-menu which contains the items that can be
inserted. The submenu items of the Insert command are enabled only in Grid View . Items that cannot be
inserted for the current selection are grayed out.
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The commands of the Insert sub-menu can be used to insert (i) the XML declaration  and node types
(Attribute , Element , Text , CDATA , Comment , Processing Instruction ) in XML documents,
(ii) DOCTYPE  declarations and external DTD declarations  in XML documents, and (iii) DTD declarations
(ELEMENT , ATTLIST , ENTITY , and NOTATION ) in DTD documents and internal DTD declarations
of XML documents.

15.6.1.1  Insert | Attribute

The Insert | Attribute  command is available in Grid View  only, and inserts a new attribute before the
selected item. Sometimes, an inserted attribute may appear a few lines before the current item in Grid View.
This is because attributes immediately follow their parent element in Grid View and precede all child elements
of that parent element.

15.6.1.2  Insert | Element

The Insert | Element  command is available in Grid View  only, and inserts a new element before the
selected item. If the current selection is an attribute, the new element is inserted before the first child element
of the attribute's parent element.

15.6.1.3  Insert | Text

The Insert | Text  command is available in Grid View  only, and inserts a new text row before the
selected item. If the current selection is an attribute, the text row is inserted after the attribute and before the
first child element of the attribute's parent element.

15.6.1.4  Insert | CData

The Insert | CData  command is available in Grid View  only, and inserts a new CDATA block before the
selected item. If the current selection is an attribute, the CDATA block is inserted after the attribute and before
the first child element of the attribute's parent element.

15.6.1.5  Insert | Comment

The Insert | Comment  command is available in Grid View  only, and inserts a new comment before the
selected item. If the current selection is an attribute, the new comment row is inserted after the attribute and
before the first child element of the attribute's parent element.
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15.6.1.6  Insert | XML

The Insert | XML  command is available in Grid View  only, and inserts a row for the XML declaration
before the selected item. You must insert the child attributes of the XML declaration and the values of this
attribute. An XML declaration must look something like this:

<?xml version="1.0" encoding="UTF-8"?>

Note: Since an XML document may only contain one XML declaration at the very top of the file, this
command should only be used with the topmost row selected and if an XML declaration does not
already exist.

15.6.1.7  Insert | Processing Instruction

The Insert | Processing Instruction  command is available in Grid View  only, and inserts a new
processing instruction (PI) before the selected item.  If the current selection is an attribute, the PI is inserted
after the attribute and before the first child element of the attribute's parent element.

15.6.1.8  Insert | DOCTYPE

The Insert | DOCTYPE  command is available in the Grid View  of an XML file when a top-level node is
selected. It appends a DOCTYPE declaration at the top of the XML document. You must enter the name of the
DOCTYPE, and this name must be the same as the name of the document element.

After you have entered the name of the DOCTYPE, you can enter the declarations you wish to use in the
internal DTD subset.

Note: A DOCTYPE declaration may only appear between the XML declaration and the XML document
element.

15.6.1.9  Insert | ExternalID

The Insert | ExternalID  command is available when a child item of the DOCTYPE  declaration in an
XML file is selected in Grid View . This command inserts a Grid View row for an external identifier (PUBLIC
or SYSTEM). You must enter the type of identifier and its value.
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The Text View corresponding to the screenshot of the Grid View shown above looks like this:

Note: A row for ExternalID can be added as a child  when the DOCTYPE item is selected, or it can be
inserted or appended  when one of the child items of the DOCTYPE item is selected, for example,
the ELEMENT declaration name in the example above.

Referencing external resources
A DOCTYPE declaration in an XML file can contain a reference to an external resource containing DTD
declarations. This resource is referenced either through a public or system identifier. For example:

<!DOCTYPE doc_element_name PUBLIC "publicID" "systemID">

<!DOCTYPE doc_element_name SYSTEM "systemID">

A system identifier is a URI that identifies the external resource. A public identifier is location-independent and
can be used to dereference the location of an external resource. For example, in your <%SPY-GEN%>
installation, URIs for popular DTDs and XML Schemas are listed in a catalog file called MainCatalog.xml. A
public identifier in an XML document can be used to dereference a DTD listed in MainCatalog.xml.

15.6.1.10  Insert | ELEMENT

The Insert | ELEMENT  command is available in Grid View  only, for DTD documents or when an item in
the DOCTYPE  declaration of an XML document is selected. It inserts an ELEMENT declaration before the
selected declaration.

15.6.1.11  Insert | ATTLIST

The Insert | ATTLIST  command is available in Grid View  only, for DTD documents or when an item in
the DOCTYPE  declaration of an XML document is selected. It inserts an ATTLIST declaration before the
selected declaration.
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15.6.1.12  Insert | ENTITY

The Insert | ENTITY  command is available in Grid View  only, for DTD documents or when an item in the
DOCTYPE  declaration of an XML document is selected. It inserts an ENTITY declaration before the
selected declaration.

15.6.1.13  Insert | NOTATION

The Insert | NOTATION  command is available in Grid View  only, for DTD documents or when an item in
the DOCTYPE  declaration of an XML document is selected. It inserts a NOTATION declaration before the
selected declaration.

15.6.2 Append

Placing the cursor over the Append command pops up a submenu which contains the items that can be
inserted for a given selection. The submenu items of the Append command are enabled only in Grid View .
Items that cannot be inserted for the current selection are grayed out.
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The commands of the Append sub-menu can be used to append (i) the XML declaration  and node types
(Attribute , Element , Text , CDATA , Comment , Processing Instruction ) in XML documents,
(ii) DOCTYPE  declarations and external DTD declarations  in XML documents, and (iii) DTD declarations
(ELEMENT , ATTLIST , ENTITY , and NOTATION ) in DTD documents and internal DTD declarations
of XML documents.

15.6.2.1  Append | Attribute

The Append | Attribute  command is available in Grid View  only, and appends a new attribute.

15.6.2.2  Append | Element

The Append | Element  command is available in Grid View  only, and appends an element node after
the last sibling element of the selected element. If an attribute node is selected, then the element node is
appended after the last child of the selected attribute's parent element.

15.6.2.3  Append | Text

The Append | Text  command is available in Grid View  only, and appends a text block after the last
sibling element of the selected element. If an attribute node is selected, then the text block is appended after
the last child of the selected attribute's parent element.
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15.6.2.4  Append | CData

The Append | CData  command is available in Grid View  only, and appends a CDATA node after the
last sibling of any selected node other than an attribute node. If an attribute node is selected, then the CDATA
section is appended after the last child of the selected attribute's parent element.

15.6.2.5  Append | Comment

The Append | Comment  command is available in Grid View  only, and appends a comment node after
the last sibling of any selected node other than an attribute node. If an attribute node is selected, then the
comment node is appended after the last child of the selected attribute's parent element.

15.6.2.6  Append | XML

The Append | XML  command is available in Grid View  only, and inserts a row for the XML declaration
as the first item in a document. You must insert the child attributes of the XML declaration and the values of
this attribute. An XML declaration must look something like this:

<?xml version="1.0" encoding="UTF-8"?>

Note: Since an XML document may only contain one XML declaration at the very top of the file, this
command should only be used with the topmost row selected and if an XML declaration does not
already exist.

15.6.2.7  Append | Processing Instruction

The Append | Processing Instruction  command is available in Grid View  only, and appends a
processing instruction node after the last sibling of any selected node other than an attribute node. If an
attribute node is selected, then the processing instruction node is appended after the last child of the selected
attribute's parent element.

15.6.2.8  Append | DOCTYPE

The Append | DOCTYPE  command is available in the Grid View  of an XML file when a top-level node is
selected. It appends a DOCTYPE declaration at the top of the XML document. You must enter the name of the
DOCTYPE, and this name must be the same as the name of the document element.
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After you have entered the name of the DOCTYPE, you can enter the declarations you wish to use in the
internal DTD subset.

Note: A DOCTYPE declaration may only appear between the XML declaration and the XML document
element.

15.6.2.9  Append | ExternalID

The Append | ExternalID  command is available when a child item of the DOCTYPE  declaration in an
XML file is selected in Grid View . This command inserts a Grid View row for an external identifier
(PUBLIC or SYSTEM). You must enter the type of identifier and its value.

The Text View corresponding to the screenshot of the Grid View shown above looks like this:

Note: A row for ExternalID can be added as a child  when the DOCTYPE item is selected, or it can be
inserted  or appended when one of the child items of the DOCTYPE item is selected, for example,
the ELEMENT declaration name in the example above.

15.6.2.10  Append | ELEMENT

The Append | ELEMENT  command is available in Grid View  only, for DTD documents or when an item
in the DOCTYPE  declaration of an XML document is selected. It appends an ELEMENT declaration to the
list of declarations.
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15.6.2.11  Append | ATTLIST

The Append | ATTLIST  command is available in Grid View  only, for DTD documents or when an item
in the DOCTYPE  declaration of an XML document is selected. It appends an ATTLIST declaration to the list
of declarations.

15.6.2.12  Append | ENTITY

The Append | ENTITY  command is available in Grid View  only, for DTD documents or when an item in
the DOCTYPE  declaration of an XML document is selected. It appends an ENTITY declaration to the list of
declarations.

15.6.2.13  Append | NOTATION

The Append | NOTATION  command is available in Grid View  only, for DTD documents or when an item
in the DOCTYPE  declaration of an XML document is selected. It appends a NOTATION declaration to the
list of declarations.

15.6.3 Add Child

Placing the cursor over the Add Child command pops up a submenu which contains the items that can be
inserted for a given selection. The submenu items of the Add Child command are enabled only in Grid View
. Items that cannot be inserted for the current selection are grayed out.
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The commands of the Add Child sub-menu can be used to add child nodes for (i) the XML declaration  and
node types (Attribute , Element , Text , CDATA , Comment , Processing Instruction ) in XML
documents, (ii) DOCTYPE  declarations and external DTD declarations  in XML documents, and (iii) DTD
declarations (ELEMENT , ATTLIST , ENTITY , and NOTATION ) in DTD documents and internal DTD
declarations of XML documents.

15.6.3.1  Add Child | Attribute

The Add Child | Attribute  command is available in Grid View  only and when an element node is
selected. It inserts a new attribute as a child of the selected element node.

15.6.3.2  Add Child | Element

The Add Child | Element  command is available in Grid View  only. It inserts a new element as a child
of the selected node.

15.6.3.3  Add Child | Text

The Add Child | Text  command is available in Grid View  only, and inserts new text content as a child
of the selected item.
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15.6.3.4  Add Child | CData

The Add Child | CData  command is available in Grid View  only, and inserts a new CDATA section as
a child of the selected item.

15.6.3.5  Add Child | Comment

The Add Child | Comment  command is available in Grid View  only, and inserts a new Comment node
as a child of the selected item.

15.6.3.6  Add Child | XML

The Add Child | XML  command is available in Grid View  only and when the file is empty. It inserts a
row for the XML declaration. You must insert the child attributes of the XML declaration and the values of this
attribute. An XML declaration must look something like this:

<?xml version="1.0" encoding="UTF-8"?>

15.6.3.7  Add Child | Processing Instruction

The Add Child | Processing Instruction  command is available in Grid View  only and inserts a new
Processing Instruction (PI) as a child of the selected item.

15.6.3.8  Add Child | DOCTYPE

The Add Child | DOCTYPE command  is available in the Grid View  of an empty document. It inserts a
DOCTYPE declaration in an XML document. The DOCTYPE declaration can be used to declare an internal DTD
subset.

15.6.3.9  Add Child | ExternalID

The Add Child | ExternalID  command is available when the DOCTYPE  declaration in an XML file is
selected in Grid View . This command inserts a Grid View row for an external identifier  (PUBLIC or
SYSTEM). You must enter the type of identifier and its value.
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The Text View corresponding to the screenshot of the Grid View shown above looks like this:

Note: A row for ExternalID can be added as a child when the DOCTYPE item is selected, or it can be
inserted  or appended  when one of the child items of the DOCTYPE item is selected, for
example, the ELEMENT declaration name in the example above.

15.6.3.10  Add Child | ELEMENT

The Add Child | ELEMENT  command is available in Grid View  only, for DTD documents or when the
DOCTYPE  declaration of an XML document is selected. It appends an ELEMENT declaration to the list of
declarations.

15.6.3.11  Add Child | ATTLIST

The Add Child | ATTLIST  command is available in Grid View  only, for DTD documents or when the
DOCTYPE  declaration of an XML document is selected. It appends an ATTLIST declaration to the list of
declarations.

15.6.3.12  Add Child | ENTITY

The Add Child | ENTITY  command is available in Grid View  only, for DTD documents or when the
DOCTYPE  declaration of an XML document is selected. It appends an ENTITY declaration to the list of
declarations.

15.6.3.13  Add Child | NOTATION

The Add Child | NOTATION  command is available in Grid View  only, for DTD documents or when the
DOCTYPE  declaration of an XML document is selected. It appends a NOTATION declaration to the list of
declarations.
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15.6.4 Convert to

The Convert to command converts a selected item in Grid View  to a different item type. This operation is
available only in Grid View on individual items that do not contain any child node. Placing the cursor over the
Convert to command pops up a submenu which contains the items to which the selected item can be
converted.

If the operation would result in a loss of data (for example, converting an attribute to a comment would result in
a loss of the attribute name), a warning dialog box will appear.

15.6.5 Table

The Table menu command can be used only in Grid View . It pops out a sub-menu with commands that
enable you to edit the selection as a table.
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15.6.5.1  Display as Table

The Display as Table  command allows you to switch between the standard Grid View  and Table
View  of an element in the document.

15.6.5.2  Insert Row

The Insert Row  command is enabled in Table View  when a row or cell is selected. It inserts a new row
before the selected row. The new row corresponds to an occurrence of the table element. Mandatory child
elements are created for the new element.

15.6.5.3  Append Row

The Append Row  command is enabled in Table View  when a row or cell is selected. It appends a new
row after the last row of the table. The new row corresponds to an occurrence of the table element. Mandatory
child elements are created for the new element.

15.6.5.4  Ascending Sort

The Ascending Sort  command is enabled in Table View  when a column or cell is selected. It sorts the
table on the basis of the contents of the selected column, in ascending order. DiffDog tries to automatically
determine what kind of data is used in the column, and sorts on alphabetic or numeric order, as required. In
case of uncertainty, you will be prompted for the sort method to use.

15.6.5.5  Descending Sort

The Descending Sort  command is enabled in Table View  when a column or cell is selected. It sorts
the table on the basis of the contents of the selected column, in descending order. DiffDog tries to
automatically determine what kind of data is used in the column, and sorts on alphabetic or numeric order, as
required. In case of uncertainty, you will be prompted for the sort method to use.

15.6.6 Move Left

The Move Left  command is available in Grid View  only. It moves the selected node to the left by one
level, thereby changing a child element into a sibling of its parent.
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15.6.7 Move Right

The Move Right  command is available in Grid View  only. It moves the selected node to the right by
one level, thereby turning it into a child element of the preceding sibling element.

15.6.8 Enclose in Element

The Enclose in Element command is enabled in Grid View  only. It encloses a selected text range in a new
element. The new element is created inline around the selected text. If you are editing a document based on a
Schema or DTD, you will automatically be presented with a list of valid choices for the name of the element in
which the text is to be enclosed.

For example, in the screenshot below, the text Nanonull in the para element is highlighted.

When you select the command Grid View | Enclose in Element, the text "Nanonull" is enclosed in a newly
created inline element and a list appears offering a choice for the name of the element. These elements are
defined in the schema as children of para.

The selection you make will be the name of the new element. Alternatively, you can enter some other name for
the element.
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15.7 XML Menu

The XML menu contains commands that relate to XML documents opened in File Comparison windows.

15.7.1 Check Well-Formedness

The Check Well-Formedness  ( F7 ) command checks the active document for well-formedness by the
definitions of the XML 1.0 specification. This command is available in both the Text View  and Grid View
of File Comparison windows. On running the well-formedness check, a message box displays the result of the
check: whether successful or not.

Note: This command is available for all files with extensions that have been set as XML-conformant in the File
Types  tab of the DiffDog Options dialog box.

15.7.2 Validate

The Validate  ( F8 ) command is available in both the Text View  and Grid View  of File Comparison
windows. It enables you to validate the active XML document against a DTD, XML Schema, or other schema.
The associated schema must be declared in the file being validated. On validating the document, a message
box displays the result of the validation: that is, whether successful or not.

Note: This command is available for all files with extensions that have been set as XML-conformant in the File
Types  tab of the DiffDog Options dialog box.
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15.8 Diff and Merge Menu

The Diff and Merge Menu lists commands to manage file , XML Schema , directory , Microsoft Word
document , database data , and database schema  comparisons. Depending on the active comparison
window, commands to set the comparison mode , navigate  compared documents in the comparison
windows and merge  differences in them, as well as commands to synchronize directories , generate
merge scripts, or to map, expand and collapse database items are also available in this menu.

Please note that the content of the Diff and Merge menu changes dynamically, depending on the type of
comparison.

Diff and Merge general settings
This subsection describes general commands available in the Diff and Merge menu. To find out more about
commands specific to comparison types, see Directory Comparison Commands  and Database Comparison
Commands .

Compare as

The Textual Comparison Only  command changes the comparison mode of a file or directory comparison
to textual comparison. Note that this command is not available if the Quick Comparison  mode is active. To
change to the Text Comparison mode in that case, you have to deactivate the Quick Comparison mode first.

The Compare as XML  command changes the comparison mode of a file or directory comparison to XML
comparison. Note that this command is not available if the Quick Comparison  mode is active. To change to
the XML Comparison mode in that case, you have to deactivate the Quick Comparison mode first.

The Compare as Binary  command changes the comparison mode of a file or directory comparison to
binary comparison. Note that this command is not available if the Quick Comparison  mode is active. To
change to the Binary Comparison mode in that case, you have to deactivate the Quick Comparison mode first.

The Compare According to File Extension Settings  command changes the comparison mode of a file
or directory comparison dynamically according to the settings on the File types  tab of the DiffDog Options
dialog box. Note that this command is not available if the Quick Comparison  mode is active. To change to
the File Extension mode in that case, you have to deactivate the Quick Comparison mode first.

Start comparison

The Start Comparison  ( F5 ) command starts comparison  for the active comparison window.

Next/last

The Next Difference  ( Alt+Down ) command selects the next difference as the current difference .

The Previous Difference  ( Alt+Up ) command selects the previous difference as the current difference .

The Last Difference  ( Alt+End ) command selects the last difference as the current difference .

The First Difference  ( Alt+Home ) command selects the first difference as the current difference .
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The Next Conflict  command jumps to the next conflict. This command is applicable for three-way
comparisons, see Three-Way Comparisons .

The Previous Conflict  command jumps to the previous conflict. This command is applicable for three-way
comparisons, see Three-Way Comparisons .

Current difference

The Display Current Difference  ( Ctrl+Enter ) command scrolls through the document to display the
current difference .

The Make Current Difference  ( Alt+Enter ) command makes the selected difference the current
difference, and sets it as the difference from which to navigate.

Copy

The Copy from Left to Right  ( Alt+Right ) command copies text of the selected difference from the
document in the left pane to the document in the right pane.

The Copy from Right to Left  ( Alt+Left ) command copies text of the selected difference from the
document in the right pane to the document in the left pane.

The Copy from Left to Middle  command is applicable when two versions of the same file are compared
against a base version from which both files originate, see Three-Way Comparisons . It merges the current
difference from the left pane into the middle pane, where "middle" is the base version.

The Copy from Middle to Left  command is applicable when two versions of the same file are compared
against a base version from which both files originate, see Three-Way Comparisons . It merges the current
difference from the middle pane into the left pane.

The Copy from Middle to Right  command is applicable when two versions of the same file are compared
against a base version from which both files originate, see Three-Way Comparisons . It merges the current
difference from the middle pane into the right pane, where "middle" is the base version.

The Copy from Right to Middle  command is applicable when two versions of the same file are compared
against a base version from which both files originate, see Three-Way Comparisons . It merges the current
difference from the right pane into the middle pane, where "middle" is the base version.

Other options

When the Show Options Before Comparison  command is toggled on for a Comparison Window, the
Comparison Options dialog box is displayed each time a comparison is made in that window. Note that the
Comparison Options dialog box is not displayed before comparisons made dynamically by DiffDog while you
edit a document.

When toggled on, the Autostart Comparison  command automatically starts a comparison when both files
or both directories are selected and opened in the comparison window. If this option is toggled off, then a
comparison (file or directory) must be explicitly started (see the Start Comparison command above).

The Compare while Editing  command is a toggle to compare or not compare documents in File
Comparison windows while editing. If toggled on, differences are highlighted as you edit. If toggled off,
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highlighting of differences is turned off in both documents as soon as you start typing in either document; to
highlight differences after editing, you must run a comparison (see the Start Comparison command above).

The Support Recently Compared Pairs  command is a toggle that switches on and off the option of
suggesting recently compared files or directories each time a file or directory is selected in one pane.

15.8.1 Directory Comparison Commands

This topic describes menu commands that are specific to directory comparisons.

The Show files in ZIP archives  option is deactivated by default, therefore only the file itself will be shown
in directory comparisons. To be able to expand the file and view its content you must activate the Show files
in ZIP archives option. 

The Compare only Size and Modification Date  command compares files within directories and
subdirectories by size and date modified. This mode is either toggled on or off. When toggled off, the four file
comparison modes  become available. Selecting one of the file comparison modes causes directories to be
compared in terms of their contents as text, XML, or binary files.

The Synchronize Directories  command opens the Synchronize directories  dialog box and populates it
with all non-equal files that are present in at least one of the directories.

The Synchronize Selected Directory  command is available when the following conditions are true:

· At least one of the compared directories contains a sub-directory which is selected.
· The selected sub-directory contains one or more non-equal files.

The command opens the Synchronize directories  dialog box and populates it with all non-equal files that are
present in the selected sub-directory.

15.8.2 Database Comparison Commands

This topic describes menu commands that are specific to database comparisons.

The Diff and Merge menu for database data comparisons lists commands to (i) set comparison modes, (ii)
start a comparison,  (iii) navigate compared documents and display differences in Database Data Comparison
windows, (iv) merge differences in them, (v) show results, (vi) sort tables (vii) map and unmap or, (viii) expand or
collapse items, (ix) enable Autolayout, and (x) show the comparison options before comparison. For more
information, see Comparing Database Data .

The Compare as String  command changes the comparison mode of a database data comparison to
string comparison.

The Compare Native  command changes the comparison mode of a database data comparison to native
comparison.
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The Compare XML Columns Native  command changes the comparison mode for XML columns to native
XML comparison. Note that this command is only available if the comparison mode of a database data
comparison is set to native comparison .

The Show Results command opens the Database Data Comparison Result window for (i) the selected table or
(ii) all tables if no table is selected. If some of the tables do not contain differences or if you select a table with
equal data in both databases, DiffDog displays a message box and you can still abort the operation.

The Sort Tables sub-menu of the Diff and Merge menu provides options for sorting the tables that are
included in the components of a database comparison. The commands always affect both sides of the
comparison (i.e., you cannot sort just one component).

The Ascending command sorts all tables in ascending order. The Descending command sorts all tables in
descending order.

The Ascending Mapped First command sorts all tables and displays the mapped tables in ascending order
first (see screenshot below).

The Descending Mapped First command sorts all tables and displays the mapped tables in descending order
first (see screenshot below).
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The Map items command tries to map all tables in the Database Data Comparison window using the settings
defined in the Database comparison  tab of the DiffDog Options dialog box.261
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15.9 Tools Menu

The Tools Menu contains commands that enable you to set the application  and comparison  options
and to customize  the appearance of DiffDog.

15.9.1 DiffDog Options

The DiffDog Options dialog box enables you to define settings for the application , file comparison ,
directory comparison , database comparison , database data result view , and Java . You can also
define network proxy settings  and specify file types  that can be compared.

15.9.2 Comparison Options

The Comparison Options dialog box allows you to define text comparison options  and XML comparison
options .

15.9.3 Comparison Document Options

This command is applicable if you have licensed DiffDog Server and intend to run with it comparison files (.filedif
and .dirdif) created with DiffDog, see also Running comparisons with DiffDog Server .

When you run .filedif or .dirdif files with DiffDog Server, you might want to optionally redirect the report with the
comparison results to an XML or text file. The dialog below lets you specify the format and path of the output
report.
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15.9.4 Customize

The Customize command lets you customize DiffDog to suit your personal needs.

15.9.4.1  Commands

The Commands tab allows you customize your menus or toolbars.
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To add a command to a toolbar or menu:

1. Select the menu option Tools | Customize. The Customize dialog box appears.
2. Select the All Commands category in the Categories list box. The available commands appear in the

Commands list box.

3. Click on a command in the Commands list box and drag it to an existing menu or toolbar. An I-beam

appears when you place the cursor over a valid position to drop the command.
4. Release the mouse button at the position you want to insert the command.

· A small button appears at the tip of mouse pointer when you drag a command. The "x" below the
pointer means that the command cannot be dropped at the current cursor position.

· The "x" disappears whenever you can drop the command (over a tool bar or menu).
· Placing the cursor over a menu when dragging opens it, allowing you to insert the command

anywhere in the menu.
· Commands can be placed in menus or toolbars. If you created you own toolbar you can populate it

with your own commands/icons.

Note: You can also edit the commands in the context menus  (right-click anywhere to open the context
menu), using the same method. Click the Menu tab and then select the specific context menu
available in the Context Menus combo box.

15.9.4.2  Toolbars

The Toolbars tab allows you to activate or deactivate specific toolbars, as well as create your own specialized
ones.

DiffDog toolbars contain symbols for the most frequently used menu commands. For each symbol you get a
brief "tool tip" explanation when the mouse cursor is directly over the item and the status bar shows a more
detailed description of the command.

You can drag the toolbars from their standard position to any location on the screen, where they appear as a
floating window. Alternatively, you can also dock them to the left or right edge of the main window.
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Show text labels
This option displays explanatory text below toolbar icons when activated. You can activate or deactivate this
option for each toolbar individually.

To activate or deactivate a toolbar:

· Click the check box to activate (or deactivate) the specific toolbar.

To create a new toolbar:

1. Click the New... button, and give the toolbar a name in the Toolbar Name dialog box that appears.
2. Drag commands to the toolbar in the Commands  tab of the Customize dialog box.

To reset the Menu Bar:

1. Click the Menu Bar entry.
2. Click the Reset button, to reset the menu commands to the state they were in when DiffDog was

installed.
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To reset all toolbar and menu commands:

1. Click the Reset All button to reset all the toolbar commands to the state they were when the program
was installed. A prompt appears stating that all toolbars and menus will be reset.

2. Click Yes to confirm the reset.

To change a toolbar name:

· Click the Rename... button to edit the name of the toolbar.

This option is available only for user-defined toolbars.

To delete a toolbar:

1. Select the toolbar you want to delete in the Toolbars list box.
2. Click the Delete button. A prompt appears, asking if you really want to delete the toolbar.
3. Click Yes to confirm the deletion.

This option is available only for user-defined toolbars.
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15.9.4.3  Keyboard

The Keyboard tab allows you to define (or change) keyboard shortcuts for any  DiffDog command.

To assign a new Shortcut to a command:

1. Select a command menu from the Category list, for example, "File". (Alternatively, select All
Commands to view commands from all menus).

2. Select the command to which you want to assign a new shortcut from the Commands list.
3. Click in the Press New Shortcut Key text box, and press the shortcut keys that are to activate the

command. The shortcuts appear immediately in the text box. If the shortcut was assigned previously,
then that function is displayed below the text box. (To clear this text box, press any of the control
keys, CTRL, ALT or SHIFT).

4. Click Assign. The shortcut now appears in the Current Keys list box.

Note:  The only supported value in the Set Accelerator for drop-down list is Default.

To de-assign or delete a shortcut:

1. In the Current Keys list, click the shortcut you want to delete.
2. Click Remove.
3. Click Close to confirm.
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To reset all shortcut keys:

1. Click the Reset All button to reset all the shortcut keys to the state they were when the program was
installed. A message box appears stating that all keyboard assignments will be reset.

2. Click Yes to confirm the reset.

Currently assigned keyboard shortcuts

Hotkeys by key

Ctrl+C Copy

Ctrl+F Find

Ctrl+G Go to Line/Char

Ctrl+H Replace

Ctrl+O Open

Ctrl+P Print

Ctrl+S Save

Ctrl+V Paste

Ctrl+X Cut

Ctrl+Z Undo

F1 Table Of Contents

F3 Find Next

F5 Start Comparison

F7 Check Well-
Formedness

F8 Validate

Alt+Enter Make Current Difference

Ctrl+Enter Display Current
Difference

Delete Delete

Shift+Delete Cut
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Hotkeys by key

Alt+Backspace Undo

Ctrl+Insert Copy

Shift+Insert Paste

Alt+Down Next Difference

Alt+Up Previous Difference

Alt+Home First Difference

Alt+End Last Difference

Alt+Left Copy from Right to Left

Alt+Right Copy from Left to Right

Hotkeys by function

Check Well-Formedness F7

Copy Ctrl+C Ctrl+Insert

Copy from Left to Right Alt+Right

Copy from Right to Left Alt+Left

Cut Ctrl+X Shift+Delete

Delete Delete

Display Current Difference Ctrl+Enter

Find Ctrl+F

Find Next F3

First Difference Alt+Home

Go to Line/Char Ctrl+G

Last Difference Alt+End

Make Current Difference Alt+Enter

Next Difference Alt+Down
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Hotkeys by function

Open Ctrl+O

Paste Ctrl+V Shift+Insert

Previous Difference Alt+Up

Print Ctrl+P

Replace Ctrl+H

Save Ctrl+S

Start Comparison F5

Table Of Contents F1

Undo Ctrl+Z Alt+Backspace

Validate F8

15.9.4.4  Menu

The Menu tab allows you to customize menu bars as well as context menus.
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Customizing menus
The Default Menu bar is the menu bar that is displayed when no document is open in the main window. Other
menu bars are as follows:

· The File compare menu bar is the menu bar visible when at least one File Comparison window has
been opened and is active.

· The Directory compare menu bar is the menu bar visible when at least one Directory Comparison
window has been opened and is active.

· The Database Data Comparison menu bar is the menu bar visible when at least one Database Data
Comparison window has been opened and is active.

· The Database Data compare result menu bar is the menu bar visible when at least one Database
Data Comparison Result window has been opened and is active.

· The Database Schema Comparison menu bar is the menu bar visible when at least one Database 
Schema Comparison window has been opened and is active.

· The XML Schema Comparison menu bar is the menu bar visible when at least one XML Schema
Comparison window has been opened and is active.

· The Word compare menu bar is the menu bar visible when at least one Word Comparison window
has been opened and is active.

To customize a menu bar, select it from the Show Menus For drop-down list. Then switch to the Commands
tab and drag commands from the Commands list box to the menu bar or into any of the menus.

Deleting commands from menus and resetting the menu bars
To delete an entire menu or a command inside a menu, do the following:

1. Select a menu bar from the Show Menus for drop-down list.
2. With the Customize dialog open, select (i) the menu you want to delete from the application's menu

bar, or (ii) the command you want to delete from one of these menus.
3. Either (i) drag the menu from the menu bar or the menu command from the menu, or (ii) right-click the

menu or menu command and select Delete.

You can reset any menu bar to its original installation state by selecting it from the Show Menus For drop-
down list and then clicking the Reset button.

Customizing the application's context menus
Context menus are the menus that appear when you right-click certain objects in the application's interface.
Each of these context menus can be customized by doing the following:

1. Select the context menu from the Select context menu drop-down list. This pops up the context
menu.

2. Click the Commands tab.
3. Drag a command from the Commands list box into the context menu.
4. To delete a command from the context menu, right-click that command in the context menu, and

select Delete. Alternatively, drag the command out of the context menu.

You can reset any context menu to its original installation state by selecting it in the Select context menu
drop-down list and then clicking the Reset button.
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Menu shadows
Select the Menu shadows check box to give all menus shadows.

15.9.4.5  Options

The Options tab allows you to set general environment settings.

Toolbar
When active, the Show ScreenTips on toolbars check box displays a popup when the mouse pointer is
placed over an icon in any of the icon bars. The popup contains a short description of the icon function, as well
as the associated keyboard shortcut, if one has been assigned.

The Show shortcut keys in ScreenTips check box allows you to decide whether or not you want to have the
shortcut displayed in the tooltip.

When active, the Large icons check box switches between the standard size icons, and larger versions of the
icons.
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15.9.5 Restore Toolbars and Windows

This menu command resets the toolbars, entry helper windows, docked windows etc. to their defaults. DiffDog
needs to be restarted for the changes to take effect.
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15.10 Window Menu

The Windows menu provides commands to arrange and organize the display of open windows. You can
cascade open windows, tile them horizontally or vertically, or arrange document icons once you have
minimized them. You can also switch to an open document window directly from the menu.

Windows
Clicking the Windows command opens the Windows dialog box (see screenshot below), which displays a list
of all open windows and provides commands that can be applied to the selected window(s). You can select a
window by clicking on its name.

The Cascade and Tile options are available only when more than one window is selected. The Activate option
is enabled only when a single window is selected.

Note: To exit the Windows dialog box, click OK; do not click the Close Window(s) button in the dialog
box. The Close Window(s) button closes the window(s) currently selected in the Windows dialog
box.
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15.11 Help Menu

Table of Contents

Opens the onscreen help manual of DiffDog with the Table of Contents displayed in the left-hand-side pane
of the Help window. The Table of Contents provides an overview of the entire Help document. Clicking an
entry in the Table of Contents takes you to that topic.

Index

Opens the onscreen help manual of DiffDog with the Keyword Index displayed in the left-hand-side pane of
the Help window. The index lists keywords and lets you navigate to a topic by double-clicking the
keyword. If a keyword is linked to more than one topic, a list of these topics is displayed.

Search

Opens the onscreen help manual of DiffDog with the Search dialog displayed in the left-hand-side pane of
the Help window. To search for a term, enter the term in the input field and press Enter or List Topics. The
Help system performs a full-text search on the entire Help documentation and returns a list of hits. Double-
click any item to display that item.

Software Activation

License your product
After you download your Altova product software, you can license—or activate—it using either a free
evaluation key or a purchased permanent license key.

· Free evaluation license. When you first start the software after downloading and installing it, the
Software Activation dialog will pop up. In it is a button to request a free evaluation license. Enter
your name, company, and e-mail address in the dialog and click Request. A license file is sent to
the e-mail address you entered and should reach you in a few minutes. Save the license file to a
suitable location. 

When you clicked Request, an entry field appeared at the bottom of the Request dialog. This field
takes the path to the license file. Browse for or enter the path to the license file and click OK. (In
the Software Activation dialog, you can also click Upload a New License to access a dialog
in which the path to the license file is entered.) The software will be unlocked for a period of 30
days.

· Permanent license key. The Software Activation dialog allows you to purchase a permanent
license key. Clicking this button takes you to Altova's online shop, where you can purchase a
permanent license key for your product. Your license will be sent to you by e-mail in the form of a
license file, which contains your license-data. 

There are three types of permanent license: installed, concurrent user, and named user. An
installed license unlocks the software on a single computer. If you buy an installed license for N
computers, then the license allows use of the software on up to N computers. A concurrent-user
license for N concurrent users allows N users to run the software concurrently. (The software may
be installed on 10N computers.)  A named-user license authorizes a specific user to use the
software on up to 5 different computers. To activate your software, click Upload a New License,
and, in the dialog that appears, enter the path to the license file, and click OK.

Note: For multi-user licenses, each user will be prompted to enter his or her own name. 
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Your license email and the different ways to license (activate) your Altova product 
The license email that you receive from Altova will contain your license file as an attachment.
The license file has a .altova_licenses file extension.

To activate your Altova product, you can do one of the following:

· Save the license file (.altova_licenses) to a suitable location, double-click the

license file, enter any requested details in the dialog that appears, and finish by
clicking Apply Keys.

· Save the license file (.altova_licenses) to a suitable location. In your Altova

product, select the menu command Help | Software Activation, and then Upload a
New License. Browse for or enter the path to the license file, and click OK.

· Save the license file (.altova_licenses) to any suitable location, and upload it from

this location to the license pool of your Altova LicenseServer. You can then either: (i)
acquire the license from your Altova product via the product's Software Activation
dialog (see below) or (ii) assign the license to the product from Altova LicenseServer.
For more information about licensing via LicenseServer, read the rest of this topic.

You can access the Software Activation dialog (screenshot below) at any time by clicking the Help |
Software Activation command.

Activate your software
You can activate the software by registering the license in the Software Activation dialog or by licensing via
Altova LicenseServer (see details below).

· Registering the license in the Software Activation dialog. In the dialog, click Upload a New
License and browse for the license file. Click OK to confirm the path to the license file and to
confirm any data you entered (your name in the case of multi-user licenses). Finish by clicking
Save.

· Licensing via Altova LicenseServer on your network : To acquire a license via an Altova
LicenseServer on your network, click Use Altova LicenseServer, located at the bottom of the
Software Activation dialog. Select the machine on which the LicenseServer you want to use has
been installed. Note that the auto-discovery of License Servers works by means of a broadcast
sent out on the LAN. As these broadcasts are limited to a subnet, License Server must be on the
same subnet as the client machine for auto-discovery to work. If auto-discovery does not work,
then type in the name of the server. The Altova LicenseServer must have a license for your Altova
product in its license pool. If a license is available in the LicenseServer pool, this is indicated in
the Software Activation dialog (see screenshot below showing the dialog in Altova XMLSpy).
Click Save to acquire the license.

https://www.altova.com/licenseserver
https://www.altova.com/licenseserver
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After a machine-specific (aka installed) license has been acquired from LicenseServer, it cannot
be returned to LicenseServer for a period of seven days. After that time, you can return the
machine license to LicenseServer (click Return License) so that this license can be acquired
from LicenseServer by another client. (A LicenseServer administrator, however, can unassign an
acquired license at any time via the administrator's Web UI of LicenseServer.) Note that the
returning of licenses applies only to machine-specific licenses, not to concurrent licenses.

Check out license
You can check out a license from the license pool for a period of up to 30 days so that the license
is stored on the product machine. This enables you to work offline, which is useful, for example, if
you wish to work in an environment where there is no access to your Altova LicenseServer (such
as when your Altova product is installed on a laptop and you are traveling). While the license is
checked out, LicenseServer displays the license as being in use, and the license cannot be used
by any other machine. The license automatically reverts to the checked-in state when the check-
out period ends. Alternatively, a checked-out license can be checked in at any time via the Check
in button of the Software Activation dialog.

To check out a license, do the following: (i) In the Software Activation dialog, click Check out
License (see screenshot above); (ii) In the License Check-out dialog that appears, select the
check-out period you want and click Check out. The license will be checked out. After checking
out a license, two things happen: (i) The Software Activation dialog will display the check-out
information, including the time when the check-out period ends; (ii) The Check out License
button in the dialog changes to a Check In button. You can check the license in again at any
time by clicking Check In. Because the license automatically reverts to the checked-in status
after the check-out period elapses, make sure that the check-out period you select adequately
covers the period during which you will be working offline.
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License check-ins must be to the same major version of the Altova product from which the license
was checked out. So make sure to check in a license before you upgrade your Altova product to
the next major version.

Note:   For license check-outs to be possible, the check-out functionality must be enabled on
LicenseServer. If this functionality has not been enabled, you will get an error message to this
effect when you try to check out. In this event, contact your LicenseServer administrator.

Copy Support Code
Click Copy Support Code to copy license details to the clipboard. This is the data that you will
need to provide when requesting support via the online support form.

Altova LicenseServer provides IT administrators with a real-time overview of all Altova licenses on a
network, together with the details of each license as well as client assignments and client usage of
licenses. The advantage of using LicenseServer therefore lies in administrative features it offers for large-
volume Altova license management. Altova LicenseServer is available free of cost from the Altova website.
For more information about Altova LicenseServer and licensing via Altova LicenseServer, see the Altova
LicenseServer documentation.

Order Form

When you are ready to order a licensed version of the software product, you can use either the Purchase
a Permanent License Key button in the Software Activation dialog (see previous section) or the Order
Form command to proceed to the secure Altova Online Shop.

Registration

Opens the Altova Product Registration page in a tab of your browser. Registering your Altova software will
help ensure that you are always kept up to date with the latest product information.

Check for Updates

Checks with the Altova server whether a newer version than yours is currently available and displays a
message accordingly.

Support Center

A link to the Altova Support Center on the Internet. The Support Center provides FAQs, discussion forums
where problems are discussed, and access to Altova's technical support staff.

FAQ on the Web

A link to Altova's FAQ database on the Internet. The FAQ database is constantly updated as Altova
support staff encounter new issues raised by customers.

Download Components and Free Tools

A link to Altova's Component Download Center on the Internet. From here you can download a variety of
companion software to use with Altova products. Such software ranges from XSLT and XSL-FO processors
to Application Server Platforms. The software available at the Component Download Center is typically free
of charge.

DiffDog on the Internet

https://www.altova.com/support
https://www.altova.com/
https://www.altova.com/manual/AltovaLicenseServer/
https://www.altova.com/manual/AltovaLicenseServer/
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A link to the Altova website on the Internet. You can learn more about DiffDog, related technologies and
products on the Altova website.

About DiffDog

Displays the splash window and version number of your product. If you are using the 64-bit version of
DiffDog, this is indicated with the suffix (x64) after the application name. There is no suffix for the 32-bit
version.

https://www.altova.com/
https://www.altova.com/
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15.12 Status and Result Messages

For file and directory comparisons, status and result messages for comparisons appear in the Comparison
Window Status Bar, which is located at the bottom of each Comparison Window.

In database data comparisons, the status as well as the result of a comparison is indicated by comparison
result icons in the Database Data Comparison window.

Status messages
Status messages indicate the status of that particular comparison, essentially whether files/directories have
been selected; whether a comparison has been carried out; and what kind of comparison was carried out (that
is, which Comparison Mode was used).

Result messages
If differences are found, a summary of the comparison results is provided by result messages in the Status Bar.
If no differences are found, this is also reported in the Status Bar. The result message lists number and type of
differences in the form:

Result: n differences  n in left pane only  n in right pane only

In File Comparison windows, Text Comparison counts differences in terms of blocks of contiguous differences,
even if the Show Differences within Lines  option is selected. So if there are six differences in four lines, four
differences are reported. If two or more lines with differences appear consecutively, without being interrupted by
a line that is equal in both files, only one difference is counted in the result message. In XML comparisons,
differences are counted in terms of nodes. Note that a difference is counted when the node exists in both
documents but is different. If the node does not exist in one document, such a node is listed as being either
present in Left Only or in Right Only. In Binary Comparisons, it is only stated whether or not the file pair is
different; no details concerning the number or location of differences are available.

Comparison result icons
As long as no comparison has been started yet, no icons are displayed in the database data comparison
window. For each compared table, however, an icon indicating whether or not the two tables are equal is
displayed. By clicking such a comparison result icon, you can display the detailed differences of a comparison
in an extra result window.

40
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16 Command Line Options

In addition to running DiffDog from the graphical user interface, you can also trigger comparisons from a
command line window. The file or directory paths to be compared can be supplied to the DiffDog executable as
arguments. Additional comparison options (further described below) can also be supplied. When the command
is executed, DiffDog starts, opens the directories or files in the appropriate comparison window, carries out a
comparison, and displays the results.

Note: Calling the DiffDog executable at the command line will open the DiffDog graphical user interface with
the options you specified. It is not possible to display the comparison outcome in the command line
window, or to export the comparison results from the command line. These capabilities are available in
DiffDog Server (https://www.altova.com/diffdog-server).

To run DiffDog from the command line interface:

1. Type cmd in the Windows search box, and press Enter to open a new command line window.
2. Change the current directory to the directory where DiffDog is installed, for example:

cd C:\Program Files (x86)\Altova\DiffDog2023\

3. Call DiffDog.exe and supply the file or directory names to be compared as arguments, as well as any
optional command line options. For example, in the command below, two text files are compared so
the options /cF /mT are explicitly set:

DiffDog.exe /cF /mT file1.txt file2.txt

For reference to all available options, see Command Line Syntax .

If DiffDog is already running when you start it from the command line, it will start as a new instance, provided
that the option Allow Multiple Instances is enabled in the Tools | DiffDog Options | Application  tab. If
Allow Multiple Instances is disabled, then the new comparison is opened in a new comparison window of an
already running DiffDog instance.

327
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https://www.altova.com/diffdog-server
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16.1 Command Line Syntax

The command line options are simple switches and are optional. If not specified, the option is off. For best
results, it is recommended that you specify the /cD or /cF option, to explicitly instruct DiffDog that you are
comparing either files or directories. Note, however, that, if you use DiffDog as a differencing tool for a source
control system, some control systems will not accept additional arguments except the file names.

Although they are organized into groups, the options listed below can appear in any order. The options are not
case-sensitive, and you can use either the minus sign (-) or the slash (/) before options. The command line
syntax is as follows:

DiffDog.exe [source name1 name2 [name3]] [general options] [compare mode] [compare
options] [filter filtername] [directory compare options] [file-filter file filtername]

source:
/cd compare directories
/cf compare files

name1 name2:
names of files or directories to compare

name3
name of the third file to compare (applicable only for three-way comparisons, see Three-Way Comparisons ).

general options
/h opens the help file

compare mode:
/mE compare according to extension  settings
/mX compare as XML
/mT compare as text
/mB compare binary

compare options:
/dD detailed  differencing
/dL show differences within lines
/iB ignore blank lines
/iC ignore case  but not in node names
/iCN ignore case
/iD ignore node depth
/iN ignore namespace
/iNT A CD C PI D X

ignore node types  (Attributes, CData, Comments, Processing Instructions, Doctype, XML
declaration)
/iOA ignore order  of attributes
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/iOC ignore order of child nodes
/iOC A G groupname T

ignore order of child nodes and add attributes as comparison criteria (All Attributes, Specific Attributes
as defined  in Group groupname, Add Element Text as Comparison Criteria)
/iP ignore prefixes
/iT ignore text  (XML)
/e resolve entities
/wN normalize whitespaces
/wS strip all whitespaces

filter:
/f filter out specific elements/attributes

filtername:
name of predefined filter

directory compare options:
/iS ignore sub-directories

file-filter:
/fD filter out specific files/directories  in directory comparison

file filtername:
name of predefined file-filter

Note: Some Comparison Options apply to XML Comparison Mode only (for example, /dD, /iN and /iNT).

These options will therefore be ignored if the [compare mode] option is not /mX.
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16.2 Command Line Examples

In the examples below, it is assumed that the current working directory is the directory where DiffDog is
installed; therefore, all commands start with DiffDog.exe. If your working directory is different, make sure to
enter the full path to the DiffDog executable instead (for example, "C:\Program Files (x86)
\Altova\DiffDog2023\DiffDog.exe"). If the path to the executable contains spaces, do not forget to enclose it
within quotes. The same applies for any referenced file or directory names which include spaces in their name.

To compare two files according to file extension, use:

DiffDog.exe /cF c:\work\Alice.txt c:\work\Bob.txt /mE

To compare three files in text comparison mode, use:

DiffDog.exe /cF c:\work\Alice.txt c:\work\Bob.txt c:\work\Chris.txt /mT

To compare two XML files in XML mode, with detailed differencing enabled (so that merge from right to left, or
left to right is possible), use:

DiffDog.exe /cF c:\work\Alice.xml c:\work\Bob.xml /mX /dD

To compare only the XML structure of the files and ignore text, use:

DiffDog.exe /cF c:\work\Alice.xml c:\work\Bob.xml /mX /iT

To compare two directories, use:

DiffDog.exe /cD c:\work1 c:\work2

To compare two directories ignoring subdirectories, use:

DiffDog.exe /cD c:\work1 c:\work2 /iS

The following command compares XML files in two directories by applying a predefined filter (created previously
from the graphical user interface), see also Filtering the content of compared directories . Notice that quotes
were used since the filter name contains spaces.

DiffDog.exe /cD c:\work1 c:\work2 /mX /fD "xml conformant files"
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17 Version Control System Integration

DiffDog can easily be integrated with version control systems that provide the option to use a custom (external)
executable for differencing and merging. 

For your convenience, this section provides instructions on how to configure miscellaneous version control
systems to use DiffDog as differencing and/or merging tool. If your version control system is not listed, or if it
has a different version, refer to its documentation for instructions on how to use a custom differencing or
merging tool. 

This section includes the following topics:

· Integrating DiffDog with Git
· Integrating DiffDog with TortoiseSVN
· Integrating DiffDog with SmartSVN
· Other Version Control Systems
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17.1 Integrating DiffDog with Git

If you are using Git (https://www.git-scm.com/) as version control system, you can set DiffDog as Git
differencing tool. You can also integrate DiffDog with any Git-based tool that provides the option to define a
custom external differencing tool (for example, gitk). The configuration instructions below were tested for Git
1.9.4; they are likely to be similar for other Git versions. For further information about integrating Git with
external differencing tools, refer to the Git user's manual.

To set DiffDog as the Git differencing tool:

· Add or edit the following lines in the .gitconfig file (this file is located in the user home directory,
typically: C:\Users\<username>\.gitconfig):

[diff]
tool = diffdog

[difftool "diffdog"]
cmd = "'C:/Program Files/Altova/DiffDog2023/DiffDog.exe'" "$LOCAL" "$REMOTE"

Note: If you are using DiffDog 32-bit on a 64-bit operating system, adjust the path to the DiffDog executable
so that it points to C:/Program Files (x86) instead of C:/Program Files.

To check whether DiffDog is set as differencing tool:

· Open the Git shell and enter the command git difftool --tool-help, as shown below.

To view changes to a Git repository file in DiffDog:

1. Open the Git repository in the Git shell, and enter the command git difftool <changed file>, for
example:

git difftool MyFile.txt

2. When prompted to confirm whether DiffDog should be launched, type Y, and then press Enter. To run
DiffDog without being prompted first, use the command git difftool -y <changed file>.

Note that the difftool command does not yield results if you provide an unchanged file as argument.

https://www.git-scm.com/
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To configure DiffDog as differencing tool in the Git graphical user interface:

1. Run gitk (for example, by right-clicking on a directory which is under Git control, and selecting Git
History).

2. On the Edit menu, click Preferences.
3. Under External diff tool, click Choose and select the path to the DiffDog executable (for example,

C:/Program Files/Altova/DiffDog2023/DiffDog.exe).

In the Git graphical user interface, you can now use the External diff command to view in DiffDog the
changes between two Git commits.
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17.2 Integrating DiffDog with TortoiseSVN

If you are using TortoiseSVN (https://tortoisesvn.net/) as Subversion client, you can set DiffDog as the program
used for comparing different revisions of files. Although the configuration instructions below apply for
TortoiseSVN 1.8.8, they are likely to be similar for other versions. For further information, refer to the
TortoiseSVN user's manual.

To set DiffDog as the TortoiseSVN differencing tool:

1. Right-click any folder, and select TortoiseSVN | Settings.
2. Click Diff Viewer.
3. Click External, and enter the path to the DiffDog executable in the format below.

C:/Program Files/Altova/DiffDog2023/DiffDog.exe %base %mine

Note: If you are using DiffDog 32-bit on a 64-bit operating system, adjust the path so that it points to
C:/Program Files (x86) instead of C:/Program Files.

https://tortoisesvn.net/


© 2016-2022 Altova GmbH

Integrating DiffDog with SmartSVN 335Version Control System Integration

Altova DiffDog 2023 Enterprise Edition

17.3 Integrating DiffDog with SmartSVN

If you are using SmartSVN (https://www.smartsvn.com/) as Subversion client, you can add DiffDog as file
comparison tool, in addition to the built-in comparison tool. The configuration instructions below apply for
SmartSVN 8.5, but they are likely to be similar for other versions.

To set DiffDog as the comparison tool:

1. Run SmartSVN.
2. On the Edit menu, click Preferences.
3. Under Tools, click File Compare.
4. Click Add, and select External diff tool.
5. Next to File Pattern, enter a pattern that matches file types that you wish to compare with DiffDog, for

example *.xml.
6. Next to Command, enter the path to the DiffDog executable, for example C:/Program

Files/Altova/DiffDog2023/DiffDog.exe.

Note: If you are using DiffDog 32-bit on a 64-bit operating system, adjust the path so that it points to
C:/Program Files (x86) instead of C:/Program Files.

7. Next to Arguments, enter ${leftFile} ${rightFile}.

https://www.smartsvn.com/
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17.4 Other Version Control Systems

Borland StarTeam Cross-Platform Client 2008 R2
https://www.microfocus.com/products/change-management/starteam/

The following steps integrate Altova DiffDog into Borland Star Team:

1. Use the StarTeam client personal options (Tools | Personal options | File | Alternate applications)
2. Compare utility: Enter the DiffDog full path.
3. Compare utility options: $file1 $file2.

Dynamsoft SourceAnywhere for VSS 5.3.2 Client
http://www.dynamsoft.com/Products/SAW_Overview.aspx 

The following steps will integrate Altova DiffDog into Dynamsoft SourceAnywhere for VSS:

1. Go to the Dynamic SourceAnywhere For VSS client Options.
2. Specify the DiffDog full path as External application for diff/merge, with the arguments: %FIRST_FILE%”

“%SECOND_FILE%.

Note: Do not perform these settings from the Altova product options, as there is no possibility of inserting the
external application parameters.

Dynamsoft SourceAnywhere Hosted Client (22252)
http://www.dynamsoft.com/Products/SourceAnywhere-Hosting-Version-Control-Source-Control.aspx

Dynamsoft SourceAnywhere Standalone 2.2 Client
http://www.dynamsoft.com/Products/SourceAnywhere-SourceSafe-VSS.aspx

The following steps will integrate Altova DiffDog into Dynamsoft SourceAnywhere Hosted and Dynamsoft
SourceAnywhere Standalone:

1. Click the Advanced button of the Source Control tab.
2. Specify the DiffDog full path as External program application for diff/merge with arguments %

FIRST_FILE%” “%SECOND_FILE%.

Jalindi Igloo 1.0.3
http://www.jalindi.com/igloo/

The following steps will integrate Altova DiffDog into Jalindi Igloo:

1. Start the Show differences command in your Altova application or other application that accesses
the source control system's differencing tool.

2. Open the Show Differences or Merge Files panel.
3. Set the External Diff Command by entering the DiffDog full file path as the External Diff EXE path.

Note: When using the default diff editor CvsConflictEditor, you might have problems comparing files with
excessively long lines. We recommended that you "pretty print" all files (particularly .ump files) before

https://www.microfocus.com/products/change-management/starteam/
http://www.dynamsoft.com/Products/SAW_Overview.aspx
http://www.dynamsoft.com/Products/SourceAnywhere-Hosting-Version-Control-Source-Control.aspx
http://www.dynamsoft.com/Products/SourceAnywhere-SourceSafe-VSS.aspx
http://www.jalindi.com/igloo/
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storing them in the repository. This limits the line length, thus avoiding problems with the
CVSConflictEditor. 

March-Hare CVS Suite Client 2008 (3321)
https://www.march-hare.com/cvsnt/en.asp

The following steps will integrate Altova DiffDog into Marc-Hare CVS Suite 2008:

1. Go to the TortoiseCVS Preferences and choose the Tools tab.
2. Specify the DiffDog full path as Diff application, and the parameters %1 %2 as two-way differencing

parameters.

Microsoft Visual Source Safe 2005 with CTP
https://msdn.microsoft.com/en-us/vstudio/aa718670.aspx

The following steps will integrate Altova DiffDog into Microsoft SourceSafe 2005: 

1. Click the Advanced button of the Source Control tab.
2. Click the Custom Editors tab and enter C:\Program Files\Altova\DiffDog2023\DiffDogexe %1 %2

in the Command Line field.
3. In the Operation combo box, select File Difference.

Microsoft Team Foundation Server 2008/2010 MSSCCI Provider
https://www.microsoft.com/en-us/download

Requirements: Visual Studio 2008 Team Explorer or Visual Studio 2008 with Team Explorer 2008. 

The following steps will integrate Altova DiffDog into Microsoft Visual Studio Team System 2008 Team
Foundation Server MSSCCI Provider:

1. In the manager (Visual Studio 2008 Team Explorer or Visual Studio 2008) options, configure Altova
DiffDog as new user tool

2. Choose Visual Studio Team Foundation Server source as the plug-in.
3. Configure a new user tool specifying: (i) the extensions of the files you wish to compare with DiffDog;

and (ii) the DiffDog full file path.

Perforce P4V 2008.1
https://www.perforce.com/

The following steps will integrate Altova DiffDog into Perforce 2008:

1. Click the Advanced button of the Source Control tab.
2. Choose the tab Diff in the Preferences panel.
3. Check as default differencing application the field “Other application” and enter the DiffDog full file path.

https://www.march-hare.com/cvsnt/en.asp
https://msdn.microsoft.com/en-us/vstudio/aa718670.aspx
https://www.microsoft.com/en-us/download
https://www.perforce.com/
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PushOK CVS SCC NT 2.1.2.5

PushOK CVS SCC x64 version 2.2.0.4

PushOK SVN SCC 1.5.1.1

PushOK SVN SCC x64 version 1.6.3.1
http://www.pushok.com/soft_cvs.php

The following steps will integrate Altova DiffDog into PushOK CVS NT and PushOK SVN SCC:

1. Click the Advanced button of the Source Control tab.
2. Choose the CVS Executables tab.
3. Select the value External merge/compare tool into the Diff/Merge field.
4. Insert the DiffDog full file path.
5. Edit the value %first %second into the "2 way diff cmd" field.

Note: When using the default differencing editor CvsConflictEditor, you might have problems comparing files
with excessively long lines. We recommended that you "pretty print" all files (particularly .ump files)
before storing them in the repository. This limits the line length, thus avoiding problems with the
CVSConflictEditor. 

QSC Team Coherence Client 7.2.1.35
http://www.teamcoherence.com

The following steps will integrate Altova DiffDog into Team Coherence Version Manager:

1. Go to Team Coherence client Options “Difference Viewer”.
2. Specify as the Default Difference Viewer application, the DiffDog full file path.
3. Specify as parameters: "$LF  $RF".

Note: It is possible that the new settings will only be applied after a Windows log off.

Surround SCM Client 2009.0.0
https://www.perforce.com/products/surround-scm

The following steps will integrate Altova DiffDog into Seapine Surround SCM:

1. Go to the Surround SCM client user options (Diff/Merge) section.
2. Edit the Diff/Merge settings to compare with a selected application.
3. Enter the DiffDog full path with the parameters “%1” “%2”.
4. Restart the Surround SCM client and the Altova products.

SourceGear Vault 4.1.4 Client
http://www.sourcegear.com/vault

The following steps will integrate Altova DiffDog into SourceGear Fortress and SourceGear Vault:

1. Click the Advanced button of the Source Control tab.

http://www.pushok.com/soft_cvs.php
http://www.teamcoherence.com
https://www.perforce.com/products/surround-scm
http://www.sourcegear.com/vault
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2. Set the Diff/Merge Vault options by specifying as the differencing program the DiffDog full path and
using the Arguments:
/ro1 /ro2 /title1:"%LEFT_LABEL%" /title2:"%RIGHT_LABEL%"  "%LEFT_PATH%" "%RIGHT_PATH%"

SourceGear SourceOffsite Client 4.2.0 (Windows)
http://www.sourcegear.com/sos/

The following steps will integrate DiffDog into SourceGear SourceOffsite:

1. Click the Advanced button of the Source Control tab.
2. Specify as “External Programs”, “Application for comparing files” the DiffDog full path.

TamTam CVS SCC 1.2.40, TamTam SVN SCC 1.2.24
http://www.fieldstonsoftware.com/software/tamtam/index.shtml

The following steps will integrate Altova DiffDog into TamTam CVS SCC and TamTam SVN SCC:

1. Click the Advanced button of the Source Control tab. 
2. Specify the DiffDog full file path as the external tool for Diff/Merge and Conflict.

Note: The default differencing editor CvsConflictEditor, has problems comparing files with excessively long
lines. We recommended that you "pretty print" all files (particularly .ump files) before storing them in
the  repository. This limits the line length, avoiding problems with the CVSConflictEditor.

http://www.sourcegear.com/sos/
http://www.fieldstonsoftware.com/software/tamtam/index.shtml


© 2016-2022 Altova GmbH

 341License Information

Altova DiffDog 2023 Enterprise Edition

18 License Information

This section contains information about:

· the distribution of this software product 
· software activation and license metering
· the license agreement governing the use of this product

Please read this information carefully. It is binding upon you since you agreed to these terms when you
installed this software product.

To view the terms of any Altova license, go to the Altova Legal Information page at the Altova website.

https://www.altova.com/legal
https://www.altova.com/
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18.1 Electronic Software Distribution

This product is available through electronic software distribution, a distribution method that provides the
following unique benefits:

· You can evaluate the software free-of-charge for 30 days before making a purchasing decision. (Note:
Altova MobileTogether Designer is licensed free of charge.)

· Once you decide to buy the software, you can place your order online at the Altova website and get a
fully licensed product within minutes.

· When you place an online order, you always get the latest version of our software.
· The product package includes an onscreen help system that can be accessed from within the

application interface. The latest version of the user manual is available at www.altova.com in (i) HTML
format for online browsing, and (ii) PDF format for download (and to print if you prefer to have the
documentation on paper).

30-day evaluation period
After downloading this product, you can evaluate it for a period of up to 30 days free of charge. About 20 days
into the evaluation period, the software will start to remind you that it has not yet been licensed. The reminder
message will be displayed once each time you start the application. If you would like to continue using the
program after the 30-day evaluation period, you must purchase a product license, which is delivered in the form
of a license file containing a key code. Unlock the product by uploading the license file in the Software
Activation dialog of your product.

You can purchase product licenses at https://shop.altova.com/. 

Helping Others within Your Organization to Evaluate the Software
If you wish to distribute the evaluation version within your company network, or if you plan to use it on a PC that
is not connected to the Internet, you may distribute only the installer file, provided that this file is not modified in
any way. Any person who accesses the software installer that you have provided must request their own 30-
day evaluation license key code and after expiration of their evaluation period, must also purchase a license in
order to be able to continue using the product.

https://shop.altova.com/
https://www.altova.com/documentation
https://shop.altova.com/
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18.2 Software Activation and License Metering

As part of Altova’s Software Activation, the software may use your internal network and Internet connection for
the purpose of transmitting license-related data at the time of installation, registration, use, or update to an
Altova-operated license server and validating the authenticity of the license-related data in order to protect
Altova against unlicensed or illegal use of the software and to improve customer service. Activation is based on
the exchange of license related data such as operating system, IP address, date/time, software version, and
computer name, along with other information between your computer and an Altova license server.

Your Altova product has a built-in license metering module that further helps you avoid any unintentional
violation of the End User License Agreement. Your product is licensed either as a single-user or multi-user
installation, and the license-metering module makes sure that no more than the licensed number of users use
the application concurrently.

This license-metering technology uses your local area network (LAN) to communicate between instances of the
application running on different computers.

Single license 
When the application starts up, as part of the license metering process, the software sends a short broadcast
datagram to find any other instance of the product running on another computer in the same network segment.
If it doesn't get any response, it will open a port for listening to other instances of the application.

Multi-user license
If more than one instance of the application is used within the same LAN, these instances will briefly
communicate with each other on startup. These instances exchange key-codes in order to help you to better
determine that the number of concurrent licenses purchased is not accidentally violated. This is the same kind
of license metering technology that is common in the Unix world and with a number of database development
tools. It allows Altova customers to purchase reasonably-priced concurrent-use multi-user licenses.

We have also designed the applications so that they send few and small network packets so as to not put a
burden on your network. The TCP/IP ports (2799) used by your Altova product are officially registered with the
IANA (see the IANA Service Name Registry for details) and our license-metering module is tested and proven
technology.

If you are using a firewall, you may notice communications on port 2799 between the computers that are
running Altova products. You are, of course, free to block such traffic between different groups in your
organization, as long as you can ensure by other means, that your license agreement is not violated.

Note about certificates
Your Altova application contacts the Altova licensing server (link.altova.com) via HTTPS. For this
communication, Altova uses a registered SSL certificate. If this certificate is replaced (for example, by your IT
department or an external agency), then your Altova application will warn you about the connection being
insecure. You could use the replacement certificate to start your Altova application, but you would be doing this
at your own risk. If you see a Non-secure connection warning message, check the origin of the certificate and
consult your IT team (who would be able to decide whether the interception and replacement of the Altova
certificate should continue or not).

http://www.iana.org/assignments/service-names-port-numbers/service-names-port-numbers.xhtml
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If your organization needs to use its own certificate (for example, to monitor communication to and from client
machines), then we recommend that you install Altova's free license management software, Altova
LicenseServer, on your network. Under this setup, client machines can continue to use your organization's
certificates, while Altova LicenseServer can be allowed to use the Altova certificate for communication with
Altova.

https://www.altova.com/licenseserver
https://www.altova.com/licenseserver
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18.3 Altova End-User License Agreement

· The Altova End-User License Agreement is available here: https://www.altova.com/legal/eula 
· Altova's Privacy Policy is available here: https://www.altova.com/privacy 

https://www.altova.com/legal/eula
https://www.altova.com/privacy
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3
3-way comparison,

navigating differences, 36

running, 34

swapping panes, 37

A
Access,

comparing data, 128

comparing structure, 128

Adding,

commands to menus, 308

commands to toolbars, 308

ADO,

as data connection interface, 152

setting up a connection, 160

ADO.NET,

setting up a connection, 166

Application status bar, 23

Application window,

description, 23

Assigning,

keyboard shortcuts, 312

shortcuts, 312

B
Binary comparison mode,

definition, 21

Blank lines, 40, 41, 94

Bookmark margin, 51

C
Case sensitivity, 40, 41, 94

Changing,

comparison mode, 77

content of compared files, 59

structure of compared files, 60

synchronization actions, 86

synchronization settings, 85

Collapsing,

all selected nodes, 270

sub-directories, 79

unselected nodes, 270

Command line,

GUI mode, 326

quiet mode, 326

syntax, 327

Commands,

Add Child | ATTLIST, 297

Add Child | Attribute, 295

Add Child | CData, 296

Add Child | Comment, 296

Add Child | DOCTYPE, 296

Add Child | ELEMENT, 295, 297

Add Child | ENTITY, 297

Add Child | ExternalID, 296

Add Child | NOTATION, 297

Add Child | Processing Instruction, 296

Add Child | Text, 295

Add Child | XML, 296

Append | ATTLIST, 294

Append | Attribute, 291

Append | CData, 292

Append | Comment, 292

Append | DOCTYPE, 292

Append | ELEMENT, 291, 293

Append | ENTITY, 294

Append | ExternalID, 293

Append | NOTATION, 294

Append | Processing Instruction, 292

Append | Text, 291

Append | XML, 292

Append Row, 299

Ascending Sort, 299

Autostart Comparison, 302

CData, 287

Check Well-Formedness, 301

Close, 275

Close all, 276

Compare According to File Extension Settings, 302

Compare as Binary, 302



© 2016-2022 Altova GmbH

Index 347

Commands,

Compare as XML, 302

Compare Directories, 274

Compare Files, 273

Compare Only Size and Modification Date, 304

Compare while Editing, 302

Comparison Options..., 307

Copy, 279

Copy from Left to Right (files), 302

Customize..., 308

Cut, 279

Delete, 279

Descending Sort, 299

DiffDog Options..., 307

Display as Table, 299

Display Current Difference, 302

Enclose in Element, 300

Exit, 277

Export differences..., 276

Find next, 280

Find..., 280

First Difference, 302

Go to line/char, 283

Go to Next Bookmark, 285

Go to Previous Bookmark, 285

Grid View, 281

Insert | ATTLIST, 289

Insert | Attribute, 287

Insert | Comment, 287

Insert | DOCTYPE, 288

Insert | ELEMENT, 287, 289

Insert | ENTITY, 290

Insert | ExternalID, 288

Insert | NOTATION, 290

Insert | Processing Instruction, 288

Insert | Text, 287

Insert | XML, 288

Insert Row, 299

Insert/Remove Bookmark, 284

Last Difference, 302

Make Current Difference, 302

Move Left, 299

Move Right, 300

Next Difference, 302

Open..., 275

Paste, 279

Pretty-Print XML Text, 284

Previous Difference, 302

Print Preview, 277

Print Setup..., 277

Print..., 276

Redo, 279

Remove All Bookmarks, 285

Replace..., 280

Save, 276

Show Options Before Comparison, 302

Start Comparision, 302

Status Bar, 282

Support Recently Compared Pairs, 302

Synchronize Directories, 304

Synchronize Selected Directory, 304

Synchronized Scrolling, 282

Text View, 281

Textual Comparison Only, 302

Toggle All Folds, 285

Toolbars, 281

Undo, 278

Validate, 301

Word Wrap, 284

Comparing,

*.doc, 90

*.docx, 90

database data, 119

directories, 71

files, 26

Microsoft Word files, 90

Office Open XML, 26, 71

OOXML, 26, 71

Word documents, 90

ZIP archives, 26, 71

Comparing directories,

see Directory comparison, 71

Comparing files,

see File comparison, 26

Comparing Word,

see Word document comparison, 90

Comparison,

autostart, 249

definition, 17

selecting directories, 75

selecting Word documents, 93

showing options before comparing, 249

Comparison management, 248

Comparison mode,

Binary, 21

changing, 77
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Comparison mode,

current, 21

Extensions, 21

Quick comparison, 21

Text, 21

XML, 21

Comparison Mode toolbar, 270

Comparison options,

for database comparisons, 140

Comparison window status bar, 23

Comparisons,

saving, 246

Context menus,

customizing, 315

Copying,

file content, 242

Copyright information, 341

Creating,

attribute groups, 45

attributes filter, 47

elements filter, 47

groups of attributes, 45

CSV,

adding files as data source, 186

Current comparison mode,

definition, 21

Customizing,

Commands, 308

context menus, 315

Keyboard, 312

Menu, 315

Options, 317

tables, 57

Toolbars, 309

D
Database,

comparing data, 119, 121, 135

merging comparison differences, 138

viewing comparison results, 135

Database connection,

setting up, 152

setup examples, 187

starting the wizard, 154

Database Data Comparison Files,

opening, 134

saving, 134

Database drivers,

overview, 157

Default comparison mode, 264

Defining,

file extensions, 264

file types, 264

Deleting,

file extensions, 264

file types, 264

Diff and Merge menu, 302

database data comparison, 304

Diff and Merge toolbar, 270

DiffDog,

allowing multiple instances, 253

application window, 23

as Git differencing tool, 331

as TortoiseSVN differencing tool, 334

features, 14

GUI, 23

interface, 23

introduction to, 11

main features, 14

options, 252

settings, 252

terminology, 17

User Reference, 269

DiffDog Server,

running comparisons with, 143

Differences,

colors, 255

copying content, 242

definition, 17

exporting, 245

in directories, 81

in files, 51

in Grid View, 55

in Text View, 51

in Word documents, 98

in ZIP files, 81

merging, 242

navigating, 241

within lines, 40, 94

Directories,

comparing, 71

selecting for comparison, 75

synchronizing, 84
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Directory comparison,

changing the comparison mode, 77

changing the synchronization actions, 86

changing the synchronization settings, 85

colors, 81

comparing files, 83

comparison mode, 21

comparison symbols, 81

configuring the view, 79

definition, 17

displaying differences, 81

displaying sub-directories, 79

features, 14

file icons, 81

filtering, 78

folder icons, 81

opening, 71

opening comparison window, 74

options, 77

running, 78

selecting directories, 75

starting, 78

starting a synchronization, 88

synchronizing directories, 84

ZIP icons, 81

Directory Comparison window,

filtering a comparison, 78

opening, 74

running a comparison, 78

selecting directories, 75

Directory Content toolbar, 270

Directory synchronization,

options, 85

running, 88

settings, 85

starting, 88

synchronization actions, 86

Displaying,

Comments, 97

repeating elements, 57

Revisions, 97

sub-directories, 79

table, 57

Displaying differences,

in directories, 81

in files, 51

in Grid View, 55

in Text View, 51

in Word documents, 98

in ZIP archives, 81

Distribution,

of Altova's software products, 341, 342

E
Edit menu, 278

Editing, 99

comparing while editing, 249

content, 59

files, 59

finding text, 61, 99

replacing text, 61, 99

structure, 60

Word documents, 99

Encoding, 253

End of line markers, 51

End User License Agreement, 341, 345

Entities,

resolving, 41

Equal files,

definition, 17

hiding, 79

showing, 79

Evaluation period,

of Altova's software products, 341, 342

Expanding,

all selected nodes, 270

selected and child nodes, 270

sub-directories, 79

Exporting,

differences, 245

to text, 245

to XML, 245

F
Features, 14

File comparison,

changing structure, 60

comparing files in directory comparison, 83

comparing while editing, 249

comparison mode, 21
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File comparison,

definition, 17

displaying differences, 51

editing content, 59

editing files, 59

features, 14

filter for XML comparison, 47

finding text, 61

Grid View, 55

opening, 26

options, 39

reloading files, 59

replacing text, 61

running, 28

saving files, 70

searching Grid View, 65

selecting Word documents, 93

starting, 28

Table View, 57

text comparison options, 40

Text View, 51

Text View Settings, 51

XML comparison options, 41

File Comparison window,

running a comparison, 28

File DSN,

setting up, 173

File menu, 273

Files,

automatic reloading, 255

backup options, 255

default comparison mode, 264

Filter,

creating, 259

default filters, 259

Filtering,

attributes, 47

directories, 78

elements, 47

XML comparisons, 47

Find,

using regular expressions, 66

Finding,

content in Grid View, 65

names in Grid View, 65

text in file comparisons, 61

text in Grid View, 65

text in Word document comparisons, 99

XML node types, 65

Firebird,

Connecting through JDBC, 187

Connecting through ODBC, 188

Folding margin, 51

Foreign keys,

disable in SQLite, 184

G
Git,

Integrating DiffDog with, 331

Grid Edit toolbar, 270

Grid toolbar, 270

Grid View,

collapsing nodes, 270

displaying differences, 55

expanding nodes, 270

finding text, 65

optimal widths, 270

replacing text, 65

Grid View menu, 286

Add Child sub-Menu, 294

Append sub-menu, 290

Convert to submenu, 298

Insert sub-menu, 286

Table sub-menu, 298

GUI,

description, 23

H
Help menu, 320

Hiding,

equal files, 79

missing files left/right, 79

newer files left/right, 79

non-comparable files, 79

sub-directories, 79

I
IBM DB2,
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IBM DB2,

connecting through JDBC, 191

connecting through ODBC, 193

IBM DB2 for i,

connecting through JDBC, 199

connecting through ODBC, 200

IBM Informix,

connecting through JDBC, 202

Ignoring,

attribute order, 41

blank lines, 40, 41, 94

case, 40, 41, 94

namespace, 41

node depth, 41

node types, 41

node types order, 41

prefixes, 41

text, 41

Indentation guides, 51

Interface,

description, 23

Introduction, 11

J
JDBC,

as data connection interface, 152

connect to Teradata, 234

setting up a connection (Windows), 176

K
Keyboard shortcuts, 312

Microsoft Word, 97

L
Legal information, 341

License, 345

information about, 341

License metering,

in Altova products, 343

Line number margin, 51

M
Margins,

bookmarks, 51

folding, 51

line numbers, 51

MariaDB,

connect through ODBC, 204

Menu bars,

customizing, 315

Menus,

adding commands, 308

Diff and Merge, 302

Edit, 278

File, 273

Grid View, 286

Help, 320

Text View, 284

Tools, 307

View, 281

Window, 319

XML, 301

Merge,

CSV differences, 138

Database differences, 138

Merging,

3-way differences, 36

definition, 17

differences, 242

Microsoft Access,

connecting through ADO, 160, 206

Microsoft SQL Server,

connecting through ADO, 208

connecting through ODBC, 211

Missing files left/right,

hiding, 79

showing, 79

Modifying,

default comparison mode, 264

directory synchronization actions, 86

Grid View, 55

options for directory comparison, 77

options for file comparison, 39

options for Word document comparison, 94

settings for directory synchronization, 85
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Multiple instances, 253

MySQL,

connecting through ODBC, 217

N
Navigation,

current difference, 241

differences, 241

Newer files left/right,

hiding, 79

showing, 79

Non-comparable files,

hiding, 79

showing, 79

Non-equal files,

definition, 17

O
ODBC,

as data connection interface, 152

connect to MariaDB, 204

connect to Teradata, 236

setting up a connection, 173

ODBC Drivers,

checking availability of, 173

Office Open XML,

comparing, 71

OLE DB,

as data connection interface, 152

OOXML,

comparing, 71

Opening,

directory comparison, 71

Directory Comparison window, 74

empty directory comparison, 74

empty Word document comparison, 92

file comparison, 26

MS Word comparison, 90

Word Comparison window, 92

Word document comparison, 90

OpenJDK,

as Java Virtual Machine, 176

Options,

application, 253

backup files, 255

colors, 255

comparison management, 248

directory comparison, 77, 257

directory filters, 257

directory synchronization, 85

encoding, 253

file comparison, 39, 255

file filters, 257

file types, 264

recently compared pairs, 250

showing before comparing, 249

startup options, 253

text comparison, 40

Windows Explorer integration, 253

Word document comparison, 94

XML comparison, 41

Oracle database,

connecting through JDBC, 219

connecting through ODBC, 221

P
PostgreSQL,

connecting natively, 181

connecting through ODBC, 225

Product features, 14

Progress OpenEdge database,

connecting through JDBC, 228

connecting through ODBC, 229

Q
Quick comparison mode,

definition, 21

R
Recently compared pairs, 250

Refreshing,

display, 97
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Refreshing,

GUI, 97

screen, 97

Regular expressions,

find and replace using, 66

Reloading,

automatic reload, 255

files, 59, 99

Word documents, 99

Replace,

using regular expressions, 66

Replacing,

text in file comparisons, 61

text in Grid View, 65

text in Word document comparisons, 99

Resetting,

context menus, 315

menu bars, 315

Resolving entities, 41

Result messages, 325

Running,

directory comparison, 78

directory synchronization, 88

file comparison, 28

Word document comparison, 96

S
Saving,

files, 70, 100

Word documents, 100

XML Schema comparison files, 113

Saving comparisons, 246

Selecting,

directories for comparison, 75

directories in Windows Explorer, 75

files for Word document comparison, 93

folders in Windows Explorer, 75

recently compared pairs, 250

Word documents in Windows Explorer, 93

Shortcuts, 312

Microsoft Word, 97

Showing,

blank lines, 40, 41, 94

Comments, 97

differences within lines, 40, 94

equal files, 79

large icons, 317

missing files left/right, 79

newer files left/right, 79

non-comparable files, 79

options before comparing, 249

recently compared pairs, 250

Revisions, 97

screen tips, 317

shortcut keys, 317

sub-directories, 79

text labels on toolbars, 309

Software product license, 345

Sorting,

tables, 57

SQL Server,

connecting through ADO, 160

connecting through ADO.NET, 166

connecting via JDBC, 176

SQLite,

comparing data, 128

comparing structure, 128

disable foreign keys, 184

setting up a connection (Windows), 184

Standard toolbar, 270

Starting,

directory comparison, 78

directory synchronization, 88

file comparison, 28

Word document comparison, 96

Startup options, 253

Status bar,

application, 23

comparison windows, 23

result message, 325

status messages, 325

Status messages, 325

Sub-directories,

collapsing, 79

displaying, 79

expanding, 79

hiding, 79

including, 79

Sybase,

connecting through JDBC, 232

Synchonizing,

directories, 84

Synchronizing,
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Synchronizing,

definition, 17

Syntax coloring, 264

System DSN,

setting up, 173

T
Tab size, 51

Table View,

customizing, 57

displaying, 57

sorting, 57

Teradata,

connect through JDBC, 234

connect through ODBC, 236

Terminology, 17

Text comparison,

options, 40

showing differences within lines, 40

Text comparison mode,

definition, 21

Text toolbar, 270

Text View,

displaying differences, 51

Text View menu, 284

Text View Settings, 51

Three-way comparison,
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